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VERSION 4

v4.0.15.97 Nov 2014
Electronic document delivery has never been so easy!

This version is the culmination of 3 years of research and development into better and more efficient ways of delivering your documents. The
product has been completely overhauled with all new engines that create a PDF, explode or burst the 'master' PDF document into multiple
pages for delivery by e-mail, Fax, SharePoint or FTP (to come soon).
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Welcome to PDF-eXPLODE
Version v4.0.15.97 Nov 2014

Overview

PDF-eXPLODE automates the document delivery process for businesses. It turns paper and electronic documents into secure e-mails that can
be batch-sent to business clients, customers, patients, employees, vendors, investors and others saving time and money. PDF-eXPLODE is
perfect for sending invoices, statements, form letters and other reports and correspondence.

At the heart of PDF-eXPLODE is the ability to explode, or separate, a PDF file into individual PDF files. This enables you, for example, to select
and combine different portions of a document into a resulting PDF file, or to e-mail different people different sections of a document. The
current version of PDF-eXPLODE incorporates an exploding engine that is capable of 2 distinct methods of exploding a document into multiple
PDFs for distribution. The 2 methods of exploding are as follows:

¢ Only pages containing a TAG will be exploded or
¢ Blank TAG pages are exploded using the previous Tag page

To be able to “explode” individual pages of any PDF file, you must be able to modify your business report template (invoice, paystub, vendor
payment, etc.) in order to include a "tag”. This “tag” is a collection of business data set out in a specific order and formatted to a set of rules
which you configure in the PDF-eXPLODE options screen. Each page to be “exploded” must contain a tag. The tag is generally located in

the page header (so it appears on all pages by default) and may be hidden using a small sized white colored font. Tags can be a basic email
address or enhanced to be able to customize the exploded file name, archive folder, password security, email message and a lot more.

A tag has the following layout, shown below in order of priority:

<pdfexplode> or {pdfexplode} or [pdfexplode] --> referred to as a 'left' or 'open’' node

Variable - Up to 9 Variables separated by commas and ending with a '%' like this Varl, Var2, Var3, Var4, Var5, Var6, Var7, Var8, Var9%
where 'Var' is a value that will be replaced by a database value when the report runs. Each value can be used for a specific purpose like
filename, folder or even email subject or message.

Message ID - A Message ID is our name for a Report or Job stream (or type). It is a one-word text with no spaces and must be terminated
(in the document tag) with a '#' like Paystubs# or Invoices# or Statements#

Email Address(es) - show a database email field here so that this value will change with each new document page. You can have more than
one email address separated by either a comma or semi-colon.

</pdfexplode> or {/pdfexplode} or [/pdfexplode] --> referred to as a 'right' or 'close’' node

This is what it would look like in a document tag:

<pdfexplode>variables%messagelD#e-mails</pdfexplode>

Each part is optional. You must have at least one or more of Variables, Message ID or email addresses. If you have nothing between the
open and close nodes, then PDF-eXPLODE will convert that page to a 'blanktag.pdf'.

Here is an example of a very basic tag, using just the Email Address part:

<pdfexplode>mail@3000ad.com.au</pdfexplode>

This tag consists of an email address destination for the page (e.g: mail@3000ad.com.au), contained between a pair of front/back tag
identifier nodes (<pdfexplode> </pdfexplode>) . You can review all of the tag format rules here. You also view a video tutorial on setting up
a tag. Just follow this link: Tag Rules

In PDF-eXPLODE you can choose between the following options:

¢ Archive and E-mail each PDF if an e-mail address exists in the tag [default] or
¢ Archive only each of the exploded PDF to a folder on your server or
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e Print the exploded PDF and Archive or
e Combine the functionality of Print, Email and Archive in a variety of ways based on your report page tag configuration.

You can also configure PDF-eXPLODE to either:

¢ Send one email with one exploded PDF attached or
e Group by email destination and send multiple PDFs attached or
¢ Do not attach any exploded PDFs to the email

You can also attach one or more additional PDFs or other file types (e.g. XLS, Doc) to the email. These are referred to as “Coversheets”. You
simply configure this in the Option screen.

When emailing reports, you have the choice of using an in-built PDF-eXPLODE SMTP email sending client or use your existing MS Outlook
email client. To configure PDF-eXPLODE business rules to match the tag within your document/report you must open the PDF-eXPLODE
application using the desktop shortcut, then select Options from the PRINTER menu item. Sending emails using MS Outlook will allow you to
send emails to a Contacts Group (aka Distribution List) also. You just need to have appropriate MS Exchange permissions to access the Group
email list. Ask your MS Exchange Administrator.

PDF-eXPLODE provides the ability to setup different job streams or processes - this is done by assigning your various job types to one or
more Message ID. Each Message ID has a number of configurable components, not least of all is the FROM, REPLY TO, CC, BCC, Subject and
Message content for the email. Additionally, you can archive each Message ID’s exploded files to different paths. There are plenty of additional
configuration possibilities. Examples of Message ID (or Job types) is Invoices, Statements, etc.

Within a Message ID run, if you wish to create an exception for a specific Client (or email address destination) for the message content of a
Message ID and say the exploded file path, you can set up a Client ID with a different message content and different archived exploded path.
The Client ID would typically be an email address that would appear in the Tag for a particular Message ID.

For example:

Configure a Message ID "Invoices" to process weekly Invoice batch runs. Email subject: "Your Invoice is attached", Email message: "Attached
is your weekly invoice"

In your document the tag would be:

<pdfexplode>Invoices#mail@3000ad.com.au</pdfexplode> and another <pdfexplode>Invoices#info@pdf-explode.com</pdfexplode>

Now Create a Client ID called 'mail@3000ad.com.au’ and under that Client create a Message ID called "Invoices". For: Email subject: "Your
Invoice is attached", Email message: "Attached please find your weekly invoice. From next week your account will be billed once monthly."

Result: when you process the weekly Invoices batch, the client: mail@3000ad.com.au will receive a different email message to other email
recipients in the batch.

Finally, PDF-eXPLODE provides you with 2 basic types of email message format. You can either send your email message as:

 Plain text which has no specific text font formatting nor any graphic display capability OR
e HTML - which is a web based language capable of formatting text with different font styles and colors as well as inserting graphics like
logos, etc.

PDF-eXPLODE has a simple to use HTML editor capable of most text font formatting as well as embedding graphics from your hard drive so
that they can be displayed on the email recipient's computer when the email is opened. You can view a tutorial on how to use the HTML editor
at www.pdf-explode.com/HTML Editor

PDF-eXPLODE has a number of ways of creating customised exploded filenames and folders for archiving (saving) the files. You can create
nested folders structure; for instance, you could create a nested folder based on the Salesman, Client Name and Month of Invoice or
Statement like - Salesman\Client\Month under a parent path which you nominate in the PDF-eXPLODE configuration and insert your exploded
PDF file at any level of this folder tree. Filename can be created as [Invoice_Number].PDF where [Invoice_number] is a data field value
passed to your report. The filename could also be a prefix or suffix to another name.

“Variables” are a concept of passing data values from your database to PDF-eXPLODE for use in Filenames, Folders, passwords, or even for
use in the e-mail Subject or Message. You have up to 9 Variables that can be inserted into the 'Tag' in your report.

PDF-eXPLODE provides you with a lot of flexibility and configurability to meet most business delivery requirements. It is the ideal middleware
tool to seamlessly work with renowned report writers like Crystal Reports, Cognos, MS Access, SQL Server Reporting Services or most business
Front Office or Back Office software. It currently has in excess of 1000 Users spread over 26 Countries and many industries, large and small. It
is inexpensively priced and 6 days-a-week support is readily available.
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Getting Help
We want you to succeed with PDF-eXPLODE. If at any time you need assistance using PDF-eXPLODE, please take advantage of any of the
following resources:

¢ Check our Online Knowledgebase for quick answers to common problems.

¢ If you don't find your answer in the Online Knowledgebase, contact us for support under one of the following plans: You have 60 days
of free priority support from the date of purchase. If you are located in United States, then e-mail info@pdf-explode.com otherwise
support@3000ad.com.au with your questions and we'll respond ASAP, guaranteed within one business day.

¢ To continue to have access to priority support after the 60-day period, you must purchase a 12-month support plan. A priority support

plan can be purchased here .
¢ We also offer per-incident support. You can purchase this 'per-incident' support by clicking here .

System Requirements

¢ Operating System: Microsoft Windows XP, Windows Server 2003, Windows Server 2008, Windows Vista or Windows 7

¢ Hard Drive: Minimum 52.5MB of free disk space, plus additional space for PDF files created

¢ RAM: At least 64MB of available memory, more during PDF creation. The size of the PDF that can be created is limited by the amount of
available memory.

Before Getting Started
Please note the following configuration items before getting started:

« Immediately after installation: Configure the PC according to the instructions in the PDF file titled Configuring Desktop or
Server PDF-eXPLODE Versions after Install that was supplied with the software. If you have any questions, please contact
support@3000ad.com.au before proceeding. Failure to follow these instructions can result in the program failing to work properly.

« If you are using PDF-eXPLODE Server: There are special considerations and configuration settings when using PDF-eXPLODE in a
shared environment such as Terminal Services, Citrix, BusinessObjects, Crystal Reports Server, SQL Server Reporting Services or as a
network shared printer. These are discussed in the topic on Multi-user Administration.

If you are upgrading from a previous version of PDF-eXPLODE: You must start PDF-eXPLODE.

¢ On the Printer menu, click PDF-eXPLODE Options....

¢ Once the Options screen opens, you must navigate through each menu item and verify the settings are correct. If not,
then adjust them.

e Ensure each Message ID and/or Client ID is correct

¢ Click Save to save your settings and exit.

« If you want to purchase a license online: Purchase this software online.
« If you already purchased a license and want to activate it online: Activate online License ID.

Getting Started

If you are eager to send your first PDF-eXPLODE e-mail within the next few minutes, follow the Fast Start Guide and then come back to the
tutorials below to learn more when time permits. If you prefer to read a technical overview of PDF-eXPLODE before getting started, see the
section below.

e Fast Start Guide

If you are new to PDF-eXPLODE, please follow the Getting Started Tutorials to quickly learn how to use PDF-eXPLODE and achieve the
results you desire. Each tutorial will take approximately 10 minutes.

Tutorials

Create a PDF File
Explode a PDF File
E-mail a PDF File
Automate the Process
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If you are currently using PDF-eXPLODE Version 1, Version 2 or Version 3 and are upgrading to Version 4, the following topics describe the
new features.

e What's New in Version 2
e What's New in Version 3
e What's New in Version 4

Technical Overview
PDF-eXPLODE software comprises two programs, a Setup Program and a Windows Printer.

b PDF-eXPLODE Application Program
The PDF-eXPLODE Application Program (PDF-eXPLODE.EXE) is used to:

+ configure PDF-eXPLODE settings including General settings for the program's operation, Mail settings for creating and sending e-
mails, Security settings for applying passwords to PDF files, and Message and Client settings for customizing e-mails for specific types of
documents or specific recipients.

+ process documents according to the configured rules by creating a Master PDF of the document, then exploding, securing, e-mailing
this master and finally archiving this master and exploded PDFs to your nominated folder path.

Some configuration settings are required while others are optional. All settings are stored in an 'INI' file, the location of which is described
on the help topic What's Installed Where. If you are going to be using PDF-eXPLODE on a network shared computer (e.g. server), please
review Multi-user Administration for important information.

The PDF-eXPLODE Application Program may be accessed from the PDF-eXPLODE folder available under Programs on the Windows Start
menu, or by clicking the shortcut optionally installed on your Windows desktop

I PDF-eXPLODE Windows Printer

The PDF-eXPLODE Windows Printer program emulates a physical printer. It creates report output in a format suitable to convert to PDF.
This output is created from your business application when you select Print from the File menu. Printer output is sent to the Application
program where it is converted into a PDF file, which in turn may be exploded into separate PDF files based on specially formatted tags
located within the document.

PDF files are saved in a specified folder with the name specified by the tag, and are then optionally e-mailed as a file attachment with
a specified e-mail subject and message. E-mail settings come from a configuration file created and maintained by the Setup Program
described above.

The PDF-eXPLODE Windows Printer may be accessed from the Printers and Faxes folder available under Settings on the Windows Start
menu. To confirm the PDF-eXPLODE printer is working properly, right-click PDFeXPLODE, select Printer Properties (or Properties if
your version of Windows does not have Printer Properties) and click Print Test Page. A PDF file containing the Windows printer test
page will be created in the Default Document Path.

You can optionally use a third party software to create a (master) PDF containing the PDF-eXPLODE tags and use either the "Command Line”
or “Drag and Drop” processing functionality to skip the PDF creation and just explode, e-mail and archive only.

Acknowledgements
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License Agreement
This chapter deals with the various issues of Licensing. In summary, purchasing PDF-eXPLODE is a license to use the software in perpetuity. It
does not come with unlimited support. Support must be purchased on an annual basis beyond 60 days after purchase. There are two distinct

Licenses - Single User for Desktop PC and Server license. Both licenses can ony be installed on one PC; however a Server license entities you
to connect one or more PC's (desktop) work stations that can send output to the server for processing remotely.

In this graphic below, 3 Users (work stations) are connected to the Server PC via the shared PDFeXPLODE Printer on the Server

PFOF-eXFLODE PRINT SERVER PROCESSING

4. PDF-eXPLODE is launched on
the server and starts processing a
‘Master PDF' fram the report

output

L User sends a Print
command from
their screen

Workstation Printer

IS

5. Exploded PDFs are emaile
and archived

2. Workstation Printer redirects the print output to the Server Printer 6. Recelve emall and FDF
attachment
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In this graphic below, the single User is connected to his/her PDFeXPLODE Printer on their own PC.

POF-eXPLODE DESKTOP PROCESSING

2. Windows creates a print output in the
required format and sends a "message” to PDF
eNPLODE program that the output is ready

7

3. Printer forwards the output to the
PDE-eXPLODE program installed on the PC

PC Monitor connected to a

eport Writer or Business Program 4. PDF-cXPLODE is launched on \”\.. oC
the PC and starts processing a o DESKTOP
‘Master PDF' from the report
1. User sends a Print L 4 ot et \"-L_‘_
command [ :“\"‘HH""-m

in the Repaort Writer

[

5. Exploded PDFs are emalle,
and archived ;
6. Recalve emall and PDF
attachrment

How do the Licenses Differ?

DESKTOP SINGLE USER LICENSE:

This license can only be installed on a single PC and working on the PC in a standalone mode. A user will interact with the program. Output
sent via the PRINT button in your application program will process on this PC and subject to a 'silent' or 'attended' (i.e. 'Silent mode' is
unchecked) mode, the user will be able to see all of processing activity.

CITRIX OR TERMINAL SERVER LICENSE:

This version works like a desktop except PDF-eXPLODE is licensed for use on a server giving multiple users the opportunity to connect
simultaneously to one central install. Users connect to the server by making a login connection to the server and can interact with the
program; each User can have their own configuration or use one central “administrator” configuration which they cannot change or edit
themselves. Users do not have any PDF-eXPLODE components installed on their PC. Terminal/Citrix Server licenses come in 1, 3,5,10 or 20
User packs, where the number of users is regarded as simultaneous Users.

PRINT SERVER LICENSE:

Each User has no visual contact with the server install. They send report output from their business application PRINT function. The output
is redirected by Windows from their PC via the LAN and the PDF-eXPLODE Printer port on their PC. The only component installed on a
workstation is the PDF-eXPLODE printer driver. Output received on the server is then processed by the PDF-eXPLODE application installed on
the Server and exploded/emailed. Process completely runs on the server and the User can be informed when the process is complete by way
of a “Completed Notification” e-mail. The Print server PDF-eXPLODE installation can be installed on a Citrix secured server or any ordinary
Client Server. Print Server licenses come in a 3, 5, 10 or 20 User packs, where the number of Users is regarded as simultaneous Users.
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PDF {.’XP,.QDE End-User License Agreement
LICENSE AGREEMENT AND LIMITED WARRANTY

IMPORTANT-READ CAREFULLY: This End-User License Agreement ("EULA") is a legal agreement between you ("Licensee")
and 3000AD SYSTEMS PTY LTD ("Licensor"). For purposes of this EULA, the term "Software Product" shall mean all PDF-
eXPLODE software and documentation, electronic and printed, individually and as a group, and the term "License" shall mean
the right to make, use, or access a particular copy of the Software Product.

The Software Product is protected by copyright laws and international copyright treaties, as well as other intellectual property
laws and treaties. The Software Product is licensed, not sold.

By installing, copying, or otherwise using the Software Product, you agree to be bound by the terms of this
EULA. If you do not agree to the terms of this agreement and the accompanying EULA, you may not install or
use the Software Product.

SOFTWARE PRODUCT LICENSE

1.0 GRANT OF LICENSE
Licensor, grants Licensee a nonexclusive and limited license to use the Software Product accompanying this EULA, solely in
accordance with the terms and conditions of this EULA. The Software is licensed, not sold, to Licensee.

2.0 INSTALLATION AND USE

2.1 Single User License

Licensee may install and use a single copy of the Software Product on a single computer as long as that computer is owned by
Licensee and/or used solely by an employee of Licensee. Licensee may access the Software Product strictly in accordance with
the terms hereof. Licensee must acquire additional single user licenses for additional users to use the Software Product.

2.2 Network License

This EULA grants you a limited, non-exclusive license to install the SOFTWARE onto one Network Server provided the appropriate
Network License (namely: PDF-eXPLODE Report Server, PDF-eXPLODE Printer Sharing Server or PDF-eXPLODE Citrix /Terminal
Server) has been purchased. "Network Server" means a computer with one or more computer central processing units (CPU's)
that operates for the purpose of serving other computers logically or physically connected to it, including, but not limited to,
other computers connected to it on an internal network, intranet or the Internet. You are strictly prohibited from installing
a Single User license product on a Network, unless approved in writing by Licensor.

2.3 Trial License

Licensee may use one copy of the Software Product on a single computer, for a limited period as provided by the Software
Product. Licensee is acquiring only the limited right to use a single copy of the Software Product for evaluation purposes.
Licensee does not acquire any rights to the Software Product itself.

3.0 DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

3.1 Separation of Components
The Software Product is licensed as a single user product and may be installed on a single computer accessible only by a
single user.

3.2 Upgrades

If the Software Product is labeled as an upgrade, Licensee must be properly licensed to use a product identified by Licensor
as being eligible for the upgrade in order to use the Software Product. A Software Product labeled as an upgrade replaces
and/or supplements the product that formed the basis for eligibility for the upgrade. Licensee may use the resulting upgraded
product only in accordance with the terms of this EULA. If the Software Product is an upgrade of a component of a package of
software programs licensed as a single product, the Software Product may be used only as part of that single product package
and may not be separated for use on more than one computer.

3.3 Rental
Licensee may not rent, lease, or lend the Software Product.
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3.4 Support Services

Licensee must register with Licensor or its Agent in order to be eligible for technical support via electronic mail. Licensee is
entitled to support via email from Licensor, free of charge. Subject to that provision, support is provided free of charge at the
Licensor's sole discretion. The Licensor reserves the right to revoke or modify support provided for the Software at any time,
for any or no reason. The Licensor also reserves the right to provide software support at an hourly rate of US$80 per hour if
it deems necessary. Any supplemental software code provided to Licensee as part of support services shall be considered part
of the Software Product and subject to the terms and conditions of this EULA. With respect to technical information Licensee
provides to Licensor as part of any such support services, Licensor may use such information for its business purposes,
including for product support and development. Licensor will not utilize such technical information in a form that personally
identifies Licensee.

3.5 Software Transfer

Notwithstanding any terms to the contrary, Licensee may not transfer rights under this EULA. In view of the fact that Licensee
has acquired the right to use the Software Product under special terms, any transfer of rights under this EULA is strictly
prohibited.

3.6 Ownership

Licensee agrees that 3000AD Systems Pty Ltd and/or its Suppliers, retains all right, title and interest in and to the Software
Product and all copies at all times, regardless of the form or media in or on which the original or other copies may
subsequently exist. Licensee agrees they neither own nor hereby acquire any claim or right of ownership to the Software
Product or to any related patents, copyrights, trademarks or other intellectual property. Licensee agrees to use reasonable
efforts to prevent and protect the contents of the Software Product from unauthorized disclosure or use. Any data, content or
information accessed through the Software Product is the property of the applicable data/content/information owner and may
be protected by applicable copyright law. This EULA gives Licensee no rights to such data, content or information.

3.7 Copyright

All title and copyrights in and to the Software Product (including but not limited to any images, photographs, animations,
video, audio, music, text, and "applets" incorporated into the Software Product), and any copies of the Software Product are
owned by Licensor unless otherwise indicated. The Software Product is protected by copyright laws and international treaty
provisions. Therefore, the Software Product must be treated like any other copyrighted material.

3.8 U.S. Government Restricted Rights

The Software Product is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject

to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19,
as applicable.

3.9 Other Restrictions

Licensee agrees not to alter, disassemble, decompile, translate, adapt or reverse-engineer the Software Product or make any
attempt to discover the source code of the Software or otherwise reduce the Software Product to a human perceivable form,
or to modify, network, or create derivative works based upon the Software Product in whole or in part, nor permit any other
party to do so.

3.10 Termination

Without prejudice to any other rights, Licensor may terminate this EULA if Licensee fails to comply with the terms and
conditions of this EULA. In such event, Licensee must destroy all copies of the Software Product and all of its component
parts.

4.0 MISCELLANEOUS

This EULA is governed by the laws of the Commonwealth of Australia in the State of New South Wales (NSW). Should you
have any questions concerning this EULA, or if you desire to contact Licensor for any reason, please contact Licensor at +612
9983-0367 or mail@3000ad.com.au.

5.0 LIMITED WARRANTY

Licensor warrants that the:
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(i) Software Product will perform substantially in accordance with the applicable user documentation published by
Licensor for a period of ninety (90) days from the date Licensee first acquired Software Product, and

(ii) Support Services provided by Licensor shall be substantially as described in the applicable user documentation
published by Licensor, and Licensor will make commercially reasonable efforts to solve problem issues. Some states and
jurisdictions do not allow limitations on duration of an implied warranty, so the above limitation may not apply. To the
extent allowed by applicable law, implied warranties on the Software Product, if any, are limited to ninety (90) days.
Notwithstanding the foregoing, Licensor under no circumstances warrants the media on which the Software Product has
been distributed.

6.0 CUSTOMER REMEDIES

Licensee's exclusive remedy shall be, at Licensors' option, either

(i) return of the price paid, if any, or

(ii) replacement of the Software Product upon proof of purchase.
This Limited Warranty is void if failure of the Software Product has resulted from accident, abuse, or misapplication. Any
replacement Software Product will be warranted for the remainder of the original warranty period or thirty (30) days,
whichever is longer.

7.0 NO OTHER WARRANTIES

To the maximum extent permitted by applicable law, 3000AD Systems Pty Ltd and its Suppliers disclaim all other warranties
and conditions, either express or implied, including, but not limited to, implied warranties of merchantability, fitness for a
particular purpose, title, and non-infringement, with regard to the software product, and the provision of or failure to provide
support services. This limited warranty gives you specific legal rights. You may have others, which vary from state to state and
jurisdiction to jurisdiction.

8.0 LIMITATION OF LIABILITY

To the maximum extent permitted by applicable law, in no event shall 3000AD Systems Pty Ltd (or its Suppliers) be liable

for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of
business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or
inability to use the software product or the provision of or failure to provide support services, even if licensor has been advised
of the possibility of such damages. In any case, 3000AD Systems Pty Ltd's (or its Suppliers') entire liability under any provision
of this EULA shall be limited to the greater of the amount actually paid by you for the software product or US $5.00. Because
some states and jurisdictions do not allow the exclusion or limitation of liability, the above limitation may not apply to you.

Copyright © 2006-2014, 3000AD Systems, AUSTRALIA
Version v4.0.15.97 Nov 2014

3000AD SYSTEMS
Sydney, AUSTRALIA

Fax: +61 2 9983 0367
mail@3000ad.com.au

www.3000ad.com.au g
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PDF-eXPLODE License

The PDF-eXPLODE single user license is defined in the End-User License Agreement and usage over a network is clarified in Network
Licensing. The intention is for each license to allow for use in either of the following two environments:

¢ on a standalone PC or network work station by any nhumber of end-users using the computer locally
- Or -

¢ on a network server or network shared computer by a single end-user or terminal.

PDF-eXPLODE licenses are also available to allow multiple users to share PDF-eXPLODE in the following three configurations:

+ PDF-eXPLODE Terminal Server License: Covers a specified number of concurrent users under Microsoft Terminal Services or a Citrix
Server product

+ PDF-eXPLODE Printer Server License: Covers a specified number of concurrent users with PDF-eXPLODE configured as a shared
printer

 PDF-eXPLODE Report Server License: Allows PDF-eXPLODE to be used from a report server such as Business Objects Enterprise,
Crystal Reports Server or SQL Server Reporting Services (SSRS)

How Licensing Works

PDF-eXPLODE licensing is implemented via software that restricts usage to the specific computer on which the software is activated. Using
electronic license activation, a trial version is converted to a fully functional, registered and licensed version. Using this approach saves you
time and makes license compliance easy for your organization.

o After installing the trial version, you already have the complete PDF-eXPLODE software installed -- you simply need to activate it to
remove the trial version limitations.

¢ When you purchase a license to use PDF-eXPLODE, you receive an e-mail with a License ID and Password.

¢ The confirmation e-mail is sent immediately upon credit card authorization as part of the invoicing process.

¢ At the end of the purchase process, you may enter your License ID and Password into PDF-eXPLODE or you may activate your license
the next time you open PDF-eXPLODE.

¢ Upon activation, you have a fully functional, registered and licensed version.

Upgrade Licensing

Upgrading from an older version of PDF-eXPLODE follows a similar process to licensing a new version. Begin by uninstalling the older version
and then follow the steps above. When you purchase a license, select the appropriate upgrade license. You may only purchase as many
upgrade licenses as you have licenses of the older version. Upon activation of the newer version license, the older version license will be
invalidated.
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Network Licensing

The following statement clarifies the End-User License Agreement provision in paragraph 2.1 for product usage in any of the following
network environments:

¢ Application Server Network (e.g. Microsoft Terminal Services or Citrix XenServer™)
¢ Client-Server Network (e.g. Microsoft Windows Network)
e Peer-to-Peer Network (e.g. Windows shared printer)

The Software Product must not be used in any network unless multiple Licenses are purchased reflecting the actual number of separate end
users or terminals (whichever is the larger) accessing the Software Product on the network.
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About PDF-eXPLODE

PDF-eXPLODE works on the principal of a Post Office which receives incoming mail for sorting and then
redistributes it in the fastest and most efficient way. It is your very own Post Office right on your Desktop!
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General Overview

PDF-eXPLODE makes it faster, easier and less expensive to distribute business documents to your business clients. You can send invoices,
statements and other reports and correspondence. It is designed to get the right information to the right people at the right time, improving
customer service, accelerating cash flow and reducing costs.

Instead of manually printing, collating, stamping and distributing stacks of mail, printing to PDF-eXPLODE can automatically e-mail batches
of individualized documents with a single mouse click. Clicking the printer button in a report writer, word processor or a mail-merge
application activates PDF-eXPLODE. PDF-eXPLODE explodes, or splits, a document into individualized PDFs, which it then e-mails securely
and reliably to your business clients.

PDF-eXPLODE is easy to set up and use because it works with the programs you already know, like Crystal Reports, Microsoft Access and
Microsoft Word, as well as with most packaged software applications designed for managing your business.

There are many ways to use PDF-eXPLODE - here are some of the ways people use it:

Send e-mails with one consolidated PDF attachment

Send e-mails with multiple PDF attachments

Send e-mails with no PDF attachments

Send e-mails using mail-merge capabilities to personalize the e-mail message
Send e-mails that include a cover document such as a newsletter or promotion
Print documents when the e-mail address is missing

Split a PDF into separate files for archiving or uploading to a web site or FTP site
Convert any document to PDF format
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How PDF-eXPLODE Works

PDF-eXPLODE has two distinct methods of operation. It can:

- start its processing when you click PRINT (to the installed PDFeXPLODE printer) in your business software or
- start processing using a third party produced PDF.

Broadly, PDF-eXPLODE functions as a Windows printer, so the document delivery process can start with the click of a printer button.
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PDF-eXPLODE then runs through a series of three steps to create and distribute targeted emails. It:

1. Takes a report or a word or mail merge document and, instead of printing it, converts it to a master PDF document;
2. “Explodes,” or splits, the master PDF into individual PDF attachments based on e-mail tags in the original document; and
3. Distributes each individual PDF either via e-mail, your local area network or FTP (available soon) to the designated recipients or

locations.

In the graphic above, by using a third party created PDF, processing can start from Step 2 "Exploding" and continue to emailing and
archiving. The advantage of this method allows you to continue to use your favorite PDF creation engine which may be faster and produce
more compact PDFs. Aside from this, there is a gain in speed in completing the process.
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Benefits of PDF

PDF-eXPLODE generates Adobe PDF (Portable Document Format) files from virtually any Windows application capable of printing. Adobe

PDF is readable across all major computing platforms, making your documents accessible to anyone using free Adobe Reader® software.
There are many benefits to using the PDF format to distribute your documents:

Preserve the appearance of your documents so that the electronic and paper versions look identical.
Protect the integrity of your documents by making them non-editable.

Make it easy to copy and paste information from your documents into other office productivity applications.
Add security to restrict access and prevent copying and pasting information from your documents.
Compress your documents for more efficient delivery and storage.

Take advantage of industry-wide support for Adobe PDF.
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Example Applications

Invoices

PDF-eXPLODE is used by a manufacturing company who prides itself on providing exceptional customer service. Part of the company
strategy is to offer customers the option to receive automated e-mails containing order acknowledgments, shipping memos and invoices.
These reports are sent daily. This function used to be performed manually. A staff member would print all the order acknowledgments,
shipping memos and invoices each day and mail or fax each one to each customer. It was an expensive and labor-intensive process, and was
subject to error, staff availability and time constraints.

PDF-eXPLODE is now used in combination with R&R Report Writer and Windows Scheduled Tasks to automatically send the requested
reports each night, ensuring that customers receive timely and accurate information about their orders.

To distribute the invoices, the database field containing the recipient’s e-mail address was inserted into the page header — in white so

it's invisible on the final communication. The report was set to print to the printer named “PDF-eXPLODE.” From there, the process is
automated. When the report is printed, PDF-eXPLODE stores the output (all invoices) in a PDF file and then sends each invoice to the correct
customer.

Statements

PDF-eXPLODE is used by a laser toner cartridge recycling company who is driving up profitability by speeding up cash flow and freeing
up staff to work on revenue generation activities. Producing and delivering monthly statements used to be performed manually by a staff
member who would print more than one thousand monthly statements and a cover letter, spending hours collating the documents and
stuffing envelopes, applying labels and finally mailing them, sometimes as long as six weeks following the end of the month.

PDF-eXPLODE is now used in combination with Crystal Reports to automatically send the monthly statements on the first day of each month
for the prior month, ensuring that customers receive timely and accurate information about their accounts.

To distribute the statements, a form letter was written in Crystal Reports, and the statement was inserted as a sub-report. The database
field containing the customer's e-mail address was inserted in the page header with the color set to white to hide it on the finished
document. By printing to the printer named “PDF-eXPLODE”", thousands of statements are sent out automatically, helping this company work
more efficiently. In fact, the CFO has calculated that the company will save $700 each time the statements are sent by PDF-eXPLODE.
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Frequently Asked Questions

[You can get help on common processing and configuring problems in our Online Knowledgebase]

What It Does

IF What is PDF-eXPLODE?

PDF-eXPLODE is a one-click batch e-mail delivery tool that makes it easy and cost-effective for small businesses to get their customers the
information they expect on time. Through a click of the printer button, PDF-eXPLODE converts a report or a Word document into batches of
individual PDF attachments and securely and reliably e-mails them to the designated recipients. In addition, users can pre-schedule routine
mailings for hands-free delivery.

I What Are the Key Benefits of PDF-eXPLODE?

PDF-eXPLODE is designed to strengthen your business relationships by getting the information people need into their hands when they
expect it. Whether sending daily confirmations, monthly statements, or other critical reports or correspondence, PDF-eXPLODE reduces
costs and saves time by eliminating the labor-intensive process of hand-mailing or e-mailing each document separately. PDF-eXPLODE helps
reduce costs, save time, increase cash flow and enhance customer service.

I How Does It Save Time and Decrease Costs?
PDF-eXPLODE software improves productivity and costs by eliminating the need to send documents one-by-one, whether through the mail
or by e-mail. It:

¢ Eliminates costly and inefficient paper-based workflows.
o Offers customers, partners and employees immediate access to the information they need.
¢ Pre-schedules routine and tedious mailings, freeing up staff to focus on revenue-generating activities.

It also adds value to your existing business systems. Most organizations already have made costly investments in software and equipment
and can't afford new technologies that disrupt their current workflows. Thanks to its standards-based interface, PDF-eXPLODE software can
work with any existing business application.

¢ As a printer driver, it easily installs onto existing Windows computers via the Printer Control Panel.

¢ It supports e-mail delivery of documents using SMTP (Simple Mail Transport Protocol) standards.

o It works with your existing business applications, including Crystal Reports, R&R Report Writer, Microsoft Word ( and Mail Merge
Wizard), Microsoft Visual FoxPro, plus accounting and other software packages.

P How Does It Increase Customer Satisfaction and Retention?
PDF-eXPLODE enables you to create focused, targeted documents, so you can treat your customers and partners as individuals, leaving
them both satisfied and loyal. It:

¢ Customizes documents, such as financial statements and marketing brochures, for specific individuals or even departments and
workgroups a€" sending them only the information they want and need.

¢ Allows you to send communications whenever you want for no additional cost so you can be responsive to your customers'
needs.

¢ Combines multiple documents to the same recipient in a single PDF.

¢ Ensures that dynamically generated documents, including business reports and sales letters, are highly legible and consistently
branded.

¢ Includes visually rich charts and graphs tailored to specific documents.

e Enhances your document delivery with targeted e-mail messages.

F Who Benefits from PDF-eXPLODE?

Everyone you do business with will benefit from PDF-eXPLODE. Communication is central to the success of a business, and customers expect
and demand regular, consistent communication. PDF-eXPLODE makes it easy and affordable to get the right information into the right hands
at the right time. That means customers as well as business partners and your employees will remain well informed and, subsequently,
confident about and satisfied with how you do business.

PDF-eXPLODE helps companies communicate reliably, efficiently and regularly not only with their customers and outside vendors but also

with and among departments. PDF-eXPLODE allows departments as well as workgroups purchasing, operations and accounting, for example
to simultaneously receive business-critical reports, so they can continue to coordinate to keep the business running smoothly and efficiently.
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I What Are Its Business Applications?
PDF-eXPLODE can be used in virtually any business and by any department that sends bulk individualized communications 4€" whether to
customers, employees, vendors or prospects.
Below is a sampling of the most popular uses for PDF-eXPLODE.
Manufacturing/Shipping and Fulfillment

¢ Order confirmations
¢ Shipping memos

Accounting and Finance

¢ Invoices

Account statements

Contracts

Purchasing orders

Dunning letters

Internal budget status reports

Human Resources Departments

¢ Benefits statements
¢ Open enrollment forms

Sales and Marketing

Targeted sales letters
Promotional mailings
Thank you notes

Re-order solicitations
Internal lead status reports
¢ Regional sales reports

Professional Services

¢ Billing statements
¢ Appointment confirmations
¢ Reminders to schedule appointment

Financial Service Providers

¢ Monthly, quarterly, year-end statements
¢ Trade confirmations
¢ Portfolio management and reviews

P How Is PDF-eXPLODE Different from Other Document Distribution Tools?

PDF-eXPLODE is an all-in-one document delivery tool that allows you to both create individual PDFs and e-mail them in batches with a click
of your printer button.

I What Are the Key Features of PDF-eXPLODE?

Easy Use and Set-up: PDF-eXPLODE can be used with both text documents and data-driven reports, seamlessly fitting into business
workflows. PDF-eXPLODE works with most business applications, including Crystal Reports, R&R Report Writer, Microsoft Access and
Microsoft Word (Mail Merge Wizard), Microsoft Visual FoxPro, and accounting and other software packages. As a printer driver, it installs onto
any Windows computer via the Printer Control Panel.

Automatic and Manual Process Settings: PDF-eXPLODE can be set in silent mode to run without intervention when a document is printed,
whether whether from within an application by clicking the printer button or from a task scheduler for true hands-free processing. Or it can

be set to run manually for full control to set options at any time, displaying interactive pop-up instructions that users respond to every step
of the way.

Standard and Customized E-mail Messages: PDF-eXPLODE defaults to a general e-mail subject and message to make e-mail deliveries as
easy and hands-free as possible. For enhanced customer service, it allows customization of e-mail subjects and messages for each individual
PDF attachment. In addition, users can crate and name pre-scripted e-mail messages - such as "Invoice" or "Monthly Statement" - to sent to
all recipients of a similar type of document to easily manage report distribution to multiple customers.
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Multiple Delivery Modes : PDF-eXPLODE can distribute individual PDF attachments through a number of communications channels. In
addition to sending through e-mail, it can send documents to shared network folders for employees to view. In the near future, PDF-
eXPLODE will have the capability to send PDF documents to FTP sites for Web publishing.

Streamlined Mailings Management and Archiving: PDF-eXPLODE has a number of features for managing mailings. It logs each task
performed for job verification so users can review the results of each e-mail and correct any errors. It also saves a copy of each PDF
attachment for archiving.

Professional Benefits of PDF Format: PDF-eXPLODE leverages the features and benefits of Adobe PDF. In addition to making documents
accessible to anyone using free Adobe Reader software, it preserves the professional appearance of original documents so the electronic and
paper versions look identical. It protects the integrity of documents by making them non-editable. It also offers efficiency, making it easy to
copy and paste information from documents into other office productivity applications.

Secure Sending: PDF-eXPLODE has a number of security features that protect the integrity of documents, including the ability to
select whether a recipient can edit the PDF document. In addition, it allows users to password-protects files to further secure their
communications.

Efficient Operations: PDF-eXPLODE efficiently sends documents directly through a mail server (SMTP) instead of using an e-mail client, such
as Outlook or Notes. This feature avoids having to manually confirm pop-up security-block messages. It also provides a choice of e-mail
From: address, so e-mails can be sent from any address. It also compresses documents for more efficient delivery and storage.

Bonus PDF Creation a€" While the main purpose of PDF-eXPLODE is to create and distribute batches of PDF documents, it can turn any
individual document, such as an Excel spreadsheet, into a PDF without sending.

How It Works
I How Does PDF-eXPLODE Work?
PDF-eXPLODE functions as a Windows printer, so the document delivery process starts with the click of a printer button.
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PDF-eXPLODE then runs through a series of three steps to create and distribute targeted e-mails. It:
1. Takes a report or a word or mail merge document and, instead of printing it, converts it to a master PDF document;
2. "Explodes" or splits, the master PDF into individual PDF attachments based on hidden e-mail tags in the original document; and
3. Distributes each individual PDF either via e-mail, your local area network or FTP (available soon) to the designated recipients.

I What Are the System Requirements for PDF-eXPLODE?
PDF-eXPLODE is ideally suited to work with any application that merges data from a database with a template, including Crystal Reports,
R&R Report Writer, Microsoft Access, Microsoft Word (Mail Merge Wizard), Microsoft Visual FoxPro and other "report writer" software, either
built-in to your business applications or used as a separate add-on to your business databases. You also may use PDF-eXPLODE with
any Windows application that is capable of printing if you wish to e-mail all or portions of the document or if you simply want to convert a
document to PDF format.

System Requirements

¢ Operating System: Microsoft Windows XP,Win Vista, Win 7, Win 2003, Win 2008 R2
¢ Hard Drive: Minimum 34MB of hard disk space
e RAM: At least 16MB of free RAM

I Will PDF-eXPLODE Combine Documents Going to the Same Recipient?

Yes. PDF-eXPLODE merges all the documents tagged, or addressed, to the same recipient into one PDF attachment, which it then e-mails.
Can I Send a Document to More than One Recipient?

Yes. PDF-eXPLODE lets you send a single document to as many recipients as you like. This feature is helpful to keep everyone in the loop.
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I Can I Customize the e-mail Messages for Each PDF Attachment?

Yes. You can create and send a specific e-mail message with a specific PDF attachment. This is done by creating and saving a subject/
message in a client folder and then a€cetaggingd€# the original document with specific file name of the subject/message. You may also
create a mail merge using variables in the e-mail subject and message.

I Can I Manually Go Through the Delivery Process Step-by-Step?

Yes. PDF-eXPLODE can run manually so that you have full control to set options for a mailing at any time. Instead of running automatically
in Silent Mode, PDF-eXPLODE will display interactive pop-up instructions that you respond to every step of the way. Using Silent Mode is a
great way to automate the process to run in the background while you work on other tasks or to run according to a schedule.
PDF-eXPLODE reads hidden tag# in the original document to know where to send the attachment and what message to include in the e-
mail. These tags include a recipient identifier which is usually an e-mail address and a message identifier. If a message identifier is not
included, the e-mail attachment is automatically sent with the default message you indicated when you initially set up PDF-eXPLODE.

IF How Do I Tag a Document?

You insert a "tag" on each page of the document that you want to be processed by PDF-eXPLODE. Typically, the tag is placed on the first
line in the page header. For a complete description and examples of of PDF-eXPLODE tags refer to the help topic PDF-eXPLODE Tag. Below
is a summary of rules concerning tags:

A tag must adhere to the following general format: <pdfexplode>variables%Message IDentifier#clientldentifier</pdfexplode>
All tags must start with <pdfexplode> and end with </pdfexplode>.

Open and close tags must match one another in case (i.e. uppercase, lowercase or mixed case).

All tags must always include a client identifier, which may be an e-mail address or a filename.

You may optionally specify multiple e-mail addresses separated with a comma (,) or semicolon (;).

An optional message identifier, if used, must precede the client identifier and be followed by a pound sign (#).

You may optionally precede the message identifier, if used, or client identifier with up to five variables followed by a percent sign
(%). Variables must be separated with a comma (,).

I How Does PDF-eXPLODE Know Where to Send a Document and What Message Should be Sent?

¢ Tags must be formatted with the Arial font, and the color may be set to White to hide the tag.
¢ All tags must fit entirely on one line. Reduce the font size if necessary to fit on one line.
¢ You may include multiple tags per page.

I* Does Tagging a Document differ depending on the Business Application?
Yes - the steps you follow to insert a PDF-eXPLODE tag depends on the application in which you are working.

e Tagging a Microsoft Access Document

Tagging a Microsoft Word Document

Tagging a Microsoft Word Mail Merge Document
Tagging a Crystal Report

Tagging an R&R Report

P How Do I Know If a Document Has Been Sent?
You can check on whether a document has been sent one of two ways.

1. You can view the Log File, which records and displays each action, so you can see if all documents were sent and which
ones, if any, had sending errors.

2. You also can look in the e-mail inbox for your e-mail return address (i.e., Sender Name) account for delivery errors returned
by the intended recipient's e-mail server.

I* How Do I Specify the Location Where PDF Archive Files are Saved?

¢ The default file name is the client identifier in the <pdfexplode> tag and the default folder is specified in General Settings.

¢ The default file name and folder may be overridden for a specific document type, using the Exploded File Name option on a Default
Message ID Tag screen, for a specific recipient on a Client Details screen or for a client-specific document on a Client-specific Message 1D
Tag screen.

¢ The file name and folder may be further customized from within the application printing to PDF-eXPLODE using variables. This feature
allows report writers to conditionally specify the file and folder names.

PDF-eXPLODE



P Can I print a PDF from the command line?

¢ Yes - For example, you may need to either print or e-mail Invoices. You could create two PDF-eXPLODE Default Message IDs, PrintMe
and EmailMe. In Crystal Reports (or another report writer) you could create a formula to compute the <pdfexplode> tag. The formula
would be something like:

If Trim({DB_Email_Addr}) = "" Then
"<pdfexplode>PrintMe# </pdfexplode>"
Else
"<pdfexplode>EmailMe#" + {DB_Email_Addr} + "</pdfexplode>"
The EmailMe message ID could specify the e-mail subject and message and the folder where the exploded PDF exploded files are saved.
The PrintMe message ID could specify the printer on which to print the selected invoices.
Another approach is to use use the Program Processing option on the Completed Processing Notification screen.

I Can I perform a file clean-up operation after PDF-eXPLODE processing?

Yes 3000AD SYSTEMS can provide a Cleanup.exe program on e-mail request (mail@3000ad.com.au with the Subject: Can I please get a
copy of Cleanup.exe) which does a number of maintenance functions like copying, moving and deleting files and folders . This program can
be configured to run once PDF-eXPLODE has completed its processing from the Program Processing option on the Completed Processing
Notification screen.

Trial and Purchase
P How Is PDF-eXPLODE Licensed?
See How Licensing Works.

I Can I Get a Trial Copy of PDF-eXPLODE?
Yes. You can download a 45-day free trial version.

I* How Can I Buy PDF-eXPLODE?

After downloading and installing the 45-day trial version of PDF-eXPLODE, you can purchase a license by running the program and selecting
Purchase this software online and clicking Continue to order through our secure website.
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What's New in Version 2

This topic presents the new features of PDF-eXPLODE Version 2 to users already familiar with the features in Version 1. Below is a summary
of the new features with links to the help topics that describe each feature in more depth.

P Windows Vista and Terminal Server

o PDF-eXPLODE Version 2 is designed to work with Windows Vista, in addition to continuing support for Windows XP, Windows 2000 and
Windows 2003.

¢ PDF-eXPLODE Version 2 is designed to work with Windows Terminal Server and Citrix Server. You will need a PDF-eXPLODE Version 2
License for each PDF-eXPLODE user (refer to Network Licensing). You no longer need to leave the server logged in on the Administrator
account.

I Variables
Variables can be included in <pdfexplode> tags to:

¢ pass mail-merge fields into e-mail subjects and messages, for example to personalize a message with the recipient's name.

+ name the exploded PDF files, for example embed an invoice number into a PDF file name for easier identification.

« name the folders in which PDF files are saved, for example use customer names to name the folders in which their PDF documents are
archived.

e supply a user-specific password to secure each PDF file.

¢ provide the sender's e-mail address.

I Quick Mail
Quick Mail enables you to create a PDF file and send it as an e-mail attachment without placing a PDF-eXPLODE tag in the document. This
is handy for ad-hoc and one-off documents.

I E-mail Options

¢ You may use e-mail servers that require an encrypted connection using SSL or TSL encryption, such as Gmail.
¢ You may optionally format e-mail addresses to be sent through a fax server or to display the recipient's full name by selecting a default

format in General Settings.

New e-mail options may be specified and applied selectively to e-mails

+ Read Notification is defined in General Settings and applied to a specific Default Message ID Tag, Client Details or a Client-specific
Message ID Tag.

« Importance and Sensitivity flags are defined in General Settings and applied to a specific Default Message ID Tag, Client Details or a
Client-specific Message ID Tag.

« Sender E-mail as defined in Mail Settings can be overridden on a specific Default Message ID Tag, Client Details or a Client-specific
Message ID Tag.

¢ BCC e-mail addresses may now be defined for a Default Message ID Tag, Client Details or a Client-specific Message ID Tag.

+ Delay each E-mail by a specified number of seconds to avoid errors that may occur on some e-mail (SMTP) servers.

I Print
You can now designate whether to print a PDF on each Default Message ID Tag, Client Details or a Client-specific Message ID Tag.

¢ Print Only might be used to print PDF files for only those clients that do not have an e-mail address.
¢ Print Also might be used to keep a hard copy of each PDF that is e-mailed.

I Distribution Lists
You can now send an e-mail to multiple recipients using a single <pdfexplode> tag in one of two ways:

e PDF-eXPLODE Tags may now include multiple e-mail addresses separated by comma (,).

¢ Client Details may now be named with either an e-mail address or any other desired identifier, for example the term "Managers" could be
used and then the e-mail addresses of several managers could be entered into the CC field to ensure all managers receive the same PDF
document.
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I Other Conveniences

¢ Global PDF Password: You may now secure all documents using the same password.

¢ Optional Timestamp: You may now include or exclude a timestamp on exploded and/or e-mail attachment PDF filenames. A timestamp
may be useful when storing multiple versions of a document or it may be undesirable when sending and e-mail attachment.

¢ PDF File Backup and Viewing: You may now choose whether to keep backup copies of PDF files when newer versions are created. You
may not want to keep backup files if you need to preserve disk space or want to prevent clutter. You can also view and print a PDF from
within PDF-eXPLODE.

¢ Very Silent Mode: A new option allows you to suppress the dialogs displayed when using PDF-eXPLODE in silent mode. If you are
running a large batch this will enable you to continue work in other applications without interference from the popup status dialogs.

¢ Job Completed Notification: You may request an e-mail alert whenever a job is completed. You may also run a batch process or
executable file at the end of processing.

e Command Line Operation: The PDF-eXPLODE print queue window now closes after exploding a PDF when running PDF-eXPLODE from a
command line.

¢ Cancel Document: You may now cancel documents waiting in the PDF-eXPLODE printer queue.
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What's New in Version 3

This topic presents the new features of PDF-eXPLODE Version 3 to users already familiar with the features in Versions 1 and 2. Below is a
summary of the new features with links to the help topics that describe each feature in more depth.

I Server Editions Now Available
Multiple users may share a single instance of PDF-eXPLODE on a PDF-eXPLODE server. Three different server configurations are supported -
a different license is available for each configuration:

+ PDF-eXPLODE Terminal Server: Licensed per concurrent user, this edition works on a Microsoft Terminal Servicer or a Citrix Server
product.

+ PDF-eXPLODE Printer Server: Licensed per concurrent user, this edition works on any computer with PDF-eXPLODE configured as a
shared printer.

 PDF-eXPLODE Report Server: Licensed per server, this edition works on BusinessObjects Enterprise, Crystal Reports Server, SQL
Server Reporting Services (SSRS) and other servers that run a report scheduler service.

I HTML Format E-mail Messages

¢ E-mail messages can be formatted using HTML, providing the ability to use fonts and styles, colors, headings, paragraphs, bulleted and
number lists, hyperlinks and images. A built-in HTML editor is provided or you may use another HTML editor.

Ir Send E-mail Using Outlook (MAPI)
¢ E-mail may be sent through Microsoft Outlook (i.e. a MAPI client), rather than sending through an SMTP server.

I PDF-eXPLODE Tag Enhancements

¢ You can now include CC and BCC e-mail addresses within the <pdfexplode></pdfexplode> tag.

I Variables Enhancements

¢ You can now use a variable to provide the e-mail From address.

¢ The number of variables supported has been expanded to six to allow for the From address.

¢ You may now include commas within variable values such as in company names (e.g. United Data Strategies, Inc.) or in numbers
(e.g. $1,234).

I Cover Sheet Enhancements

¢ A cover sheet may now be inserted either at the beginning or the end of the exploded PDF, or as a second attachment to an e-mail.
¢ A cover sheet may now be specified on a specific Default Message ID Tag, Client Details or a Client-specific Message ID Tag.
¢ Quick Mail now allows you to attach another PDF document, such as a cover sheet.

Ik Fax Server Support

¢ A new E-mail Address Format option allows you to control the format of the e-mail addresses you are sending to, which is useful for
sending e-mails to a fax server.

P New Utilities

¢ A new Completed Processing Notification option allows you to specify a process to be executed at the end of processing, such as a .BAT
or .EXE. You can use this feature to copy, move or delete PDF files and more.

¢ A new PDF Combiner utility enables you to combine multiple master PDF files that may then be exploded to send multiple reports to a
recipient in a single PDF attachment.

¢ A new PDF Viewer utility is included.

I Other Conveniences

+ PDF-eXPLODE Options have a new user interface making it easier to navigate.
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¢ A new item on the Printer Menu, Cancel, makes it easier to cancel a document that is being processed.

¢ Changes in the PDF-eXPLODE architecture improve its ability to withstand antivirus software attempts to disable/remove PDF-eXPLODE
program components.

Changes in the PDF-eXPLODE architecture improve support for larger and more complex documents.
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What's New in Version 4

This topic presents the new features of PDF-eXPLODE Version 4 to users already familiar with the features in Versions 1, 2 and 3. Below is a
summary of the new features with links to the help topics that describe each feature in more depth.

Windows Support

o PDF-eXPLODE now works with Windows 7, Windows Server 2008 and 64-bit versions of Windows.

Program Architecture

¢ A new exploding engine processes jobs up to 100% faster, new PDF creation engine produces PDF files up to 25% faster.
¢ Printer Server and Terminal/Citrix Server versions now create a separate print queue for each user to avoid collisions.

Exploding / E-mailing Options

Two methods of exploding: You can choose between exploding a pag where a Tag exists OR you can explode all blank pages
(without a tag) based on the a previous page with a tag.

E-mail blast without PDF attachments: You can now configure PDF-eXPLODE to not include PDF attachments when sending
e-mails. This feature is available in Mail Settings or can be specified on a specific Default Message ID Tag, Client Details or a
Client-specific Message ID Tag. This feature enables you to use PDF-eXPLODE as a bulk e-mail merge program. Using variables in
the <pdfexplode> tag, you can merge database information into the e-mail subject and message. Plus, you can optionally include
a cover sheet of any file type (PDF, DOC, etc).

Attach multiple PDF files: You can now configure PDF-eXPLODE in General Settings to attach multiple PDF files to an e-mail
when they are addressed to the same e-mail address. The default behavior is still to send only one PDF attachment per e-mail.
Use variables to assign distinct names to the exploded PDF files.

Include multiple cover sheet files: You can now include multiple cover sheet files. If you select to attach them as separate
files, files can be of any type (not limited to PDF.) This feature is available in General Settings or can be specified on a specific
Default Message ID Tag, Client Details or a Client-specific Message ID Tag.

PDF-eXPLODE Exploding Method: The exploding engine now offers 2 distinct methods of exploding:

1. Only pages containing a TAG will be exploded: This is the default method where every page must contain a tag. A
blank Tag page will be ignored in the exploding process.

2. Blank TAG pages are exploded using the previous Tag page: if your document does not contain TAGs on every
page, the engine can be configured to explode the ‘blank-Tag’ page(s) using the last Tag found on a page immediately
prior to the blank Tag page. You can also 're-tag' a page again in the batch which will be then combined with previous
pages

PDF-eXPLODE tag:

1. You can now use curly braces ({})or square brackets ([]) instead of angle brackets (<>). For example: {pdfexplode}...{/
pdfexplode} or [pdfexplode...[/pdfexplode] are valid, but you cannot mix angle brackets, curly braces and square brackets
within a tag.

2. The maximum length of the contents of a PDF-eXPLODE tag is increased to 240 characters from 190 (i.e. the text
between <pdfexplode> and </pdfexplode>.

Certain invalid characters will be replaced automatically. For example, forward slash (/) will be replaced by
hyphen (-) if used within a date or underscore (_) if used within a name. Double-quote (") will be replaced by
single-quote ().
Set Reply To e-mail address: You can now control the return path in the e-mail internet header in Mail Settings or in Variable
Settings separately from the sender e-mail address.

¢ Variables:The number of variables supported is increased from 6 to 9. You can circumvent the limit of 9 variables using
the new VSplit() and MSplit() functions to extract portions of a variable within an e-mail subject or message (see next
item).

¢ You can manipulate and format variables in e-mail subjects and messages using programming functions, including:
VSplit(), MSplit(). Replace(), FormatDate(), Ndays(), Upper(), Lower(), Proper(), Replace(), Trim().

¢ You can now set the variable used as the From Address to also set the Return Path / Reply To address. You can also now
specify a coversheet file name using a variable on a specific Default Message ID Tag, Client Details or a Client-specific
Message ID Tag.

¢ You can now specify nested folders in a variable used for the exploded file folder.

Print number of copies: If you print to a physical printer (print only / print also), you can now specify the number of copies.
Drag-and-drop PDF files to explode and e-mail: If you have created a master PDF with another PDF creator and it includes
<pdfexplode> tags, you can drag-and-drop the file onto the PDF-eXPLODE window to explode and e-mail. PDF files using version
1.7 or lower of the PDF format are supported.

Combine PDF files from the command line: You can now automate the process of combining master PDF files so that it is
possible to include multiple reports into a single e-mail attachment. Use the command line to automate the process.
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e Embed Images like Logos in your HTML message using our HTML editor: Choose any JPG, GIF or PNG from either your
Hard Drive or from a URL and the editor will add the HTML code required to embed the images into an HTML message at the
time of when sending.

¢ Insert a watermark on each page of the ‘Master PDF’ using our script language

Administration Enhancements

Job completed e-mail log: You can now attach the log from the current job to the job completed notification e-mail. The log is
in comma-separated values (CSV) format and includes the exploded PDF file name and path, e-mail address, date and time.
Re-start interrupted process: If the PDF-eXPLODE process is interrupted after creating the temporary exploded PDF files
(named *_expl.pdf), you can manually restart the process and complete the naming, e-mailing and archiving steps. Use the
command PDFEXPLODE.EXE —CONTINUE "FolderPath of the_expl.pdf ", for example, PDFEXPLODE.EXE —CONTINUE "C:\PROGRAM
FILES\PDFS".

Configurable log and settings file locations: Registry entries are now used to specify the location of log and settings
(pdfexplode.ini) files. Registry entries are created under HKEY_LOCAL_MACHINE\Software\PDFeXPLODE on 32-bit computers, or
HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\PDFeXPLODE on 64-bit computers.

Log SMTP e-mail details: You can now configure logging to optionally capture the complete conversation between PDF-
eXPLODE and the SMTP server to help diagnose problems.

Individual user settings on Printer Server: Now each user can have their own settings on a printer server based on their
Windows user account name. A new command line parameter enables administrators to easily setup user accounts.

Copy settings utility for Printer Server: A utility program aids in multi-user administration by allowing you to copy settings
from one user to another user.

Anti-virus compatibility: A new PDF-eXPLODE program architecture is more resistant to anti-virus software that interrupts the
PDF-eXPLODE process.

Font configuration simplified: It is no longer necessary to manually configure the printer driver’s font substitution table. This
was necessary on some computers to support newer Windows fonts.

Utility Programs

Retired

A new PDF Splitter utility can be used to explode a PDF having no <pdfexplode> tags, resulting in a separate file per page
( Pg0001.pdf, Pg0002.pdf...Pg9999.pdf.) You can specify a filename prefix.
A new PDF Rotate utility can be used to to rotate landscape-oriented pages within a PDF to portrait orientation (counterclockwise
90 degrees).
A new PDF Viewer utility program is faster and more accurate.
¢ A new PDF Printer utility includes the following enhancements:You can now configure the number of copies to print in the
printer driver
¢ You can now print password protected PDFs.
¢ You can now print to any printer on the network.
¢ You can now run the print program from the end of processing program (i.e. from the command line) to automate a
process.
A new PDF Explode & E-mail utility program Makes it easy to process PDF files created using other software.
A new Copy Message ID utility program can copy one Message ID to another default Message ID, specific Client ID or Client-
Message ID.

Features

The Outlook address lookup feature is no longer supported.

The PDF Viewer included with Version 3 has been replaced by the PeXPDFViewer described above.

The button labeled View Transaction Logs on the Logging and Utilities screen is no longer available. In its place, PDF-eXPLODE
now creates a log file for each job in an Excel-compatible CSV format. Job logs are stored in a folder named with the Windows
user account under the LOGS folder in the PDF-eXPLODE program folder. The log file can be attached to the Completed Processing
Notification.

PDF-eXPLODE


What&apos%3bsNewVersion4.htm#
What&apos%3bsNewVersion4.htm#

Installing
PDF-eXPLODE simplifies the installation process with its wizard setup file. With a minimum of mouse clicks,
you can install the program on any drive or to any folder. Configuration of the program post install is very
important and the setup program comes with a PDF that explains configuration as a step-by-step process.
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System Requirements

¢ Operating System: Microsoft Windows XP, Windows Server 2003, Windows Server 2008, Windows Vista or Windows 7
¢ Hard Drive: Minimum 52.5MB of free disk space, plus additional space for PDF files created

e RAM: At least 64MB of available memory, more during PDF creation. The size of the PDF that can be created is limited by the amount of
available memory.
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Install PDF-eXPLODE

I Log on to Windows

¢ If you are installing PDF-eXPLODE on a server you must be logged on at the console as the administrator.
- Or -
o If you are installing PDF-eXPLODE on a work station or standalone PC, we recommend that you log on as the administrator however it is
not a requirement.

P Download PDF-eXPLODE

¢ Click the link on the website to download the PDF-eXPLODE setup program, PDF-eXPLODE Setup.exe.
¢ Click Save when you are asked “"Do you want to run or save this file?”
¢ Select a folder on your hard drive in which to save the setup file.

I* Run the Setup Program

¢ When the download is complete, click Run.
¢ If you receive a security warning stating that the publisher could not be verified, click Run.
¢ When you see the Setup Wizard Welcome screen, click Next.

I License Agreement

¢ Read the License Agreement, select I accept the agreement and click Next.

I Select Destination Location

¢ Select the folder in which you want PDF-eXPLODE program files installed and click Next.

I Select Components

¢ Click Next for Full Installation.

I Select Start Menu Folder
You may select where to create the PDF-eXPLODE program shortcuts.

o If you want to create the shortcuts in the Start Menu PDF-eXPLODE folder, click the Next button.
o If you want to select a different folder, click the Browse button and find the folder you want, or type the full pathname of the folder you
want, and then click the Next button.

I Select Additional Tasks

¢ Select Create a desktop icon to be able to launch PDF-eXPLODE from your desktop using a Windows shortcut.
¢ If you select to create a desktop icon, select whether you want the desktop icon For all users or For the current user only.
¢ Select whether to Create a Quick Launch icon. Selecting this option adds a shortcut icon for PDF-eXPLODE to the Quick
Launch portion of the taskbar located next to the Start button. If the Quick Launch bar is not displayed, right-click an empty
area on the taskbar, point to Toolbars, and then click Quick Launch.
¢ If you right-click an empty area on the taskbar and do not see the Toolbars option, click Lock the Taskbar to clear the check
mark.
¢ Select whether to Create an entry in the Windows Explorer context menu. Selecting this option enables you to right-click a file,
such as a Word document, and create a PDF file using PDF-eXPLODE.

I Ready to Install

¢ Review your settings.
¢ Click Install to proceed or click Back to make any changes.
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P Completing the PDF-eXPLODE Setup Wizard
To complete the installation, you may be asked to restart your computer.

¢ Select Yes, restart the computer now or No, I will restart the computer later if you are not ready to restart and begin using
PDF-eXPLODE.
¢ Click Finish.

I Post Installation
Assign "Full control" permissions to the following folders (and their sub-folders) for the Windows user account(s) that will be using PDF-
eXPLODE.

¢ The PDF-eXPLODE program folder. The default location of the program folder on 32-bit systems is C:\Program Files\PDF-eXPLODE and
on 64-bit systems is C:\Program Files(x86)\PDF-eXPLODE.

e C:\Temp.

¢ If you are installing PDF-eXPLODE on Terminal Server or Citrix Server, C:\Windows\Temp.

« If later on you change the default folder(s) in which PDF files are saved, you must also assign Full control permissions to that folder(s) as
well.

To assign Full control permissions (this procedure may be slightly different depending on the version of Windows):

Open Windows Explorer and navigate to the desired folder.
Right-click the folder and select the Security tab.

Select the desired user name or group.

Click Edit.

Select the Full control checkbox.

Click OK twice.

ounhronNE

If, when you print to the PDFeXPLODE printer, the message "System cannot find the file specified" displayed, set the PDF-eXPLODE
programs to run as administrator.

1. Navigate to the PDF-eXPLODE program folder.

2. Right-click PDF-eXPLODE.exe.

3. Select Properties.

4. Click the Compatibility tab.

5. Select the checkbox labeled "Run this program as an administrator" or "Allow non-administrators to run this program" (the
exact wording depends on the version of Windows.)

6. Click OK.

7. Navigate to the C:\Windows\System32 folder and repeat this procedure for the file named pdfexplodespl.exe.

If you are using Windows Vista or Windows 7 and, when you print to the PDFeXPLODE printer, warning messages are displayed, turn off
User Account Control.

Open the Windows Control Panel.

Select User Accounts.

Select Change User Account Control settings.
Change the setting to Never notify.

Click OK.

uihwnN=

I Getting Started

o If you logged in as administrator to install PDF-eXPLODE, log out and log back in as the user.

¢ To begin using PDF-eXPLODE, please review the help topic Getting Started.

o If you installed PDF-eXPLODE on a network shared computer, for example to use with Terminal Services, Citrix, Business Objects
Enterprise, Crystal Reports Server, SQL Server Reporting Services or as a network shared printer, there are special considerations and
configuration settings discussed in the topic on Multi-user Administration.
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Multi-user Administration

PDF-eXPLODE may be installed on a network shared computer (e.g. server) that is used as a terminal server, printer server or report server.
However, please be aware that a PDF-eXPLODE server license is required. Refer to How Licensing Works for more information.

e Example terminal servers: Microsoft Terminal Services, a Citrix Server product
e Example printer server: any computer with PDF-eXPLODE configured as a shared printer
e Example report servers: BusinessObjects, Crystal Reports Server, SQL Server Reporting Services (SSRS)

P Installation

o Install PDF-eXPLODE at the computer's physical console — Do not install via a remote session.
¢ Log on to Windows using the Administrator account — Do not log on using a User account with "administrator privileges".

Ik Server Configurations

PDF-eXPLODE Terminal Server
You may configure PDF-eXPLODE in one of two ways: Each user can have their own settings (the default) or all users can share the
same settings.

¢ To configure PDF-eXPLODE so that all users share the same settings, navigate to the REG folder under the PDF-eXPLODE
program folder (default is C:\Program Files\PDF-eXPLODE) open the file named TurnAdminIni_ON.reg. Click OK when prompted.
This will direct PDF-eXPLODE to use the settings for the Administrator user account.

¢ To configure PDF-eXPLODE so that each user has their own settings, navigate to the REG folder under the PDF-eXPLODE
program folder (default is C:\Program Files\PDF-eXPLODE) open the file named TurnAdminIni_OFF.reg. Click OK when prompted.
This will direct PDF-eXPLODE to use the settings for the logged-in user account. This is the default setting after installation.

PDF-eXPLODE Printer Server

¢ During installation, PDF-eXPLODE is configured to store settings under the Windows Administrator user account (This is
equivalent to manually executing the file TurnAdminIni_ON.reg located in the REG folder in the PDF-eXPLODE program folder.)

¢ During installation, PDF-eXPLODE is configured to select Very Silent mode in General Settings to prevent dialogs that require user
interaction from displaying on the server console.

¢ In the Windows Printers & Faxes folder, right-click PDFeXPLODE, select Sharing..., enable Share this printer, and enter Share
name: PDFeXPLODE.

¢ On each workstation that requires access to PDF-eXPLODE Printer Server, open the Windows Printers & Faxes folder and add the
shared PDF-eXPLODE printer.

¢ To evaluate PDF-eXPLODE Printer Server with a trial license, log on to the server using the Administrator account. After you print
from a workstation, the Evaluation dialog will display on the server. Select Evaluate this software and click Continue to proceed.
This step is not required when you have a paid license.

You may configure PDF-eXPLODE in one of two ways: Each user can have their own settings (the default) or all users can share the
same settings.

¢ To configure PDF-eXPLODE so that all users share the same settings, navigate to the REG folder under the PDF-eXPLODE
program folder (default is C:\Program Files\PDF-eXPLODE) open the file named TurnAdminIni_ON.reg. Click OK when prompted.
This will direct PDF-eXPLODE to use the settings for the Administrator user account.

¢ To configure PDF-eXPLODE so that each user has their own settings, navigate to the REG folder under the PDF-eXPLODE
program folder (default is C:\Program Files\PDF-eXPLODE) open the file named TurnAdminIni_OFF.reg. Click OK when prompted.
This will direct PDF-eXPLODE to use the settings for the logged-in user account. This is the default setting after installation.

A utility program is available in the PDF-eXPLODE program folder to copy the settings of one user to another user. Run the utility
either from the Windows command prompt or from the Start Run command. The syntax is as follows:
PeXCopy FromUserWindowsAccount ToUserWindowsAccount
For example, to copy Mark's settings to Rob:
PeXCopy Mark Rob
If there are embedded spaces, surround the user account name in double quotes:
PeXCopy "Mark Smith" "Rob Jones"

PDF-eXPLODE Report Server
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¢ During installation, PDF-eXPLODE is configured to store settings under the Windows System user account (This is equivalent to
manually executing the files TurnAdminIni_ON.reg and TurnSystemIni_ON.reg located in the REG folder in the PDF-eXPLODE

program folder.)

During installation, PDF-eXPLODE is configured to select Very Silent mode in General Settings to prevent dialogs that require user

interaction from displaying on the server console.

¢ To evaluate PDF-eXPLODE Printer Server with a trial license, log on to the server using the Administrator account. After a

scheduled report is printed, the Evaluation dialog will display on the server. Select Evaluate this software and click Continue to
proceed. This step is not required when you have a paid license.

I Using the Trial License for Evaluation

¢ If you are using the Trial License, please be sure to close PDF-eXPLODE after changing or viewing settings.

¢ If you have set Administrator account settings ON, you must be at the server console to respond to the Evaluation dialog that appears
each time you print to PDF-eXPLODE.

PDF-eXPLODE Evaluation
Thank vou for choosing PDF-eXPLODE, an easy-to-use Printer

driver software designed specifically for businesses who need an =

autornated solution to burst ("eXplode”) & distnbute via email, =

information in PDF format from any Windows based word

processor of report writer document '
PDF-eXPIODE

Please select from the following options

" [Purchase this software oning

Actronte onine Licence ID

(+ Ewalyale this softwane

Trial days left : 45

Suppmt
In LIS - Tel: (978) 579-9526

Em Coortrnes
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What's Installed Where

When you install PDF-eXPLODE, the following files and folders are created on your system. If you remove PDF-eXPLODE, you may
optionally keep your settings (PDFeXPLODE.ini).

Note: You may wish to periodically delete old files in the C:\Program Files\PDF-eXPLODE\LOGS and C:\Program Files\PDF-eXPLODE\PDFs
folders to make more disk space available.

Folder Files installed

C:\Program Files\PDF-eXPLODE Program, license file, properties and uninstall information (PDF-eXPLODE.exe, PDF-eXPLODE.If,
pdfexplode.properties, UninstPDFeXPLODE.exe, unins000.exe and unins000.dat)

This is the default program folder. You may change the default program folder at the time of
installation.

C:\Program Files\PDF-eXPLODE\CONTROLS Program component files.

This location may be configured using the Registry key:
32-bit Windows: \HKEY_LOCAL_MACHINE\Software\PDFeXPLODE\CONTROLDir
64-bit Windows: \HKEY_LOCAL_MACHINE\Software\WOW6432NODE\PDFeXPLODE\CONTROLDir

C:\Program Files\PDF-eXPLODE\EXPLODED PDFS  Folder created to contain exploded PDF files generated by PDF-eXPLODE.

The locations where exploded PDF files are archived can be configured in Mail Settings in the
Exploded File Path, or on a specific Default Message ID Tag, Client Details or a Client-specific

Message ID Tag.

C:\Program Files\PDF-eXPLODE\FAILED Folder will contain PDF files that failed to be sent by e-mail
C:\Program Files\PDF-eXPLODE\HELP Help file (PDF-eXPLODE.chm)

C:\Program Files\PDF-eXPLODE\ICONS Various icons used in the program group

C:\Program Files\PDF-eXPLODE\INIs PDFeXPLODE.ini (client, i.e. user, settings).

To allow multiple users to each have their own settings, files are stored in folders named withthe
Windows user account name.

This location may be configured using the Registry key:
32-bit Windows: \HKEY_LOCAL_MACHINE\Software\PDFeXPLODE\INIDir
64-bit Windows: \HKEY_LOCAL_MACHINE\Software\WOW6432NODE\PDFeXPLODE\INIDir

C:\Program Files\PDF-eXPLODE\LOGS\ Program log file (PDF-eXPLODE.log), spooler log file (PeXSPOOLER.log), the current run log
(PDFeXPLODERunLog.csv) and backup versions from previous runs.

To allow multiple users to each have their own log, files are stored in folders named with the
Windows user account name.

This location may be configured using the Registry key:
32-bit Windows: \HKEY_LOCAL_MACHINE\Software\PDFeXPLODE\LOGDir
64-bit Windows: \HKEY_LOCAL_MACHINE\Software\WOW6432NODE\PDFeXPLODE\LOGDir

C:\Program Files\PDF-eXPLODE\PDFs Folder created to contain PDF files (called "master" PDF files) generated by PDF-eXPLODE.
The folder where master PDF files are created can be configured in General Settings using Default
Document Path.

C:\Program Files\PDF-eXPLODE\Temp Folder created to contain temporary files for jobs in process. Files are moved here from C:\temp

\PDFeXplode.

To allow multiple users to each have their own temp files, files are stored in folders named with the
Windows user account name.

This location may be configured using the Registry key:

32-bit Windows: \HKEY_LOCAL_MACHINE\Software\PDFeXPLODE\PDTempDir
64-bit Windows: \HKEY_LOCAL_MACHINE\Software\WOW6432NODE\PDFeXPLODE\PDTempDir
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C:\temp\PDFeXplode Temporary files being transferred from the Windows printer spooler to the Temp folder under the
PDF-eXPLODE program folder.

To allow multiple users to each have their own temp files, files are stored in folders named with the
Windows user account name.

This location may be configured using the Registry key:
32-bit Windows: \HKEY_LOCAL_MACHINE\Software\PDFeXPLODE\PSTempDir
64-bit Windows: \HKEY_LOCAL_MACHINE\Software\WOW6432NODE\PDFeXPLODE\PSTempDir

C:\WINDOWS\system32 Application Extension and ActiveX control files required by PDF-eXPLODE
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Remove PDF-eXPLODE

You may need to remove PDF-eXPLODE from your computer. Note: If you are running a 45-day trial version and you remove and re-install
PDF-eXPLODE, the 45-day trial period will not reset.

I Removing PDF-eXPLODE
From the Start Menu

Click Start.

Point to Programs.

Point to the PDF-eXPLODE program group.
Click the Uninstall PDF-eXPLODE icon.

PN

From the Control Panel

Click Start.

Point to Settings.

Point to Control Panel.

Click the Add or remove programs

Scroll the list down until the PDF-eXPLODE icon is visible.

Click the PDF-eXPLODE icon.

Click Change/Remove.

Click Yes to confirm the program will be removed.

Select whether to delete all program settings (i.e. the PDF-eXPLODE.ini file).

LCONOUDWNE
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Purchasing and Registering
When you download your Free Trial, it extends for 45 days. During the evaluation period you are entitled to priority support.
Purchasing once you are done evaluating, will provide you with a perpetual license to use PDF-eXPLODE and the first 60 days of
the purchase comes with free priority support. After that, should you require any operating support, you must purchase a priority
support plan which is relatively inexpensive. This provides for a response to your requests or enquiry within 24 business hours.
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Trial Version

The PDF-eXPLODE trial version allows you to evaluate the product and all of its capabilities for a period of 45 days from the date on which
you install it. The trial version is the same software as the fully-licensed product with the following limitations:

Only the first 25 PDF files that are exploded will be e-mailed and archived.

E-mail messages will include promotional copy in the message footer with a link to the PDF-eXPLODE website.

Archived PDF files will contain a cover page indicating that the file was created with an unlicensed copy of PDF-eXPLODE.
The trial version cannot be used after 45 days following installation of the software.

To remove the trial version limitations and have a full-licensed, fully-functional product, purchase and register a license at any time during
or after the 45-day trial period. You will receive a license id and password that must be activated over the Internet and will remove the trial
version limitations - there is no need to uninstall or re-install the software.
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Purchase Online

When you open the Trial Version of PDF-eXPLODE, either during or after the 45-day trial period, you may purchase a full product license to
remove the Trial Version limitations. Licenses are purchased over the internet using a credit card for payment. A license ID and password
will be provided immediately after payment is authorized and will be confirmed in an e-mail automatically sent to the e-mail address you
provide.

1. To begin, start PDF-eXPLODE.
2. In the PDF-eXPLODE Evaluation dialog box, select Purchase this software online and then click Continue.

PDF-eXPLODE Evaluation

Thank you for choosing PDF-eXPLODE, an easy-to-use Printer
driver software designed specifically for businesses who need an =
autormated solution to burst ("eXplode”) & distnbute via email, =
information in PDF format from any Windows based word
processor of repar writer document /
PDF-eXPLODE
Please select from the following options
& Purchase iis software onine
" Acthoabe onlne Licence D
(" Evaluals tha sofiwane
i Irick Manualy Vendor pae only
Trial days left : 45
Suppodt:
In US - Tel: (978) 579-9526 £t Cork

3. Click Yes when prompted Display order form?

D e b b Pl ot ther el e i e I s g mincy oo i Lt D red iy, R arbe Bhn Plorsnaten.  Offterwes, didk
Yk

] e | e

4. Click OK when prompted About to display order form

i Wouw weeh becesrer wll ross bybe you drectly o the onlire ordes Fome. Wihen ypos) b complisted) Bhes ordering process,. pend out the peceipt ared
i OF ok our Becawser. Wi vl Ehen be shls [ EpTss 0 yROF order nformation o this spelcstion R proderly anlodk i

5. The Order Process form will appear in an Internet browser window. Complete the online forms and print the completed order
invoice, which contains your License ID and Password.

Now select Activate online License ID and click Continue.

The Unlock via Internet dialog box will appear in a separate window. At the end of the order process you were supplied with a
License ID and Password.

N
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Unlock via Internet

Enber wour oodes micimation piovided on pous electnonss iscept

F'!wl

Lcense i |
Password [

8. Enter your License ID and Password in the Unlock via Internet dialog box and then click OK.
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Register Online

When you purchase PDF-eXPLODE online, you can activate the license at the same time after completing the order process. However, it is
not necessary to register at the time you purchase - you may do so at any time thereafter by following the steps below. Registering your
product will remove the Trial Version limitations.

After purchasing online, a license ID and password were provided in an invoice for you to have printed and were confirmed in an e-mail
automatically sent to the e-mail address you provide. You will need these to register.

1. To begin, start PDF-eXPLODE.
2. In the PDF-eXPLODE Evaluation dialog box, select Activate online License ID and then click Continue.

PDF-eXPLODE Evaluation

Thank you for choosing PDF-eXPLODE, an easy-to-use Printer

driver software designed specifically for businesses who need an =
automated solution to burst ("eXplode") & distribute via email, =
infarmation in POF format from any Windows based word

processor of report wnter document ’*

PDF-eXPLODE

Please select from the following cptions

" Purchase this software online
i) ;&]ir}:it_'e_'ﬁn:hilm_ s cﬂ:!
™ Evalusis ths software

~
Trial days left : 45

Supput;
In LIS - Tel: {978) 579-9526 £ Cork

1. Enter your License ID and Password in the Unlock via Internet dialog box and then click OK.

Unlock via Intermet

Enber pour ondes mfomation provided on pour elecinorss recept

License I |I e |

Password [
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Upgrading to Version 4

Installing

You will need to uninstall the previous version before you can install Version 4. The architecture and the installation routine has
completely changed, so it is best to install PDF-explode V4 into a different folder after uninstalling. This ensures that Windows
does not point old registry references to the new files. Ideally just change the installed path to PDF-eXPLODEV4.

Before you uninstall, please save the PDF-eXPLODE.INI settings file using Win Explorer. Once you install PDF-eXPLODE V4, just restore the INI
file to the INIS sub-folder under the current user's folder in INIS (or Administrator if using a network product)

Once installed, open PDF-eXPLODE such that it is accessing the just saved PDF-eXPLODE.INI. Go through every screen ensuring the values of
check boxes and radio selection buttons (circles with a dot in the center)are correctly set.

In version 4:

o all previously stored 'text' or boolean (aka True/False) values have now been converted to an integer value of 1 = True, 0 = False or the

numbers 1,2..5 are assigned where a multiple selection is used
¢ all password encryptions have been changed. This means that the password MUST be retyped and then Saved (or 'Apply' clicked) to force a

recalculation.
« all email messages are now capable of word wrap and are not truncated at 75 characters. To leverage the benefit of a continuous paragraph

feed, you must retype and save the message.

PDF-eXPLODE



Getting Started Tutorials
Learn how to use PDF-eXPLODE in a few short lessons .
There are 3 basic steps to this process. Watch a 3-minute demo of PDF-eXPLODE
PDF-eXPLODE in 3 easy steps
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Create a PDF File

The purpose of this help topic is to show how to create your first PDF file using PDF-eXPLODE. PDF-eXPLODE is a valuable tool for
automatically separating a large document into individual sections and sending them as e-mail attachments to different recipients. However,
PDF-eXPLODE can also be used simply to save a document in a PDF file as follows.

The following instructions assume you have just installed PDF-eXPLODE and have not yet changed the default configuration settings. Please
note the default paper size supported by PDF-eXPLODE is Letter. If your paper size is different, for example A4, you must edit the PDF File
Creation Properties and set the appropriate Paper Size before proceeding.

I Create a PDF File

Open an existing document in an application such as Microsoft Word.

On the File menu, click Print.

In the Print dialog box, select the printer named PDF-eXPLODE and click OK.
When PDF-eXPLODE displays the Print Options dialog, click Create PDF.

In the Save as dialog box, select a folder, enter a file name and click Save.

ahwnN=

Ik View a PDF File

You may view the PDF file you just created if you have a PDF viewer installed such as the free Adobe Reader, available at www.adobe.com.
If you do not have a PDF viewer installed, PDF-eXPLODE includes one named PeXPDFViewer, which can be accessed from the Logging and
Utilities screen.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.
-Or-

Right-click Start and click Explore.
Select the folder in which you saved your PDF file.
Double-click the PDF file you created to open it.
4. Close the PDF when you are done viewing it. (If you leave it open and try to create it again you will get an error because the file is
still in use and cannot be overwritten.)

wn
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Explode a PDF File

At the heart of PDF-eXPLODE is the ability to explode, or separate, a PDF file into individual PDF files. This enables you, for example, to
select and combine different portions of a document into a resulting PDF file, or to e-mail different people different sections of a document.
The following instructions assume you have just installed PDF-eXPLODE and have not yet changed the default configuration settings.

I Specify the Exploded PDF Filename

1. Open an existing document in an application such as Microsoft Word. Make sure the document contains multiple pages.
2. At the top of page 1, type the following PDF-eXPLODE Tag, where "pagel_" is the filename prefix of the PDF file that will contain
the contents of page 1.

<pdfexplode>pagel_</pdfexplode>
3. In the page header, type the following PDF-eXPLODE tag, where "mydocument_" is the filename prefix of the PDF file that will
contain the contents of page 1.

<pdfexplode>mydocument_</pdfexplode>

P Tips
¢ Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail, so the page header is the
ideal location to ensure each page is included.
¢ To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer. After typing the
text, click anywhere outside the header.
The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.
The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.
You may change the color of the tag to white to make it invisible in the resulting document.
You may include multiple PDF-eXPLODE tags per page if you want to include a page in multiple exploded documents.
All of the pages associated with the same filename will be combined into a single PDF file.

I Create and Explode the Document
PDF-eXPLODE can create and explode a PDF. However, if you have an existing PDF created by another process, you can still use PDF-
eXPLODE to explode it - refer to the instructions for using PDF-eXPLODE from a Command Line.

On the File menu, click Print.

In the Print dialog box, select the printer named PDF-eXPLODE and click OK.

When PDF-eXPLODE displays the Print Options dialog, click Explode Now.

In the Save as dialog box, select a folder, accept the default filename or enter a different file name and click Save. (This is the
"Master" PDF file that contains the entire document. Any existing version is overwritten without warning each time you re-create
it.)

5. Click OK when prompted that PDF-eXPLODE successfully exploded the file.
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I View the Resulting PDF Files
You may view the PDF file you just saved if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.
_Or_

Right-click Start and click Explore.

2. Select the folder in which you saved your PDF file.

3. Double-click the Master PDF file you created to open it. (This is the file created in step 4 above, which defaults to the name
PDFeXPLODE.PDF.) Close your PDF viewer when done.

4. View your exploded PDF files in the same manner. The file containing all of the pages in the document will be named
"mydocument_*.pdf" where the "*" is the date and time the file was created. This feature helps in archiving different versions
of, say, an account statement that is sent monthly. The other file, containing only the first page of your document will be named
"pagel_*.pdf".
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E-mail a PDF File

Although PDF-eXPLODE can explode a document or report into separate PDF files without sending them by e-mail, most users will want to
take advantage of the ability to send e-mail attachments.
The following instructions assume you have just installed PDF-eXPLODE and have not yet changed the default configuration settings.

I Configure E-mail Settings
To e-mail a PDF file using PDF-eXPLODE, you first need to configure your e-mail settings. Follow the instructions on the Mail Settings topic.

Ik Specify the E-mail Recipient

1. Open an existing document in an application such as Microsoft Word.
2. In the page header, type the following PDF-eXPLODE Tag, replacing "me@somewhere.com " with your actual e-mail address.

<pdfexplode>me@somewhere.com</pdfexplode> I Tips
¢ Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail, so the page header is the
ideal location to ensure each page is included.
¢ To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer. After typing the
text, click anywhere outside the header.
The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.
The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.
You may change the color of the tag to white to make it invisible in the resulting document.
You may include multiple PDF-eXPLODE tags per page if you want to send a page to multiple recipients.
All of the pages associated with the same e-mail address will be combined into a single PDF file.

I Create, Explode and E-mail the Document
PDF-eXPLODE can create and explode a PDF. However, if you have an existing PDF created by another process, you can still use PDF-
eXPLODE to explode and e-mail it - refer to the instructions for using PDF-eXPLODE from a Command Line.

1. On the File menu, click Print.

2. In the Print dialog box, select the printer named PDF-eXPLODE and click OK.

3. When PDF-eXPLODE displays the Print Options dialog, click Options.

4. In the Options dialog box, under PDF-eXPLODE Settings, select Send by email to all email addresses from the
document tags, and then click Save.

5. In the Print Options dialog, click Explode Now.

6. In the Save as dialog box, select a folder, enter a file name and click Save.

7. Click OK when prompted that PDF-eXPLODE successfully exploded the file.

I+ View the Resulting E-mail
You may view the PDF file you just e-mailed yourself if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com.

1. In your e-mail inbox, locate the e-mail you just sent yourself.
2. Open the e-mail and then open the PDF attachment. Close your PDF viewer when done.

I View the Resulting PDF File
You may view the archived copy of the PDF file you just sent if you have a PDF viewer such as the free Adobe Reader, available at
www.adobe.com.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.
_Or_
Right-click Start and click Explore.

2. Select the folder in which you saved your PDF file.

3. Double-click the PDF file you created to open it. (The filename will be your e-mail address followed by the date and time.) Close
your PDF viewer when done.

I View the PDF-eXPLODE Log File
It is a good idea to check the PDF-eXPLODE Log File to be sure no errors occurred sending the e-mails.
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Click Start, point to Programs, point to PDF-eXPLODE, and then click PDF-eXPLODE.

On the Printer menu, click PDF-eXPLODE Options....

In the Options List, click PDF-eXPLODE Settings.

Click View Transaction Logs to display individual log files for each e-mail in an Explorer window. The PDF file names have the
word "SUCCESS" or "FAILED" appended to provide a compact summary status view.r Tips
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¢ Open a file if the name ends in "FAILED" to see a descriptive error message.

¢ Click View Detailed Log to display a detailed log of PDF-eXPLODE operations if you need more
information.

¢ The detailed log appears in chronological order of when events occur, so the most recent events appear
at the bottom.

¢ You can see all of the steps taken by PDF-eXPLODE and can note any errors encountered.

¢ Be sure also to check the e-mail inbox for the Sender Name you specified in PDF-eXPLODE
Connection Settings. Undeliverable e-mails may return error notification e-mails to this address.

5. On the Printer menu, click Exit to close PDF-eXPLODE.
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Automate the Process

As you begin to use PDF-eXPLODE on a routine basis, you may no longer want to interact with the Print Options dialog each time you use PDF-eXPLODE. A
feature called Silent Mode enables you to automate the complete process of document creation, explosion and e-delivery.

I Selecting Silent Mode

1. Click Start, point to Programs, point to PDF-eXPLODE, and then click PDF-eXPLODE.
2. On the Printer menu, click PDF-eXPLODE Options....
3. In the Options dialog box, under General Settings, select Explode/E-mail in Silent Mode.

Important: If you are using a PDF-eXPLODE Server product (Report Server, Printer Server or Terminal Server) you must also select
Suppress display of any processing dialogs in Silent Mode.
4. Click Save. On the Printer menu, click Exit to close PDF-EXPLODE.

I+ Specify the E-mail Recipient

1. Open an existing document in an application such as Microsoft Word.
2. In the page header, type the following PDF-eXPLODE Tag, replacing "me@somewhere.com " with your actual e-mail address.

<pdfexplode>mel@somewhere. com</pdfexplode>[’ Tips

* Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail, so the page header is the ideal location to
ensure each page is included.

* To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer. After typing the text, click
anywhere outside the header.

* The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.

* A tag must fit entirely on a single line.

* You may include multiple PDF-eXPLODE tags per page if you want to send a page to multiple recipients.

* All of the pages associated with the same e-mail address will be combined into a single PDF file.

* You may change the color of the tag to white to make it invisible in the resulting document.

I* Create, Explode and E-mail the Document

1. On the File menu, click Print. PDF-eXPLODE creates a master PDF, explodes it into a separate PDF for each e-mail recipient and sends each as an
e-mail attachment.

IF View the Resulting E-mail
You may view the PDF file you just e-mailed yourself if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com.

1. In your e-mail inbox, locate the e-mail you just sent yourself.
2. Open the e-mail and then open the PDF attachment. Close your PDF viewer when done.

I* View the PDF-eXPLODE Log File
It is a good idea to check the PDF-eXPLODE Log File to be sure no errors occurred sending the e-mails.

1. Click Start, point to Programs, point to PDF-eXPLODE, and then click PDF-eXPLODE.
2. On the Printer menu, click Show Log File.
3. View the log and click Close when finished

P Tips
* The log appears in reverse order of when events occur, so the most recent event is listed first.
¢ You can see all of the steps taken by PDF-eXPLODE and can note any errors encountered.
* Be sure also to check the e-mail inbox for the Sender Name you specified in PDF-eXPLODE
Connection Settings. Undeliverable e-mails may return error notification e-mails to this address.

1. On the Printer menu, click Exit to close PDF-eXPLODE.
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Reference
This chapter has details of each menu item
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Start PDF-eXPLODE

You may open PDF-eXPLODE from the Windows Start menu or, optionally, from the desktop icon, if you chose to create one during
installation. In addition, you may open PDF-eXPLODE from the Printers and Faxes Window.

I Starting PDF-eXPLODE
From the Start Menu

Click Start.

Point to Programs.

Point to the PDF-eXPLODE program group.
Click the PDF-eXPLODE icon.
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From the Desktop
If you chose to create a Desktop Icon during installation:

1. Double-click the PDF-eXPLODE icon.

From the Printers and Faxes Window

Click Start.

Point to Settings.

Click Printers.

Right-click the PDF-eXPLODE icon.
Click Open.

bl
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Main Menu

The PDF-eXPLODE program window displays the main menu and and the print queue. The main menu consists of a menu bar with the
following menu items.

P Printer Menu

¢ Click Suspend Printer to hold PDF-eXPLODE jobs in a queue until you are ready to proceed. For example, if you have a report that
takes a long time to generate and you do not want to be connected to the Internet during report generation you can stop the printer,
generate the report, then connect to the Internet and restart the printer to explode and e-mail the report.

When Suspend Printer is selected, a check mark will appear next to the menu item. Documents that you print while Stop Printer is
selected are held in the PDF-eXPLODE queue. The queue appears below the main menu and displays information about documents
waiting to be exploded and e-mailed.

Click Suspend Printer again to restart the printer and remove the check mark . Any print jobs pending in the queue will be
processed (exploded and e-mailed). When Suspend Printer is de-selected, processing continues. If silent mode is selected on
General Settings, the pending documents are exploded and e-mailed immediately. If silent mode is not selected then the Print
Options dialog is displayed to allow the user to control processing. Click Set As Default Printer to specify that PDF-eXPLODE is the
default printer used when you click Print on the File menu of many Windows-based programs. A check mark will appear next to the
PDF-eXPLODE printer icon in your PC's Printers and Faxes window.

P Tip
« To open Printers and Faxes, click Start, click Control Panel, click Printers and Other Hardware, and then click Printers and
Faxes.
¢ Click Cancel Document to remove the selected document(s) from the queue.
¢ Click PDF-eXPLODE Options... to display and/or modify options including General Settings, Security Settings and Mail Settings, as well
as Default Messages, Client Details and Client-specific Messages.
¢ Click Exit to close PDF-eXPLODE. It will still remain active as a printer driver enabling you to create, explode and e-mail PDF files when
you click Print on the File menu of many Windows based programs.

P View Menu

¢ Click Status Bar to display the status bar at the bottom of the PDF-eXPLODE window. When selected, a check mark will appear next
to the menu item. Click Status Bar again to hide the status bar and remove the check mark. The status bar displays a count of the
number of documents in the PDF-eXPLODE FAILED folder and in the queue.

P Help Menu

¢ Click Help Topics to access PDF-eXPLODE help information.
¢ Click About PDF-eXPLODE to display license and system information.

Below the menu bar is a print queue showing any files that were printed to PDF-eXPLODE and are currently being processed. Refer to
Suspend Printer on the Printer Menu for more details.

The print queue may also be used a shortcut for printing documents to PDF-eXPLODE. To do so, simply drag-and-drop a file from Windows

Explorer onto the PDF-eXPLODE print queue. Note that document types that store a printer name (e.g. Microsoft Word documents) must be
saved with PDF-eXPLODE as the named printer.
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Specifying Options
This chapter relates to each Menu item you access when you open the PDF-eXPLODE configuration screen "Options".
To open the Options screen, start PDF-eXPLODE from the desktop using the shortcut, and then click Options from the "Printer" menu.
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General Settings

General Settings let you choose how you want to create and deliver the PDF files created by PDF-eXPLODE, as well as some default
document properties.

To begin, start PDF-eXPLODE.
I Open General Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click General Settings.

Pk E-Mail

¢ Choose Explode only, no E-mails if you want to explode the master PDF but do not want to send exploded PDF files by e-mail to
clients. This option might be used to generate exploded PDF documents for archiving or for distribution via a network folder or FTP, or
for testing so that exploded PDF files can be viewed before being sent.

¢ Choose Explode and E-Mail to all tag e-mail addresses to send exploded PDF files by e-mail to all e-mail addresses in the
document tags. This option is selected as the default. Note: Tags that are not valid e-mail addresses will not be sent but the exploded
PDF files will be created.

¢ Choose Explode and E-Mail to only pre-defined Client ID E-mail Addresses to send only the individual PDF files tagged with an
e-mail address that you have defined in Client Details. This feature allows you to treat selected clients as special cases. Note: Tags that
are not valid e-mail addresses will not be sent but the exploded PDF files will be created.

P E-Mail Notification

¢ Choose None if you do not want to be notified by e-mail when a recipient reads an e-mail sent by PDF-eXPLODE.
¢ Choose Notify me on Read to receive an e-mail notification (called a "read receipt") when a recipient reads an e-mail sent by PDF-
eXPLODE. Note that not all e-mail servers support this option and also a recipient may optionally deny sending a read notification.

I E-Mail Flags

Select e-mail flags to apply to every e-mail that is sent. You may enable/disable the default e-mail flags for a specific e-mail message on

a Default Message ID Tags screen, for a specific client on a Client Details screen or for a client-specific e-mail message on a Client-specific
Message ID Tags screen. Note that some e-mail clients, such as Outlook Express, do not display all of the e-mail flags.

¢ Set Importance to Normal, Low or High. Press the Delete key to clear the selection.
¢ Set Sensitivity to Normal, Personal , Private or Confidential. Press the Delete key to clear the selection.

I Master PDF Properties
You may specify the following PDF creation options and PDF file properties, which apply to every PDF file created. Property fields including
Title, Author and Subject may be displayed when a PDF file is opened in a viewer such as Adobe Reader.

+ Explode/E-mail in Silent Mode: If you select this checkbox, the program will run in Silent Mode, meaning it will run unattended
after you initiate printing a document. This is the default option. If you have an application that can initiate printing from the Windows
Scheduler, then this option will enable you to e-mail documents when you are away from the computer. If you prefer to manage the
delivery process, uncheck the checkbox and manually set options in the Print Options dialog after you initiate printing a document. If
you print a document containing no PDF-eXPLODE tags, the Print Options dialog will display regardless of the Silent Mode setting (except
on PDF-eXPLODE Printer Server and PDF-eXPLODE Report Server, since dialogs cannot be displayed on the workstation.)

¢ Note: you must select this option (and Very Silent Mode - see below) when operating PDF-eXPLODE on a Printer Server or Report
Server that is running under the SYSTEM account since there is no user interface available for the SYSTEM account. Failure to do so
will result in the application appearing to be frozen.Suppress display of any processing dialogs in Silent Mode [Very Silent
Mode]: If you have selected Explode/E-mail in Silent Mode and select this checkbox, then all dialog and message windows will
be suppressed. This is helpful if you want to process files with PDF-eXPLODE in the background while you work on other Windows
applications.

Note: you must select this option when operating PDF-eXPLODE on a Printer Server or Report Server that is running under the
SYSTEM account since there is no user interface available for the SYSTEM account. Failure to do so will result in the application
appearing to be frozen.

¢ Default Document Title specifies the filename and title of the master PDF document.r Tips
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If you want to specify a different master PDF document name for different documents, create a Default Message ID, for example
Invoice, and use Exploded File Name to specify the file name, for example MasterInvoices. Then insert a <pdfexplode> tag on
every page of your document as follows:
<pdfexplode>Invoice# </pdfexplode>
¢ Use the Default Message ID Exploded File Path to designate a folder in which to save the file.

¢ Default Author shows the name of the person who created the PDF document.

¢ Default Subject specifies the subject of the PDF document.

o Default Document Path selects the folder in which the master PDF document and the exploded PDF documents are saved. Before
the individual PDF documents are created, a master PDF document is created, so it can be “exploded,” or split, into individual PDF
documents. The recommended setting for this property is C:\Program Files\PDF-eXPLODE\PDFs, where C:\Program Files\PDF-
eXPLODE is the name of the folder where the program is installed. Click Browse to navigate to the desired folder. You may override the
location of the exploded PDF documents for a specific e-mail message on a Default Message ID Tags screen, for a specific client on a
Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen.

I Default Cover Sheet

¢ Cover Sheet specifies whether to insert an existing PDF file into each exploded PDF, and specifies the full pathname to the selected
PDF. The selected PDF may be any number of pages. Use this feature for such applications as including a generic newsletter or
promotion in every PDF file created by PDF-eXPLODE. PDF-eXPLODE will not insert a cover sheet if the exploded PDF file is password
protected. If the cover sheet is attached separately, it can be any file type (i.e. not restricted to PDF.)Select the checkbox to enable
insertion of the cover sheet, or de-select the checkbox to disable this feature.

¢ Select whether to position the cover sheet file in the Front or Back of the exploded PDF file or as a Separate attachment. If you
select Front or Back, the cover sheet file must be a PDF. If you select Separate, the file can be any type.

¢ Click Browse to navigate to the desired PDF file name. If you select to attach the cover sheet as a separate file, you can select
multiple files by separating the filenames with a vertical bar (|) character. For example, to attach three files, you could enter:

C:\CoverSheet1.pdf|D:\CoverSheet2.doc|C:\CoverSheet3.xls
I Tips
¢ You may use this feature in combination with the cover sheets defined on a Default Message ID Tags screen, for a specific client on a
Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen for cover sheets inserted in the
Front or Back of the exploded PDF files. Both cover sheets will be included.
¢ If you select to include both the Default Cover Sheet PDF as a Separate PDF attachment and also specify a Cover Sheet PDF as a
Separate attachment on a Default Message ID Tags screen, Client Details screen or a Client-specific Message ID Tags screen, the
default cover sheet attachment will not be included.
Note: If you select to include the Default Cover Sheet PDF as a Separate attachment PDF Security Settings will be ignored, i.e. the
behavior will be the same as when Security Mode is set to Do Not Secure any PDF document after exploding.

I File/Email Options

+ Date-Time Stamp options specify whether to append the date and time to PDF file names. Appending the date and time may be
helpful in organizing multiple versions of the same file.Suppress DATE_TIME on exploded filename: If you select this checkbox,
the date and time will not be appended to the names of the exploded PDF files (i.e. the archived versions). Note that this option does
not affect the attachment PDF files (i.e. the e-mailed versions).

« Suppress DATE_TIME on e-mail attachment file: If you select this checkbox, the date and time will not be appended to the
names of the attachment PDF files (i.e. the files attached to e-mails). Note that this option does not affect the exploded PDF files (i.e.
the archived versions).

¢ Add leading '_' character to DATE_TIME in File names: This option is only available if you select one of the above DATE_TIME
options. If you select this checkbox, the DATE_TIME appended to exploded file names and attachment file names will be preceded by
an underscore (_) character.

¢ E-mail Address Format options allow you to control the format of the e-mail addresses you are sending to, which is useful for sending
e-mails to a fax server.Standard Format: This is the default selection and is the best choice for most users. It assumes the e-
mail addresses in your <pdfexplode> document tags are in the standard e-mail format such as <pdfexplode>nancy@pdf-
explode.com</pdfexplode>.

¢ Fax Sending 1: This format can be used with fax servers that expect the e-mail address to be in a format like: 9780001234 <pdf-
explode@myfaxserver.net>. The e-mail address in the <pdfexplode> tag should be formatted slightly differently as:
<pdfexplode>9780001234!pdf-explode@myfaxserver.net</pdfexplode>, where the fax number is followed by an
exclamation point (!) and the angle brackets are omitted in the tag.

¢ Fax Sending 2: This format can be used with fax servers that expect the e-mail address to be in a format like:
Fax=9780001234@myfaxserver.net. The e-mail address in the <pdfexplode> tag should be formatted slightly differently as:
<pdfexplode>Fax9780001234@myfaxserver.net</pdfexplode>, where the equal sign (=) is omitted; it will be inserted by
PDF-eXPLODE before sending.
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Full Name Format: This format can be used when you want the recipient's full name to appear in the TO address instead of their
e-mail address. For example, if you are sending an e-mail to Mary Doe in Accounts Payable at pdf-explode.net, you may want the
TO address to appear as Mary Doe(Accounts Payable) instead of accounts@pdf-explode.net. The e-mail address in the
<pdfexplode> tag should be formatted as <pdfexplode>Mary Doe(Accounts Payable)!accounts@pdf-explode.net</
pdfexplode>, where the TO name is followed by an exclamation point (!) and the angle brackets are omitted in the tag. The e-mail
will be sent to Mary Doe(Accounts Payable) <accounts@pdf-explode.net>.
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Completed Processing Notification

You may configure PDF-eXPLODE to take certain actions upon completion of a print job. You may choose to send an e-mail alert and/or run
an external process at the end of processing.

To begin, start PDF-eXPLODE.

I Open Completed Processing Notification

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Completed Processing Notification.

I E-mail Notification
You may specify the recipient's e-mail address, the e-mail subject and e-mail message.

Send a message at the end of a print run processing: Select this checkbox to enable e-mail alerts.

Attach the current run log with this message: Select this checkbox to attach a log file for the job that is triggering the e-mail
notification. The log is in CSV (comma-separated values) format and includes the exploded PDF file name and path, e-mail address, date
and time. This is especially helpful for users in a PDF-eXPLODE Server configuration who do not have access to the log file saved on

the server. The file can be opened in a program such as Notepad or Microsoft Excel for viewing. Job logs are stored in a folder named
with the Windows user account under the LOGS folder in the PDF-eXPLODE program folder. This file will not be created if no e-mails are
generated in the job.

To - allows you to enter one or more e-mail addresses separated by commas (,).

Subject - contains the e-mail subject. You may insert variables within the subject to create a mail merge if you have selected Use
variables in e-mail on the Variable Settings screen.

Message - contains the e-mail message. You may insert <<Date>> and <<Time>> where you want PDF-eXPLODE to fill-in the
current system date and/or time at the moment the e-mail is sent. You may insert variables within the subject to create a mail merge if
you have selected Use variables in e-mail on the Variable Settings screen.

I Tips for Using a Variable

¢ When using a variable in the Subject or Message, the value should be a constant, i.e. the variable should contain the same value
for all tags in the document since only the last instance is used. This capability is useful for inserting the name of the report, for
example.

I Program Processing
You may specify a process to be executed at the end of processing. You might use this feature to copy, move or delete PDF files. For more
information on obtaining a program to copy, move and delete files send an e-mail request to mail@3000ad.com.au.

Execute a Batch file or Program at the end of the processing run: Select this checkbox to enable program processing.
Select whether to execute the Batch file (.BAT) or Program (.EXE) Before or After the E-mail Notification.

Enter the full pathname of the Program to Run or click Browse to select it.

Enter any necessary Program Parameter, or if the parameter is a filename click Browse to select it.

Click Test Program to ensure it works as desired.

I Tip

¢ Use the PeXPrintPDF print utility (located in the Program folder) and print a PDF. PeXPrintPDF supports the following command
line parameters where the first two parameters are required and the last three are optional:
-PRINT, PDFpathname [,printername] [,#copies] [,password]
For example, "C:\Program Files\PDF-eXPLODE\PeXPrintPDF.exe" -PRINT, "C:\Program Files\PDF-eXPLODE\PDFS
\PDFeXPLODE.pdf",HP LaserJet 3300 Series PCL 6
¢ Omit the printername to use the default printer
e Omit the # of copies to default to 1 copy
o If you skip a parameter, include the comma, for example, to print 2 copies to the default printer use:
"C:\Program Files\PDF-eXPLODE\PeXPrintPDF.exe" -PRINT, "C:\Program Files\PDF-eXPLODE\PDFS
\PDFeXPLODE.pdf",,2
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Logging and Utilities

Logging enables you to audit program operations, identify failed e-mails and diagnose unusual issues. Utilities provide capabilities to backup,
view and combine PDF files.
To begin, start PDF-eXPLODE.

I Open Logging and Utilities

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Logging and Utilities.

I Log Maintenance

¢ Log Program Operations: Select this checkbox to save a detailed log of the steps taken by PDF-eXPLODE including any error
messages, a summary transaction log noting the success or failure of each e-mail and any PDFs that failed to be sent.

¢ Log details of e-mails sent via SMTP: Select this checkbox only if you are having trouble sending e-mails via SMTP and want to log
the complete details to help diagnose a problem. Disable this feature when not needed to prevent the log file from becoming excessively
large. Thisoptions does not apply when sending e-mail via MAPI, or Outlook.

¢ Click View Detailed Log to display a detailed log of PDF-eXPLODE operations in a Notepad window. The detailed log contains
documents each step taken in exploding and e-mailing a PDF so there will be many lines of information per e-mail. Close the Notepad
window when you have finished viewing or editing the log file. If you continue using PDF-eXPLODE with a log file window opened,
changes will not be reflected - you will need to click View Detailed Log again to see any subsequent changes.

Note: On PDF-eXPLODE Server installations, for example a Printer Server, you may see multiple user accounts listed. Select the
desired user account name and then click View Detailed Log to view the log for a particular user

b Tips
¢ The window may be sized and scrolled to facilitate viewing.
¢ The log is displayed in chronological order with the most recent operations appearing at the bottom.
¢ You may edit the log file as desired, for example, you may wish to delete older portions no longer needed or save an archive version
and clear it entirely.
* To copy text so you can paste it into another application, select the text, right-click the mouse and click Copy.
¢ For the locations of the PDFeXPLODE.log and PDFeXPLODE.ini files, refer to What's Installed Where.
¢ For more information on diagnosing problems using the log files, refer to Logging Operations.
¢ Click View Failed Mail PDFs to access PDFs that were not sent in an Explorer window. This feature will facilitate manually resending
PDF files that failed to send.* Tips
¢ You can manually resend a PDF using an e-mail client program such as Microsoft Outlook.
¢ Click Delete Log Entries to reduce the size of the detailed log file by deleting entries dated ON or BEFORE a selected date. You will be
prompted to enter the desired date, where the accepted date format will be displayed (it varies depending on your Windows Regional
Options).

I Tips

¢ The detailed log file can grow quite large over time. Deleting older entries periodically can improve performance when viewing the log
file and save disk space.

* You may wish to archive a copy of the detailed log file before deleting entries. You can copy the log file the same way you would copy
any file using Windows Explorer.

¢ For the name and location of the log file refer to What's Installed Where for details.

I PDF File Backups

* Don't Create BKP (Master) and BAK (Exploded) Back-up Archive files: If you select this checkbox, backup copies of the master
PDF and exploded PDF files will not be created.
¢ Click Delete Backup Files to remove backup copies of PDF files dated ON or BEFORE a selected date. You will be prompted to enter
the desired date, where the accepted date format will be displayed (it varies depending on your Windows Regional Options.) You may
enter the desired file path where the files to be deleted are located, or click Browse to navigate to the desired file path. You may also
select whether to delete _bak or _bkp files. Files named *_bkp.pdf are backup copies of the master PDF and files named *_bak.pdf are
copies of exploded PDF files. After making your selections, click Process to delete the files and then click Close when done.lF Tips
¢ Deleting older files periodically will save disk space.
¢ For the default location of PDF files refer to What's Installed Where for details.
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Auto Backup of Option File to: If you select this checkbox, the file containing program options will be copied to the specified location
each time changes are saved. The default backup location if none is specified is the same directory in which the program options file
resides. For the name and location of the program options file refer to What's Installed Where for details. You may enter the desired file
path where you would like the backup copy to be saved, or click Browse to navigate to the desired file path.r Tips
If you need to maintain the same settings in two different user accounts (e.g. Administrator and SYSTEM), use this feature to
propagate the changes to the other user account.

I PDF Viewer

Click Browse to select a PDF file to view.
Click Open PDF to view the selected PDF.
You can also use the PeXPDFViewer utility (located in the Program folder) to view a PDF from a command line.

I PDF Utilities

Split PDF: Use this function to split a PDF that does not have <pdfexplode> tags, resulting in a separate PDF file for each page. Files
will be named using their corresponding page number, for example, 0001.pdf, 0002.pdf ... 9999.pdf. You can specify a filename prefix
to customize the file names.Enter a File name prefix: This is optional and will be pre-pended to file names. For example, enter the
word Page to create files named Page0001.pdf, Page0002.pdf etc.

Enter the Folder path where you want the spilt pdf files to be saved. Use the Browse button to navigate to the desired folder.

Enter the File Name & Folder Path for the input PDF file that you want to split. Use the Browse button to navigate to the desired
file.

Click Split PDFs to perform the operation.

Click Close when you are finished.

Combine PDFs: Use this function to combine multiple unsecured PDF files into a single PDF, which can then be exploded by running
PDF-eXPLODE from a command line, or by printing to PDF-eXPLODE from the PDF Viewer. Using PDF-eXPLODE in this manner will
enable you to combine multiple PDF reports and documents into a single e-mail attachment. If you want to create several master PDF
files without exploding them so that you can combine them and then explode the combined PDF, disable Silent Mode and then print

to PDF-eXPLODE and select Create PDF.Click Combine PDFs to select up to five unsecured PDF files to combine. Note: the PDF files
cannot have security applied, i.e. you cannot have an Owner or User password applied.

Click the Browse buttons to select the full pathname to the PDF you want to create (the output file) and up to five PDF files you want
to combine (the input files).

Click Combine PDFs to perform the operation.

Click Close when you are finished.

Rotate PDF: Use this function to rotate landscape-oriented pages within a PDF to portrait orientation (counterclockwise 90
degrees).Enter the File Name & Folder Path for the output PDF file that you want to create. Use the Browse button to navigate to
the desired file.

Enter the File Name & Folder Path for the input PDF file that you want to rotate. Use the Browse button to navigate to the desired
file.

Click Rotate PDFs to perform the operation.

Click Close when you are finished.

Explode & E-mail PDF: Use this function to explode and e-mail a PDF created by another PDF creator. Note that you can also use a
command line or drag-and-drop a PDF file onto the program window to accomplish the same outcome.Enter the File Name & Folder
Path for the PDF file that you want to explode and e-mail. Use the Browse button to navigate to the desired file.

Click Explode & E-mail to perform the operation.

Click Close when you are finished.

+ Copy Message ID: this utility copies a default Message ID to another Message ID, Client ID or a specific Client-Message ID.
This is useful when creating specific Client
i. Copy Message ID: Use this utility to copy a default Message ID to another Message ID, Client ID or a specific Client-Message
ID. This is useful when creating specific Client exceptions for a particular Message ID processing.
ii. Select a Message ID from the Input Message ID dropdown list. If no Message IDs have currently been created, then you
cannot proceed with this utility.
iii. Decide on whether you want to duplicate the Input Message ID to a new (Output) Message ID. You cannot insert the name of
an existing Message ID.
iv. Click the appropriate Copy To button to copy the Input Message ID to an Output Client ID or Client-Message ID. You cannot
insert the name of an existing Client ID.
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v. If copying to a Client-Message ID, you must enter either a new or existing Client ID name.
vi. Click Start Copying to run the copy process.
vii. Click Close when you are finished.

TIP

e Make a copy of a default Message ID to an Output Client-Message ID to enable you to create a specific Client exception as part of
a Message ID process run.

For instance:

¢ You are running the "Invoices" Message ID with a single e-mail for each exploded invoice PDF. However one destination
email client wishes to receive one email with all invoices attached. Copy the default "Invoices" Message ID as "Invoices"
to Client-Message ID text entry field. In the Client ID, show the e-mail destnation address as it shows in the tag.

¢ Once you create the copy, go to the Client-Message ID in the Options (under Mail Settings) screen and check the flag
Attach multiple exploded PDFs to one e-mail. This means that this client will receive all their Invoices in the "Invoices"
Message ID batch attached to one email whereas the rest of the destiation Clients will receive one e-mail for each
exploded PDF.

TIP

¢ To refresh the Mail Settings/ Default Message ID menu you will need to exit from the Options screen back to the Print Queue and
re-open the Print Options from the Printer menu

I PDF Printer Utility
Use the PeXPrintPDF print utility (located in the Program folder) to print a PDF from a command line.
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Variable Settings

Variables let you customize e-mail subjects and messages and allow you to generate PDF file names and path names at runtime. Variables

give you more control over the content of e-mail messages and help you better organize your PDF documents. If you are printing from

a program that provides the ability to perform calculations (such as Crystal Reports, SQL Server Reporting Services, R&R Report Writer,

Microsoft Access and Microsoft Excel) you can use formulas to compute the values of the variables.

For example, you might save a person's first name into a variable and begin an e-mail message "Dear <Var1>:" where "<Var1>" would be

replaced with a person's first name to produce "Dear John:". You can also use variables in file and folder names, where you might want to

save invoices in folders identified by a customer's name, and have the file name be the invoice number, for example, "C:\Invoices\CompanyA

\Invoice_12345.pdf".

PDF-eXPLODE allows for up to nine variables. Variables are passed to PDF-eXPLODE by placing them into the PDF-eXPLODE tag inserted into

your document. The format for including variables in the <pdfexplode> tag is as follows :
<pdfexplode>Var1,Var2,Var3,Var4,Var5,Var6%Message ID#ClientID</pdfexplode>

Variables may be omitted, for example, if you only want to pass variable 2 and variable 4, your tag would be in this format:
<pdfexplode>,Var2, Var4%Message ID#ClientID</pdfexplode>

NOTE: Be careful that your variable values do not inadvertently contain commas because the comma is used to separate variables. For

example, you might include a customer name as Smith, John, which would be interpreted by PDF-eXPLODE as two variables; the first

variable's value is Smith and the second variable's value is John. A similar problem can occur with numbers when a comma is used

as a thousands separator. For example, a customer account number 1234 may be inadvertently formatted as 1,234, which would be

interpreted by PDF-eXPLODE as two variables; the first variable's value is 1 and the second variable's value is 234.

If you must include a comma within a variable value, you may enclose the value within accent grave characters, i.e. the backwards single

quote character () or ASCII character 96, which is usually located on the same key as the tilde (~) to the left of the numeral one (1) key on

the keyboard. For example, “Smith, John" or *1,234" are permissible values that will preserve the embedded commas.

To begin, start PDF-eXPLODE.
I Open Variable Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Variable Settings.

I File Names
To use a variable to specify the name of the exploded PDF file, make the following selections.

¢ Select Use variable for exploded file name to enable this feature.
¢ Choose where you want the variable to appear in the file name.Choose Leading to use the variable as a prefix to the default file
name. For example, if the exploded file name is "_Invoice" and the variable value is "9995" then the resulting file name will be
"99995_Invoice.pdf".
¢ Choose Trailing to use the variable as a suffix to the default file name. For example, if the exploded file name is "Invoice_" and the
variable value is "9995" then the resulting file name will be "Invoice_9995.pdf".
¢ Choose Full name to use the variable as the complete file name. For example, if the exploded file name is "Invoice" and the variable
value is "9995" then the resulting file name will be "99995.pdf".
b Tips
¢ Note that the default file name is the client id in the <pdfexplode> tag, but may be overridden using the Exploded File Name option on
a Default Message ID Tag screen, Client Details screen or a Client-specific Message ID Tag screen.
Windows does not permit the following characters to be used in file names: < > :"/\ | ? *
Period (.) may not be used as the first character in a file name.
PDF-eXPLODE does not permit the following characters to be used in file names: # % @ ~
Apply a small font to a <pdfexplode> tag that includes variables because the tag can grow very wide and it must fit on a single line.
We recommend using Times New Roman font in 6 point font size.
¢ Select the variable to use for the file name: allows you to choose the variable whose value will be used in the file name. Select
Varl, Var2, Var3, Var4, Var5 or Var6.

I Sub-Folder Names

A variable may be used to name the folder in which a PDF file is saved. The designated folder is a sub-folder to the Default Document Path
specified on the General Settings screen, or the file path override specified on a Default Message ID Tag screen, for a specific client on a
Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tag screen.

To use a variable to create a sub-folder in which to save the exploded PDF files:

¢ Select Use variable to create a sub-folder to enable this feature.

¢ Select the variable for sub-folder name: allows you to choose the variable whose value will be used as the complete sub-folder
name. Select Varl, Var2, Var3, Var4, Var5 or Var6. If you specify a relative pathname, the parent folder must exist at runtime - PDF-
eXPLODE will not create it.
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¢ Select Use ~ character in variable to indicate nested sub-folder to pass multiple levels of sub-folders in a single variable. The
carat (©) takes the place of the backslash (\) as the delimiter since the backslash would produce an invalid temporary file name during
processing.

I* File Password

A variable may be used to supply a user password to secure a PDF. If used, a password variable will override any other password settings
specified on Default Message ID Tag, Client Details, Client-specific Message ID Tag or PDF Security Settings. Use PDF Security Settings to
select desired permissions (for example, Allow Printing). If Security Mode is set to Do not secure any PDF document after exploding
then all permissions will be disallowed.

¢ Select Use variable as a PDF password to enable this feature.

¢ Select the variable to use as Password: allows you to choose the variable whose value will be used as the password. Select Varl,
Var2, Var3, Var4, Var5 or Varé6.

¢ Enter the Owner Password. The owner password is required. It must be entered by a person who has opened a PDF and wants to
gain access to, and modify, the document security permissions.

P Tips

» Use this feature when the password is stored in a database for securing confidential documents such as Payroll direct deposit
advice.

« If you select this feature but do not include a password variable in a document tag, the resulting exploded PDF file will not have
security applied (even if you set Security Mode to Secure all PDF documents after exploding).

e The entire <pdfexplode>...</pdfexplode> tag is used as a temporary file name, therefore do not use any of the following
characters in a password variable because Windows does not permit them to be used in file names: < > :"/\ | ? *

I From Address

A variable may be used as the e-mail from (i.e. return) address. The designated e-mail address is an override to the default Sender Name
specified on Mail Settings or the Sender E-mail override specified on a Default Message ID Tag screen, for a specific client on a Client
Details screen or for a client-specific e-mail message on a Client-specific Message ID Tag screen.

¢ Select Use variable as the E-mail FROM/Return Address to enable this feature.
« Select the variable for FROM address: allows you to choose the variable whose value will be used as the complete e-mail FROM
address. Select Varl, Var2, Var3, Var4, Var5 or Varé.
¢ Select Make 'From Address' and 'Return Path/Reply To' same to set the return path in the internet header to be the same as the
from address.
¢ Note: The FROM address value passed in the variable must be in one of the following formats:An e-mail address, for example,
jsmith@smithcompany.com
¢ A sender name followed by exclamation point (!) followed by an e-mail address, for example, John Smith!
jsmith@smithcompany.com

I+ Select Variable Usage in E-mail Merge

You may opt to have PDF-eXPLODE perform a mail merge in the e-mail from address, subject and message using the variables from the
PDF-eXPLODE tags in the document being printed.

¢ Select Use variables in e-mail to enable this feature. Place variable names within angle brackets in your e-mail subject or message
where you want their values to appear. For example, if variable 1 contains an invoice number, type "Invoice #<Varl>" to produce
something like "Invoice #12345". An example is given on the program screen.

¢ You may insert programming functions within the subject and message to manipulate and format the contents of variables.

¢ Note: Do not insert a variable in Default Document Title on General Settings or in Exploded Filename on a Default Message ID Tag
screen, for a specific client on a Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tag screen.
as these settings will not be replaced with the variable value at runtime.
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PDF Security Settings

PDF Security Settings let you protect the PDF files you create with PDF-eXPLODE. PDF-eXPLODE can protect your PDF documents from
unauthorized viewing, copying, sharing, modifying or printing.

By default, all PDF documents created with PDF-eXPLODE do not have security enabled. Security may be applied:

¢ globally to all exploded PDF files by assigning the same password to every PDF file (see Specify Passwords below),

¢ globally to all exploded PDF files by assigning an individual password to each PDF using Variables in the PDFeXPLODE tag, which
override the settings on this screen,

¢ on an exception basis to exploded PDF files for specific recipients for whom you create a Client Details screen and select the option
labeled Protect Resulting PDF document.

PDF-eXPLODE lets you choose security settings for each security-enabled PDF document you create. While it is not necessary to secure
your PDF documents, you should consider the purpose for which a document will be used, the sensitivity of the contents and who will be
receiving it.

Note: Security is not applied to Cover Sheets that are sent as a separate PDF attachment or to Quick Mail PDF files.

To control access to your PDF files, you enable encryption, select the permissions you wish to grant and apply passwords.

To begin, start PDF-eXPLODE.

I Open PDF Security Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click PDF Security Settings.

Ik Set Security Mode
Set a security mode to specify whether and how to apply security to the PDF files created. If you opt to secure PDF files, then you must
enter an Owner Password (see below). Note that security applied using variables will override the settings on this screen.

+ Do not secure any PDF document after exploding offers no security but should be compatible with all PDF viewing programs.

¢ Secure all PDF documents after exploding allows you to secure all documents using the same password, i.e. a global password.
This option provides convenience while sacrificing security, since all PDF files will have the same password as entered below. You may
override the default passwords specified below for specific documents and clients on a Client Details screen or a Client-specific Message
ID Tags screen. Note: The use of password variables in the <pdfexplode> tag takes precedence over these settings.

¢ Secure just the PDF documents for the selected clients after exploding allows for greater security by providing for different
passwords to be assigned to different PDF files. You may override the default passwords specified below for specific documents and
clients on a Client Details screen or a Client-specific Message ID Tags screen.

I+ Set Encryption Level
Encryption allows you to control access to the PDF files generated by PDF-eXPLODE. If you select to secure PDF files using Security Mode,
specify whether to use 40 bit or 128 bit encryption.

¢ 40 bit encryption provides some security but is compatible only with Adobe Acrobat or Reader v4 or below. We recommend not using
this setting unless you know you must. Selecting this option will allow you to specify some permissions.

e 128 bit encryption offers the greatest degree of security but is compatible only with Adobe Acrobat or Reader v5.0 or higher. Most users
should have v5.0 or higher, so this is the recommended setting for users wanting encryption security. Selecting this option will allow you
to specify all available permissions.

I Set Permissions

Select the permissions you wish to apply to your PDF documents. Permissions for the document can be set separately from access to the
document. For instance, with Password Security, it's possible to require different passwords to open (a User Password) and manipulate (an
Owner Password) the document, meaning that you can allow one set of users to view the document, and another, smaller set to copy or
print the document.

¢ Allow Printing - print the document (possibly not at the highest quality level, depending on whether allow-degraded-printing is also
set). To disallow printing, de-select this permission and also the permission labeled Allow Degraded Printing.

« Allow Modify Contents - modify the contents of the document by operations other than those controlled by Allow Modify Annotations,
allow Fill In and Allow Assembly

¢ Allow Copy - copy or otherwise extract text and graphics from the document by operations other than that controlled by Allow Screen
Readers
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« Allow Modify Annotations - add or modify text annotations, fill in interactive form fields and, if Allow Modify Contents is also set,
create or modify interactive form fields (including signature fields )

¢ Allow Fill In - fill in existing interactive form fields (including signature fields), even if Allow Modify Annotations is not set

¢ Allow Screen Readers - extract text and graphics (in support of accessibility to disabled users or for other purposes)

¢ Allow Assembly - assemble the document (insert, rotate or delete pages and create bookmarks or thumbnail images), even if Allow
Modify Contents is not set

¢ Allow Degraded Printing - when this is set (and allow-printing also is set), printing is limited to a low level representation of the
appearance, possibly of degraded quality. To disallow printing, de-select this permission and also the permission labeled Allow
Printing.

To view permission settings in resulting PDF documents, open a PDF generated by PDF-eXPLODE using Adobe Acrobat or Adobe Reader and
select Document Properties from the File menu. Permission settings appear on the Security dialog window.

| Description |} Security | Fants || Advanced

Document Security

The document's Security Method restricts what can be done to the document.
Security Method: Mo Security

Can be Opened by:  All versions of Acrobat

Document Restrictions Summary
Printing:  Allowed
Document Assembly: Mot Allowed
Content Copying or Extraction:  Allowed
Content Extraction for Accessibility:  Allawed
Commenting: Mot Allowed
Filling of form fields:  Allowed
Signing: Mot Allowed
Creation of Template Pages: Mot Allowed

Submitting Forms: Mot Allowed

Ok l [ Cancel

I+ Specify Passwords

You can specify two passwords for PDF documents created by PDF-eXPLODE: a User Password and an Owner Password. The "user" is the
person to whom you are sending a PDF and the "owner" is you. You should specify different passwords for the User and Owner or else

a user will have access to change permissions. You may override these general passwords with passwords specific to an e-mail message
defined on a Default Message ID Tag screen, which may be overridden by passwords specific to an e-mail recipient defined on a Client
Details screen, which may be overridden by passwords for a client-specific message on a Client-specific Message ID Tags screen.

¢ User Password if specified, must be entered by a user to open and view a PDF document generated with this password. User Password
must be different than Owner Password to protect the document against users changing the document's permissions.
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e Owner Password is required if Encryption Level is set to either 40 bit or 128 bit. If specified, the owner password must be entered by a
person who has opened a PDF and wants to gain access to, and modify, the document security permissions.
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Mail Settings
Mail Settings let you configure PDF-eXPLODE to communicate with your e-mail server and construct the default e-mail message.

To begin, start PDF-eXPLODE.
I Open Mail Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Mail.

I Default E-Mail Setting

The default e-mail Subject and Message appear when your e-mails are viewed by recipients. You can change them each time you send e-
mail using PDF-eXPLODE, or you may override the default message for a specific e-mail message on a Default Message ID Tags screen, for a
specific client on a Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen.

¢ Select Send e-mail message as HTML if you want to send e-mail messages in HTML format. Using HTML enables you to format e-
mail messages using fonts and images, etc. If you do not select this option, e-mail messages will be sent in plain text format. Note
that you can override this setting for a specific e-mail message on a Default Message ID Tags screen, for a specific client on a Client
Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen. An HTML editor is provided with PDF-
eXPLODE, or you may use another editor and specify the file to be used.

¢ Subject: Enter an e-mail Subject. You may insert variables and programming functions within the subject to create a mail merge if you
have selected Use variables in e-mail on the Variable Settings screen.

* Message File: If you selected Send e-mails as HTML, enter a full pathname to the file containing the HTML message. To browse to
the file that you want to select or create, clear the contents of Message File and click Edit HTML File (see below). You may insert
variables and programming functions within the message to create a mail merge if you have selected Use variables in e-mail on the
Variable Settings screen.

¢ Message Text: If you selected the Send e-mails as HTML option, the HTML file contents are displayed. If you did not select the Send
e-mails as HTML option, you may edit the message text here. You may insert variables and programming functions within the message
to create a mail merge if you have selected Use variables in e-mail on the Variable Settings screen. You may insert <<Date>> and
<<Time>> where you want PDF-eXPLODE to fill-in the current system date and/or time at the moment the e-mail is sent.

I Exploding Rules

Attachment Rules
Change the default method of attaching each exploded PDF to one e-mail. You can select between No exploded attachment or Multiple
exploded attachments to the one email. This will override the default behaviour of one exploded PDF attached to one email.

+ Do NOT attach exploded PDFs to e-mail: Select this option if you want to use PDF-eXPLODE to do an e-mail blast without the PDF
attachments. You can use variables to mail-merge data into the e-mail subject and message.

¢ Attach multiple exploded PDFs to one e-mail where the PDFs all have the same destination: Select this checkbox if you want
to send multiple attachments to the same e-mail address. The default behaviour is to send one PDF per e-mail. You can use this feature
in combination with variables to name the PDF files so they have distinct names.

Exploding Method
Select from the dropdown:

1. Only pages containing a TAG will be exploded:

This is the default method where every page must contain a tag. A blank Tag page will be ignored in the exploding process.
For example:
Example 1:
<pdfexplode>mail@3000ad.com.au </pdfexplode>
Page 1: This is the first tag page text

Page 2 : No Tag on this page
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This is intentionally blank

<pdfexplode>info@pdf-explode.com </pdfexplode>
Page 3: This page has a different tag

Page 4 : No Tag on this page
This is intentionally blank

Result:
Page 1 will be exploded to Mail@3000ad.com.au.pdf (1 Page PDF)
Page 3 will be exploded to info@pdf-explode.com.pdf (1 Page PDF)

2. Blank TAG pages are exploded using the previous Tag page:

Select this option if your document does not contain TAGs on every page. Here the engine will explode the blank TAG page using the last
Tag found on a page immediately prior to the blank Tag page. You can also 'tag' a page again in the batch which will also be picked up and
combined with previous pages. The Tag must be the exact same including spaces between the values. For example:

Example 1:
<pdfexplode>mail@3000ad.com.au </pdfexplode>
Page 1: This is the first tag page text

Page 2 : No Tag on this page
This is intentionally blank

<pdfexplode>info@pdf-explode.com </pdfexplode>
Page 3: This page has a different tag

Result:
Page 1 and 2 will be exploded to Mail@3000ad.com.au.pdf (2 Page PDF)
Page 3 will be exploded to info@pdf-explode.com.pdf (1 Page PDF)

Example 2:
<pdfexplode>mail@3000ad.com.au </pdfexplode>
Page 1: This is a tagged page

Page 2 : No Tag on this page
This is intentionally blank

<pdfexplode>info@pdf-explode.com </pdfexplode>
Page 3: This is a different tag

Page 4 : No Tag on this page
This is intentionally blank

<pdfexplode>mail@3000ad.com.au </pdfexplode>
Page 5 : This page is the same Tag as appeared on Page 1

Result:
Page 1, 2 and 5 will be exploded to Mail@3000ad.com.au.pdf (3 Page PDF)
Page 3 and 4 will be exploded to info@pdf-explode.com.pdf (2 Page PDF)

Example 3:
<pdfexplode>mail@3000ad.com.au </pdfexplode>
Page 1: This is a tagged page

Page 2 : No Tag on this page
This is intentionally blank

<pdfexplode>info@pdf-explode.com </pdfexplode>
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Page 3: This is a different tag

Page 4 : No Tag on this page
This is intentionally blank

<pdfexplode>mail@3000ad.com.au </pdfexplode>
<pdfexplode>info@pdf-explode.com </pdfexplode>
Page 5 : There are 2 Tags on this page - one the same as Page 1 and the other similar to Page 3

Result:
Page 1, 2 and 5 will be exploded to Mail@3000ad.com.au.pdf (3 Page PDF)
Page 3, 4 and 5 will be exploded to info@pdf-explode.com.pdf(3 Page PDF)

I E-Mail Connection Setting

You can send e-mail using either PDF-eXPLODE (an SMTP client) or through Microsoft Outlook (a MAPI client).
P Use PDF-eXPLODE (SMTP)
To send e-mail using PDF-eXPLODE's SMTP client, you need to tell PDF-eXPLODE your Connection Settings as follows. After
supplying the necessary information, click the Test Connection button to send a test e-mail to the Sender Name e-mail address
and confirm the settings are correct and working.

¢ Select Use PDF-eXPLODE (SMTP).

¢ The Sender Name can be whatever name you wish to appear in the From field as viewed by recipients of your e-mail.
Undeliverable e-mails may return error notification e-mails to this address, which can be used to help clean your e-mail list and
re-send important documents. Enter a name followed by an e-mail address within angle brackets, for example:

John Smith <jsmith@smithcompany.com>

¢ Enter a Reply To e-mail address if it is different than the sender name. This setting may be overridden using a variable From
Address or by setting Reply To on a specific Default Message ID Tag, Client Details or a Client-specific Message ID Tag.

The following information usually supplied to you by your organization's e-mail administrator or your Internet Service Provider (ISP):

1. Name of your Outgoing Mail SMTP Server. This may be entered in one of three formats:DNS Name, for example:
smtp.mycompany.com
2. IP Address, for example: 192.168.10.25
3. Server Name: for example: smitp _srvrl
¢ Your Sign-on Username, if you use a web hosting service this will often be your e-mail address (for example:
myname@ mycompany.com), whereas if your company has its own e-mail server you may only need to enter your login name
(for example, myname).
¢ Your Sign-on Password. (The password is not displayed and is encrypted before being saved by PDF-eXPLODE to protect
your privacy.)
¢ The Authentication Type required by your e-mail server. Select; None, POP, Login or Plain.
¢ The Port number used by your e-mail server (usually 25)
¢ Name of your Incoming Mail (POP3) Server (for example pop.mycompany.com). This is only required when you have set
Authentication Type to POP3.
¢ Select Delay each E-Mail to set the time delay between sending each e-mail (after the first one is sent) to between 1 and 60
seconds. This can help prevent errors such as 'Too Many Connections' from occurring when the SMTP (e-mail) server limits the
number of e-mail that can be sent simultaneously.
¢ Select a security protocol, either SSL or TLS if your e-mail server requires an encrypted (i.e. a secure) connection, for example
Gmail. TLS security is required where an explicit security connection is required (for example, Office 365 cloud-based Microsoft
Exchange server), or security is set up by PDF-eXPLODE e-mail engine before opening communication with the e-mail server.
This is sometimes referred to as StartTLS. In contrast to TLS, SSL is an /mplicit connection, which is only established when
sending a message. In both cases (TLS and SSL) the e-mail message is encrypted.
¢ Click Test Connection to test the e-mail settings and send a test e-mail to the Sender Name.

I Use Microsoft Outlook (MAPI)
To send e-mail using Microsoft Outlook (a MAPI client) client, you only need to ensure Outlook is installed, set as the default e-mail
client and configured properly. The following options are available.

¢ Select Use Microsoft Outlook (MAPI).
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Select Send as a DRAFT to place the e-mail into the Outlook Drafts folder. A benefit of doing so is that the Outlook security
will not ask for manual confirmation. If you do not select this option, the e-mail will be placed into the Outbox folder, which
requires clicking Yes in response to an Outlook security warning dialog that asks you to confirm mail sending from third party
applications.

Note: This means that PDF-eXPLODE Silent and Very Silent modes will stop processing until receiving a manual
response. To maintain continuity of the PDF-eXPLODE processing in silent (unattended) mode, it will be necessary
to install a software utility like ClickYES, which will automaticallyclick the Yes button and continue processing in your
absence. There are free programs available on the Internet that will automatically click Yes in response to the Outlook
security warning dialog. Search for "ClickYes", or you may download ClickYes from http://www.3000ad.com.au/
ClickYesSetup.exe. For PDF-eXPLODE Server, you'll need ClickYes Pro available at www.contextmagic.com.
¢ Select Send FROM address as 'on behalf of' to specify the FROM e-mail address if you have permission to send messages on
behalf of another person. Enter the desired e-mail address in Sender Name <Sender E-mail Addr> (see below), or you may
override the From address for a specific e-mail message on a Default Message ID Tags screen, for a specific client on a Client
Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen.
¢ The Sender Name <Sender E-mail Addr> is used in conjunction with Send FROM address as 'on behalf of' to specify
the FROM e-mail address if you have permission to send messages on behalf of another person. It can be whatever name and
e-mail address you wish to appear in the From field as viewed by recipients of your e-mail, provided you are permitted to send
messages on behalf of that e-mail address. Enter a name followed by an e-mail address within angle brackets, for example:

John Smith <jsmith@smithcompany.com>
I Tips

¢ This is the From e-mail address not to be confused with the Reply-To e-mail address, which will be the default e-mail address
specified in your MAPI client (e.g. Microsoft Outlook) and is also the e-mail address to which undeliverable e-mails may return
error notification e-mails.

¢ If you do not set Microsoft Outlook to Send immediately when connected, the e-mail(s) will not be sent and will remain in
the Outbox folder. You will need to move the e-mails to the Drafts folder and open and re-send them and then click Send/
Receive.

I Exploded File Details

Set the default name and folder for exploded PDF files. You may override these default settings for a specific e-mail message on a Default
Message ID Tags screen, for a specific client on a Client Details screen or for a client-specific e-mail message on a Client-specific Message ID
Tags screen.

« Exploded File Name will replace the e-mail address in each exploded PDF file name with text of your choice.

Example: The exploded PDF files created by PDF-eXPLODE are named according to the e-mail recipient and, optionally, the date and
time of creation. For example, an e-mail sent to nancy@pdf-explode.com on May 28, 2007 at 1:23 PM will have an attachment PDF
file named:

nancy@pdf-explode.com070528_132300.pdf
If you enter Invoice in this field then the resulting attachment PDF filename will be:
Invoice070528_132300.pdf

To remove the date and time from PDF filenames, use the options Don't add DATE_TIME to exploded filename and Don't add
DATE_TIME to e-mail attachment file, which are located on the General Settings screen. Following the example above, these
options enable you to set the e-mailed and archived filenames to: Invoice.pdf

+ Exploded File Path allows you to select a folder where exploded PDF files will be saved (i.e. archived). Type the desired pathname
(e.g. C:\Documents and Settings\Nancy\My Documents\Archived PDF-eXPLODE Files) or click Browse to locate and select the desired
path without typing it.r Tips

¢ Do not insert variables (for example, <var1l>) or keywords (for example <date>) into the exploded file name or exploded file path.
Windows does not allow the use of angle bracket characters (<>) in file names.
¢ Windows does not permit the following characters to be used in file names: < > :"/\ | ? *

Click Save to save your settings.
On the Printer menu, click Exit to close PDF-eXPLODE.
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Default Message ID Tags

Default Message ID Tags allow you to specify whether a particular type of document should be printed, e-mailed or both. If e-mail is
selected, you may also define the subject and message. For example, you could define a Default Message ID Tag "Invoice" to have a default
e-mail subject and message applied to all of the invoices you e-mail. In addition, you can specify the PDF file name, path name and security
passwords.

You may override the default message settings by creating a Client-specific Message ID Tag with the same name.

To begin, start PDF-eXPLODE.

I Open Default Message ID Tags

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click the plus sign (+) to the left of Mail Settings.
3. Click the plus sign (+) to the left of Default Message ID Tags.

I+ Create a Default Message ID Tag

1. If there are no existing message ID tags, click New Message ID.

-Or-

If there are existing message ID tags, click any existing message ID tag.
2. Click the button labeled New.

e Complete the following fields:Message ID is the tag or name you use to identify this set of options in the PDF-eXPLODE tag
inserted into your report or document. The Message ID may not include any spaces. Do not use a message id like PRN, which
results in PDF-eXPLODE trying to create a file with an invalid filename. The following device names are reserved by Windows and
cannot be used as a filename: CON, PRN, AUX, NUL, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8, COM9, LPT1,
LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and LPT9.

¢ Select Apply E-Mail Notification to receive an e-mail notification (called a "read receipt") when a recipient reads an e-mail sent
by PDF-eXPLODE. You must also choose Notify me on Read on the General Settings screen for this option to take effect. Note
that not all e-mail servers support this option and also a recipient may optionally deny sending a read notification.

¢ Select Apply E-Mail Flags to set the Importance and Sensitivity flags specified on the General Settings screen. Note that some
e-mail clients, such as Outlook Express, do not display all of the e-mail flags.

¢ Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages
using fonts and images, etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts,
etc.) An HTML editor is provided with PDF-eXPLODE, or you may use another editor and specify the file to be used. The Message
ID may not include any spaces.

¢ Choose Print if you want to print documents. Note: If security is applied to a PDF then printing will not occur. Only one copy
may be printed.Choose ONLY (don't E-Mail) to print documents with this message ID but not e-mail them.
-Or-
Choose ALSO ( print and E-Mail) to print in addition to e-mailing the documents.
¢ Select a printer from the dropdown list of available printers.
¢ Select the number of copies, which defaults to 1.

b Tips

¢ Use Print Only in combination with Variables when you need to e-mail some documents and print others, based on whether you
have the recipient's e-mail address in your database. For example, you may be e-mailing invoices but need to print and mail
hard-copy invoices to customers who do not have an e-mail address. You could use a formula in your report to conditionally
insert into the <pdfexplode> tag a Message ID whose purpose is to Print Only for those customers without an e-mail address.
Customers with e-mail addresses would have a different Message ID inserted into their <pdfexplode> tag whose purpose is to
specify the e-mail subject and message.

e Use Print Also when you want to send documents by e-mail but also need to keep a hard-copy for your physical files.

I» Message ID Configuration
I E-mail Setting

¢ Sender E-mail can be filled in if you want to override the default sender e-mail address specified on the Mail Settings
screen. The Sender Name can be whatever name you wish to appear in the From field as viewed by recipients of your e-
mail. Undeliverable e-mails may return error notification e-mails to this address, which can be used to help clean your e-mail
list and re-send important documents. Enter a name followed by an e-mail address within angle brackets, for example:John
Smith <jsmith@smithcompany.com>
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As an alternative to entering sender e-mail address here, a variable may be used to provide the sender e-mail address. For
example, if the e-mail address is contained in variable 3, enter <var3>.

¢ Enter a Reply To e-mail address if it is different than the sender name. This setting may be overridden using a variable
From Address or by setting Reply To on Client Details or a Client-specific Message ID Tag.

¢ CC can be checked to send a copy of each e-mail to one or more e-mail recipients. Multiple CC e-mail addresses must be
separated with a comma (,) or semicolon (;). Unlike BCC, recipients will see each other's e-mail addresses.

e BCC can be checked to send a blind copy of each e-mail to one or more e-mail recipients. Multiple BCC e-mail addresses
must be separated with a comma (,) or semicolon (;). Unlike CC, BCC recipients will not see each other's e-mail address.

¢ Subject is the subject that appears on the e-mail when received by your clients. You may insert variables and
programming functions within the subject to create a mail merge if you have selected Use variables in e-mail on the
Variable Settings screen.

* Message File should contain a full pathname to the file containing the HTML message if you selected the Send e-mails as
HTML option. If you are sending e-mails in text format, leave this field blank. To browse to the file that you want to select,
clear the contents of Message File and click Edit HTML File (see below). You may insert variables and programming
functions within the message to create a mail merge if you have selected Use variables in e-mail on the Variable
Settings screen.

¢ Message is the message that will appear in the body of the e-mail received by your clients. You may insert variables and
programming functions within the message to create a mail merge if you have selected Use variables in e-mail on the
Variable Settings screen. You may insert <<Date>> and <<Time>> where you want PDF-eXPLODE to fill-in the current
system date and/or time at the moment the e-mail is sent.

¢ If you are sending e-mails in text format, click Edit Text to enlarge the area for editing the message, and then click
Update to save the changes or Cancel to discard any changes.

¢ If you are sending e-mails in HTML format, click Edit HTML File to use the PDF-eXPLODE HTML Editor to edit the HTML
file specified in Message File, or to create a new HTML file if the Message File option is blank. You may optionally use
another HTML editor and specify the Message File above.

I+ Exploded File
Set the default name and folder for exploded PDF files, and options for inserting a cover page. These
settings override those specified on the Mail Settings screen.

+ File Name will replace the e-mail address in each exploded PDF file name with text of your choice.

Example: The exploded PDF files created by PDF-eXPLODE are named according to the e-mail recipient
and, optionally, the date and time of creation. For example, an e-mail sent to nancy@pdf-explode.com on
January 28, 2009 at 1:23 PM will have an attachment PDF file named:

nancy@pdf-explode.com090128_132300.pdf
If you enter Invoice in this field then the resulting attachment PDF filename will be:
Invoice090128_132300.pdf

After being e-mailed, the exploded PDF filename will be the same unless you select Suppress DATE_TIME
on exploded filename, in which case the filename will be:
Invoice.pdf

« File Path allows you to select a folder where exploded PDF files will be saved (i.e. archived). Type the desired pathname
(e.g. C:\Documents and Settings\Nancy\My Documents\Archived PDF-eXPLODE Files) or click Browse to locate and select
the desired path without typing it.r Tips

¢ Do not insert variables (for example, <varl>) or keywords (for example <date>) into the exploded file hame or exploded
file path as PDF-eXPLODE does not merge any variable Database values from the tag into this field. The name you use
here is taken as a lieral in the filename and Windows does not allow the use of angle bracket characters (<>) in file
names.

¢ Windows does not permit the following characters to be used in file names: < > :"/\ [ ? *

« Cover Sheet (CS) Fixed specifies whether to insert an existing PDF file into each exploded PDF, and specifies the full
pathname to the selected PDF. (To specify the coversheet file name in a variable in the <pdfexplode> tag, see the option
for CS Variable below.) The selected PDF may be any number of pages. Use this feature for such applications as including
a generic newsletter or promotion in every PDF file created by PDF-eXPLODE. Note: This cover sheet is in addition to any
cover sheet defined in General Settings. PDF-eXPLODE will not insert a cover sheet if the exploded PDF file is password
protected. If the cover sheet is attached separately, it can be any file type (i.e. not restricted to PDF.)

¢ Select the checkbox to enable insertion of the cover sheet, or de-select the checkbox to disable this feature.

¢ Select whether to position the cover sheet file in the Front or Back of the exploded PDF file or as a Separate attachment.
If you select Front or Back, the cover sheet file must be a PDF. If you select Separate, the file can be any type.
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¢ Click Browse to navigate to the desired coversheet file name. If you select to attach the cover sheet as a separate file, you
can select multiple files by separating the filenames with a vertical bar (|) character. For example, to attach three files, you
could enter:

C:\CoverSheet1.pdf|D:\CoverSheet2.doc|C:\CoverSheet3.xls

e I Tips
¢ You may use this feature in combination with the the Default Cover Sheet PDF defined in General Settings for cover
sheets inserted in the Front or Back of the exploded PDF files. Both cover sheets will be included.
¢ If you select to include both the Default Cover Sheet PDF as a Separate attachment and also specify a Cover Sheet PDF
as a Separate attachment on a Default Message ID Tags screen, Client Details screen or a Client-specific Message ID
Tags screen, the default cover sheet attachment will not be included.

I+ Attachment
Change the default method of attaching each exploded PDF to one e-mail. You can select between No
exploded attachment or Multiple exploded attachments to the one email. This will override the default
behaviour of one exploded PDF attached to one email. You can optionally elect to rotate any exploded
PDF page which has a landscape orientation in the PDF, back to portrait. This is necessary to prevent an
exploded landscape PDF pagewidth being truncated from: 11 inches to 8.5 inch (Letter) or 11.7 inches to
8.29 inch (A4), when fed through an electronically transmitted fax.
¢ Do NOT attach exploded PDFs to e-mail: Select this option if you want to use PDF-eXPLODE to do an e-mail blast
without the PDF attachments. You can use variables to mail-merge data into the e-mail subject and message. Plus, you can
use the cover sheet feature (see below) to include a generic attachment on every e-mail.
¢ Attach multiple exploded PDFs to one e-mail where the PDFs all have the same destination: Select this
checkbox if you want to send multiple attachments to the same e-mail address. The default behavior is to send one PDF
per e-mail. You can use this feature in combination with variables to name the PDF files so they have distinct names.
* Rotate Landscape pages to Portrait in the exploded PDF: Select this checkbox to ensure landscape oriented
pages are not cut off along the width when sending through a fax server. Pages are not reformatted - they are rotated
counterclockwise 90 degrees. Portrait-oriented pages are not affected by this option.

I* Variable

Use this feature to add cover sheets that are customised to each exploded PDF. You could for example, add
a PDF timsheet for each exploded Paystub (aka Payslip) when sending employees their pay details. Each
variable file name in the tag must be just a filename and extension. For example: Mark.PDF. You can add
multiple attachments like this: Mark.PDF&Mark1.XLS. Files shown in the tag must be saved to the path
shown at ‘Variable File Path’.

¢ Select Insert Coversheet from Variable to allow the name of a cover sheet (i.e. any related document to be attached
to the same e-mail as the exploded PDF) to be specified in a variable. The file name is only the name of the file, not the
complete path (see below).

+ Coversheet position in the exploded file: Select whether to position the cover sheet file in the Front or Back of the
exploded PDF file or as a Separate attachment. If you select Front or Back, the cover sheet file must be a PDF. If you
select Separate, the file can be any type.

¢ Select the variable for Coversheet attachment that will contain the name of the coversheet file.

o Enter the Variable File Path where the coversheet file is saved.

I PDF Security

¢ Select Protect Exploded PDF to enable security and enter the passwords described below.

¢ User Password is a general password for viewing documents sent with this message that is applied to all clients you have
specified to receive protected PDF files. You may override this password for a specific client on a Client Details screen
or on a Client-specific Message ID Tags screen. User Password must be different than Owner Password to protect the
document against users changing the document's permissions.

 Owner Password is a general password for manipulating permissions in documents sent with this message that is applied
to all clients you have specified to receive protected PDF files. You may override this password for a specific client on a
Client Details screen or on a Client-specific Message ID Tags screen.

Click Apply to save your changes and remain in PDF-eXPLODE Options. -or-

Click Save to save your changes and exit PDF-eXPLODE Options. -or-

Click a different option in the Options List on the left to discard changes and remain in PDF-eXPLODE Options. -or-
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.
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I Edit a Default Message ID Tag

¢ Click an existing message ID.Click Edit.
e Make your desired changes.
¢ Click Apply to save your changes and remain in PDF-eXPLODE Options.
_Or-
Click Save to save your changes and exit PDF-eXPLODE Options.
_Or-
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

I Delete a Default Message ID Tag
¢ Click an existing message ID.Click Remove.

¢ Click Yes to confirm the deletion or No to cancel.

IF Rename a Default Message ID Tag

1. To rename a message ID you must delete it and re-create it.
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Client-specific Message ID Tags

Client-specific Message ID Tags allow you to define the subject and message specific to both a particular type of document and a specific client. For example,
you could define a Default Message ID Tag named "Invoice" and, in addition, define a Client-specific Message ID Tags named "Special Invoice" to send to
clients requiring special attention. The Client-specific Message ID Tags override the Default Message ID Tag screen and the Client Details screen.

To begin, start PDF-eXPLODE.

I Open Client-specific Message ID Tags

On the Printer menu, click PDF-eXPLODE Options....

In the Options List, dlick the plus sign (+) to the left of Mail Settings.

Click the plus sign (+) to the left of Clients.

Click the plus sign (+) to the left of the specific client for whom you want to add a client-specific e-mail message.

N

I+ Create a Client-specific Message ID Tag

1. If there are no existing message ID tags, click New Message ID.
_or-

If there are existing message ID tags, click any existing message ID tag.
2. Click the button labeled New.
3. Complete the following fields:* Client Details

¢ Client ID or E-mail Address is a displayed for reference only.

* Message ID is the client-specific Message ID tag used to identify this set of options in the PDF-eXPLODE tag inserted into your report or
document. The Message ID may not include any spaces.

* Select Apply E-Mail Notification to receive an e-mail notification (called a "read receipt") when a recipient reads an e-mail sent by PDF-
eXPLODE. You must also choose Notify me on Read on the General Settings screen for this option to take effect. Note that not all e-mail servers
support this option and also a recipient may optionally deny sending a read notification.

* Select Apply E-Mail Flags to set the Importance and Sensitivity flags specified on the General Settings screen. Note that some e-mail clients,
such as Outlook Express, do not display all of the e-mail flags.

* Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages using fonts and
images, etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts, etc.) An HTML editor is provided
with PDF-eXPLODE, or you may use another editor and specify the file to be used.

* Choose Print if you want to print documents. Note: If security is applied to a PDF then printing will not occur. Only one copy may be
printed.Choose ONLY (don't E-Mail) to print documents with this message ID but not e-mail them
-or-
Choose ALSO ( print and E-Mail) to print in addition to e-mailing the documents.
* Select a printer from the dropdown list of available printers.
* Select the number of copies, which defaults to 1.

I Client Specific Message ID Configuration
I E-mail Setting
* Sender E-mail can be filled in if you want to override the default sender e-mail address specified on the Mail
Settings screen. The Sender Name can be whatever name you wish to appear in the From field as viewed by
recipients of your e-mail. Undeliverable e-mails may return error notification e-mails to this address, which can be
used to help clean your e-mail list and re-send important documents. Enter a name followed by an e-mail address
within angle brackets, for example:John Smith <jsmith@smithcompany.com>
As an alternative to entering sender e-mail address here, a variable may be used to provide
the sender e-mail address. For example, if the e-mail address is contained in variable 3, enter
<var3>.
* Enter a Reply To e-mail address if it is different than the sender name. This setting may be overridden using a variable
From Address.
¢ CC can be checked to send a copy of each e-mail to one or more e-mail recipients. Multiple CC e-mail addresses must be
separated with a comma (,) or semicolon (;). Unlike BCC, recipients will see each other's e-mail addresses.
e BCC can be checked to send a blind copy of each e-mail to one or more e-mail recipients. Multiple BCC e-mail addresses
must be separated with a comma (,) or semicolon (;). Unlike CC, BCC recipients will not see each other's e-mail address.
¢ Subject is the subject that appears on the e-mail when received by your clients. You may insert variables and
programming functions within the subject to create a mail merge if you have selected Use variables in e-mail on the
Variable Settings screen.
* Maessage File should contain a full pathname to the file containing the HTML message if you selected the Send e-mails as
HTML option. If you are sending e-mails in text format, leave this field blank. To browse to the file that you want to select,
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clear the contents of Message File and click Edit HTML File (see below). You may insert variables and programming
functions within the message to create a mail merge if you have selected Use variables in e-mail on the Variable
Settings screen.

* Message is the message that will appear in the body of the e-mail received by your clients. You may insert variables

and programming functions within the message to create a mail merge if you have selected Use variables in e-mail on

the Variable Settings screen. You may insert <<Date>> and <<Time>> where you want PDF-eXPLODE to fill-in the
current system date and/or time at the moment the e-mail is sent.

If you are sending e-mails in text format, click Edit Text to enlarge the area for editing the message, and then click

Update to save the changes or Cancel to discard any changes.

If you are sending e-mails in HTML format, click Edit HTML File to use the PDF-eXPLODE HTML Editor to edit the HTML

file specified in Message File, or to create a new HTML file if the Message File option is blank. You may optionally use

another HTML editor and specify the Message File above.
P File Details
Set the default name and folder for exploded PDF files, and options for inserting a cover page. These settings override
those specified on the Mail Settings screen.

* Do NOT attach exploded PDFs to e-mail: Select this option if you want to use PDF-eXPLODE to do an e-mail blast without the PDF
attachments. You can use variables to mail-merge data into the e-mail subject and message. Plus, you can use the cover sheet feature
(see below) to include a generic attachment on every e-mail.

* Rotate Landscape pages to Portrait in the exploded PDF: Select this checkbox to ensure landscape oriented pages are not cut off
along the width when sending through a fax server. Pages are not reformatted - they are rotated counterclockwise 90 degrees. Portrait-
oriented pages are not affected by this option.

* File Name will replace the e-mail address in each exploded PDF file name with text of your choice.

Example: The exploded PDF files created by PDF-eXPLODE are named according to the e-mail recipient and, optionally,
the date and time of creation. For example, an e-mail sent to nancy@pdf-explode.com on January 28, 2009 at 1:23
PM will have an attachment PDF file named:

nancy@pdf-explode.com090128_132300.pdf
If you enter Invoice in this field then the resulting attachment PDF filename will be:
Invoice090128_132300.pdf

After being e-mailed, the exploded PDF filename will be the same unless you select Suppress DATE_TIME on exploded
filename, in which case the filename will be:

Invoice.pdf
File Path allows you to select a folder where exploded PDF files will be saved (i.e. archived). Type the desired pathname (e.g. C:
\Documents and Settings\Nancy\My Documents\Archived PDF-eXPLODE Files) or click Browse to locate and select the desired path
without typing it.* Tips

* Do not insert variables (for example, <var1>) or keywords (for example <date>) into the exploded file name or exploded file path.
Windows does not allow the use of angle bracket characters (<>) in file names.

* Windows does not permit the following characters to be used in file names: < > :"/\ | ?*

* Cover Sheet (CS) Fixed specifies whether to insert an existing PDF file into each exploded PDF, and specifies the full pathname to the
selected PDF. (To specify the coversheet file name in a variable in the <pdfexplode> tag, see the option for CS Variable below.) The
selected PDF may be any number of pages. Use this feature for such applications as including a generic newsletter or promotion in every
PDF file created by PDF-eXPLODE. Note: This cover sheet is /n addition to any cover sheet defined in General Settings. PDF-eXPLODE will
not insert a cover sheet if the exploded PDF file is password protected. If the cover sheet is attached separately, it can be any file type
(i.e. not restricted to PDF.)

* Select the checkbox to enable insertion of the cover sheet, or de-select the checkbox to disable this feature.

* Select whether to position the cover sheet file in the Front or Back of the exploded PDF file or as a Separate attachment. If you select
Front or Back, the cover sheet file must be a PDF. If you select Separate, the file can be any type.

* Click Browse to navigate to the desired coversheet file name. If you select to attach the cover sheet as a separate file, you can select
multiple files by separating the filenames with a vertical bar (|) character. For example, to attach three files, you could enter:

C:\CoverSheet1.pdf|D:\CoverSheet2.doc|C:\CoverSheet3.xls

I Tips
* You may use this feature in combination with the the Default Cover Sheet PDF defined in General Settings for cover sheets inserted in
the Front or Back of the exploded PDF files. Both cover sheets will be included.
¢ If you select to include both the Default Cover Sheet PDF as a Separate attachment and also specify a Cover Sheet PDF as a Separate
attachment on a Default Message ID Tags screen, Client Details screen or a Client-specific Message ID Tags screen, the default cover
sheet attachment will not be included.
I Variable
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¢ Select Insert Coversheet from Variable to allow the name of a cover sheet (i.e. any related document to be attached to the same e-
mail as the exploded PDF) to be specified in a variable. The file name is only the name of the file, not the complete path (see below).

* Coversheet position in the exploded file: Select whether to position the cover sheet file in the Front or Back of the exploded PDF
file or as a Separate attachment. If you select Front or Back, the cover sheet file must be a PDF. If you select Separate, the file can be
any type.

¢ Select the variable for Coversheet attachment that will contain the name of the coversheet file.

* Enter the Variable File Path where the coversheet file is saved.

I PDF Security

¢ Select Protect Exploded PDF to enable security and enter the passwords described below.

¢ User Password is a general password for viewing documents sent with this message that is applied to all clients you have specified
to receive protected PDF files. You may override this password for a specific client on a Client Details screen or on a Client-specific
Message ID Tags screen. User Password must be different than Owner Password to protect the document against users changing
the document's permissions.

« Owner Password is a general password for manipulating permissions in documents sent with this message that is
applied to all clients you have specified to receive protected PDF files. You may override this password for a specific client
on a Client Details screen or on a Client-specific Message ID Tags screen.

1. Click Apply to save your changes and remain in PDF-eXPLODE Options.
_C?irc-k Save to save your changes and exit PDF-eXPLODE Options.
_Ccl)irc-k a different option in the Options List on the left to discard changes and remain in PDF-eXPLODE Options.
_C?irc-k Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

I Edit a Client-specific Message ID Tag

Click an existing message ID.
Click Edit.
Make your desired changes.
Click Apply to save your changes and remain in PDF-eXPLODE Options.
_Or_
Click Save to save your changes and exit PDF-eXPLODE Options.
_Or_
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

PN

I Delete a Client-specific Message ID Tag
1. Click an existing message ID.

2. Click Remove.
3. Click Yes to confirm the deletion or No to cancel.

IF Rename a Client-specific Message ID Tag

¢ To rename a message ID you must delete it and re-create it.
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HTML Editor

HTML Editor enables you to create e-mail messages formatted in HTML, allowing you to use fonts, colors, images, etc. You may optionally
use another HTML editor and specify the HTML file name in Default E-Mail Settings, for a specific type of mailing on a Default Message

ID Tags screen, for a specific client on a Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags
screen.

I Basic Editing Steps

1. To begin, click Edit HTML File.

2. If you have not yet specified a Message File, the Open dialog is displayed. Navigate to the desired folder and enter the name of
the file you would like to create and click Open. If you omit a file name extension, it will default to .html.

3. Edit and format the message using the toolbar buttons (explained below) to enter HTML commands.

4. When you are finished editing, click the Save button or select Save from the File menu to save your changes.

5. Select Close from the File menu to return to PDF-eXPLODE.

I Toolbar Buttons

The toolbar buttons display a tooltip when you hover the mouse over the button. Following is a description of each button in the order they
appear, with subheads to reflect the button groupings. You may insert variables within the message to create a mail merge if you have
selected Use variables in e-mail on the Variable Settings screen. For example, if you want to personalize a message with the recipient's
first name, which is in variable 4, you could enter Dear <var4>:.

File
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e Save: To save the HTML you are editing, click Save or press CTRL+S.
¢ Preview: To preview the HTML message as it will appear in the e-mail message, click Preview. Click Preview again to continue
editing.

Edit
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Cut: To remove text and save it to the Windows Clipboard, highlight the text and click Cut or press CTRL+X.
Copy: To copy text to the Windows Clipboard, highlight the text and click Copy or press CTRL+C.

Paste: To paste the contents of the Windows Clipboard at the cursor location, click Paste or press CTRL+V.
Delete: To delete a portion of text, highlight the text and click Delete or press CTRL+X.

Undo: To undo the last change, click Undo or press CTRL+Z.

Redo: To redo the last undone change click Redo or press CTRL+Y.

Find: To find text, click Find or press CTRL+F and enter the text to search for. To find the next instance, press F3.

Emphasis
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* Bold: To add bold emphasis to a portion of text, highlight the text and click Bold or press CTRL+B.
o Italic: To italicize a portion of text, highlight the text and click Italic or press CTRL+1I.

¢ Underline: To underline a portion of text, highlight the text and click Underline or press CTRL+U.
o Strikethrough: To strike out a portion of text, highlight the text and click Strikethrough.

Insert
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« Insert Paragraph: To insert a paragraph at the cursor location, click Insert Paragraph or press CTRL+P and begin typing.

« Insert image: To insert an image at the cursor location, such as a logo or photo, click Insert image and enter a URL for the desired
image if you wish to link to a web image. Alternatively, you can select an image on your local computer hard drive by clicking the
BROWSE button to locate the file. This file-path will remain a link in the HTML file but converted to an embedded image at the time of e-
mail sending.
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« Insert Web address link: To insert a link to a web address at the cursor location, click Insert Web address link and enter the URL.
« Insert E-mail address link: To insert a mail-to link at the cursor location, click Insert E-mail address link and enter an e-mail
address.
« Insert Quick Text: You can create and insert named blocks of text using the Quick Text feature. To create, edit or delete a Quick
Text, click Insert Quick Text to open the Quick Text dialog. To create a Quick Text, enter a Name and Text and then click Add.
¢ To edit a Quick Text, select a Quick Text in the list, edit Text and click OK.
¢ To delete a Quick Text, select a Quick Text in the list and click Delete.
¢ To add a Quick Text to the Insert Quick Text dropdown list, select a Quick Text in the list and click Favorite.
¢ To insert a Quick Text at the cursor location, click Insert Quick Text, select the desired name and click Insert.
¢ To insert a Favorite Quick Text at the cursor location, click the dropdown arrow next to Insert Quick Text and select the desired
name.
« Insert Heading: You can create headings up to six levels deep.To insert a heading at the cursor location, click the dropdown arrow
next to Insert Heading and select a heading level. Then type the heading.
¢ To insert another heading at the same level you can just click Insert Heading (not the dropdown arrow) as a shortcut.
» To format existing text as a heading, highlight the text and click the dropdown arrow next to Insert Heading to select a heading level,
or click Insert Heading to select the current heading level.

Font
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¢ Select Font: To apply a font to a portion of text, highlight the test and select a font hame from the dropdown list.

« Select Font Size: To apply a font size to a portion of text, highlight the test and select a size name from the dropdown list. You can
select a relative size by selecting a numbers preceded by a minus (-) or plus (+) sign, or an absolute point size by selecting a number
without a leading sign. A relative size will make it the specified number of point sizes smaller (-) or larger (+) than the size of the
preceding text.

+ Select Font Color: To apply a color to a portion of text, highlight the test and select a color or define a custom color.

Alignment
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Align Left: To left-align a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Align Left.
Align Center: To center a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Align Center.
Align Right: To right-align a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Align Right.
Justify: To justify a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Justify.

Indent Text: To indent a block of text, highlight the text and click Text Indent.

Organization
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¢ Unordered List: To insert a bulleted list at the cursor location, click Unordered List.

e Ordered List: To insert a numbered list at the cursor location, click Ordered List.

¢ Insert New List Item: To insert a new item into an unordered or ordered list, click Insert New List Item.
¢ Horizontal Line: To insert a horizontal rule at the cursor location, click Horizontal Line.

Other

¢ You can use programming functions to manipulate and format variables within an e-mail subject or message if mail-merge is enabled.

P Keyboard Shortcuts

Key Function

CTRL+A Select all text

CTRL+B Apply bold to selected text
CTRL+C Copy to clipboard

CTRL+F Find

CTRL+I Apply italics to selected text
CTRL+P Insert paragraph
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CTRL+S
CTRL+X
CTRL+V
CTRL+Y
CTRL+Z
F1

F3

Save HTML file

Cut selected text

Paste from clipboard
Redo last undone change
Undo last change

Display help

Find next instance

SHIFT+Enter Insert carriage return
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Preparing a Document
This section discusses the PDF-eXPLODE Tag rules with a practical review
of how this tag can hange from Text Documents to various Report Writers
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PDF-eXPLODE Tag

What is a "Tag"?
A Tag is a text string, embedded invisibly in your document and formatted to business rules that you configure within PDF-eXPLODE so you
can achieve your document delivery objectives.

PDF-eXPLODE uses the tag to “explode” your master document into multiple pages and based on your configured tag rules, it knows where
to send the document, how to name the file and where to save it on your hard drive.

The tag consists of 3 parts, each optional but at least one part must exist on a page between a pair of front and back nodes
(<pdfexplode></pdfexplode>)

You insert PDF-eXPLODE tags in your documents to indicate which settings to use when exploding and e-mailing documents. The general
formatis: <pdfexplode>variables”omessagelD# e-mails</pdfexplode>

The ‘%’ indicates the end of Variables, whereas as ‘#’ confirms that the word in front of it is a Message ID. The email address must
always be at the end of the tag.

Tag Format Rules
A PDF-eXPLODE tag must be formatted according to specific rules.

¢ A PDF-eXPLODE tag must begin with a <pdfexplode> open tag and end with a </pdfexplode> close tag. Optionally, curly
braces ({})or square brackets ([]) may be used instead of angle brackets (<>), for example, {pdfexplode}...{/pdfexplode} or
[pdfexplode...[/pdfexplode] are valid, but you cannot mix angle brackets, curly braces and square brackets within a tag.

« Within the open <pdfexplode> tag and the close </pdfexplode> tag you must specify at least one of three optional sections:
variables, a message ID and/or e-mail address(es) or Client Id. The general format is: <pdfexplode>variables%messagelD#e-
mails</pdfexplode> - see examples below.

¢ You may optionally specify multiple e-mail addresses separated with a comma (,) or semicolon (;). Only the first Client ID e-mail
address will be used to search for a Client Details screen or on a Client-specific Message ID Tags screen. Also, only the first Client
ID e-mail address will be used in haming the attachment PDF file.

¢ You may optionally precede the first Client ID or e-mail address with a Message ID tag followed by a pound sign (#).

¢ You may optionally precede the first Client ID or e-mail address, or an optional Message ID, with up to nine variables followed by a
percent sign (%). Variables must be separated with a comma ().

¢ The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match.

¢ The case of the text between the open <pdfexplode> tag and the close </pdfexplode> tag can be upper or lower.

¢ The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman, and must be a minimum
size of 7 points.

¢ A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.

¢ A tag must not be overshadowed by an image in close proximity to it, as this can mask the text thereby making it difficult to "read"
the tag when exploding.

¢ A tag may not contain more than 240 characters, for example, the tag <pdfexplode>MyDocument</pdfexplode> contains 10
characters.

Document Tagging Rules
A PDF-eXPLODE tag must be inserted within a document according to specific rules.

¢ If you are operating with the default exploding rule, then only pages that begin with a PDF-eXPLODE tag will be included in
exploded PDF files, so the page header in your document template, is the ideal location of the tag, to ensure each page is
included.

e (From V4.0.9.97 Feb 2014) If you have selected the rule (under Mail Setting/Exploding Rules) ‘Blank TAG pages are exploded
using the previous Tag page’, then blank-tag pages are permitted in the document. The first blank page prior to any tag in the
document will be ignored. To see how exploding will occur in this exploding method, click here

¢ You may include multiple PDF-eXPLODE tags per page if you want to send a page to multiple recipients.

¢ All of the pages associated with the same tag content will be combined into a single PDF file.

¢ You may change the color of the tag to white to make it invisible in the resulting document.

Note: An empty tag, for example <pdfexplode></pdfexplode>, will create an exploded PDF file with a name determined as follows:

1. If Suppress DATE_TIME on exploded filename /s not selected in General Settings and Exploded File Name /s
blank in Mail Settings, then the file name will be yyyymmdd_hhmmss.pdf, where the hame represents the system
date and time when the file was created.

2. If Suppress DATE_TIME on exploded filename /s selected in General Settings and Exploded File Name /s blank
in Mail Settings, then the file name will be .pdf.

3.
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If Suppress DATE_TIME on exploded filename /s selected in General Settings and Exploded File Name /s not
blank in Mail Settings, then the file name will be the name specified in Mail Settings followed by .pdf.

4. If Suppress DATE_TIME on exploded filename /s not selected in General Settings and Exploded File
Name /s not blank in Mail Settings, then the file name will be the name specified in Mail Settings with
yyyymmdd_hhmmss.pdf appended.

5. The location of the exploded PDF file will be the path specified in Mail Settings, or if blank then the Default Document
Path specified in General Settings.

PDF File Name Rules

o PDF-eXPLODE creates each exploded file with a temporary file name using the full tag (excluding the open /close < pdfexplode >
nodes). This filename can be recognized from the _expl.pdf end.

* Windows does not permit the following characters to be used in file names, and therefore they cannot be used inatag: < > :"/\
| 7 *

¢ Period (.) may not be used as the first character in a file name.

* PDF-eXPLODE does not permit the following characters to be used in file names, message IDs or in variables unless the variable is
surrounded within the backwards single quote character (") or ASCII character 96, which is usually located on the same key as the
tilde (~) to the left of the numeral one (1) key on the keyboard: # % ~ ~ °

Example Tag to Specify a PDF File Name
<pdfexplode>MyDocument</pdfexplode>
<pdfexplode>MyDocument, mail@3000ad.com.au</pdfexplode>

1. In the first example above, the standard tag has no email address, a file name MyDocument.pdf is created and the process ends.
No e-mail address exists in the tag.

2. In the second example, the filename is followed by a comma (,) and an e-mail address; hence a file (MyDocument.pdf) will
be created and delivered to mail@3000ad.com.au subject to the General Settings option' Explode and e-mail to all Tag e-mail
addresses'.

Example Tag to Specify an E-mail Address

<pdfexplode>JohnSmith@SmithCompany.com</pdfexplode>
In addition to the Standard e-mail format shown above, you may optionally specify in General Settings that e-mail addresses in tags are in
Full Name format.

e Example Tag to Specify an E-mail Address in Full Name Format, will be sent to
JohnSmith<Sales@SmithCompany.com>:<pdfexplode>John Smith!Sales@SmithCompany.com</pdfexplode>

Example Tag to Specify an E-mailable Fax Number
Many fax servers allow you to send a PDF e-mail attachment by forming an e-mail address with the fax number followed by the fax server
domain name, for example:

<pdfexplode>9780001234@MyFaxServer.net</pdfexplode>
In addition to the Standard e-mail format shown above, you may optionally specify in General Settings that e-mail addresses in tags are in
Fax Sending format.

e Example Tag to Specify an E-mail Address in Fax Sending Format, will be sent to
¢ 9780001234 <JohnSmith@MyFaxServer.net>:<pdfexplode>9780001234!JohnSmith@MyFaxServer.net</
pdfexplode>

Example Tag to Specify an E-mail Message
<pdfexplode>Invoice#JohnSmith@SmithCompany.com</pdfexplode>

e The above example assumes you have created a Default Message ID Tag named Invoice. In addition to defining a default
e-mail message for invoices, you may also have created a Client-specific Message for invoices under the Client Details for
JohnSmith@SmithCompany.com.

Example Tag to Specify Multiple E-mail Addresses
<pdfexplode>JohnSmith@SmithCompany.com,AccountsReceivable@SmithCompany.com</pdfexplode>
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¢ Remember that the tag must fit entirely on a single line in the document. You may reduce the font size to fit, if necessary.
¢ Separate e-mail addresses with a comma (,) or semicolon (;).
» Files are named based on the first tag unless you specify a variable as the filename (see example
below). Therefore, do not use multiple different tags that begin with the same e-mail address
or else PDF-eXPLODE may mix up the documents. For example, if you have the following
tags: < pdfexplode>John@SmithCompany.com,Mary@SmithCompany.com,Susan@SmithCompany.com</pdfexplode>
<pdfexplode>John@SmithCompany.com,David@SmithCompany.com,Andrew@SmithCompany.com</
pdfexplode>
change the order of one of the tags so that John is not first in both tags, for example:
<pdfexplode>John@SmithCompany.com,Mary@SmithCompany.com,Susan@SmithCompany.com</
pdfexplode>
<pdfexplode>David@SmithCompany.com,John@SmithCompany.com,Andrew@SmithCompany.com</
pdfexplode>

Example Tag to Specify a CC or a BCC e-mail address
You can include CC and BCC e-mail addresses in a tag /in addition to the TO address(es).

¢ To include one or more CC e-mail addresses, precede the CC addresses with a tilde (~), for example:
<pdfexplode>JohnSmith@SmithCompany.com,~BobJones@SmithCompany.com,MaryBrown@SmithCompany.com</pdfexplode>

¢ To include one or more BCC e-mail addresses, precede the BCC addresses with BC-, for example:
<pdfexplode>JohnSmith@SmithCompany.com,BC-BobJones@SmithCompany.com,MaryBrown@SmithCompany.com</pdfexplode>
¢ If you use both CC and BCC, the CC addresses must come before the BCC addresses:
<pdfexplode>JohnSmith@SmithCompany.com,~BobJones@SmithCompany.com,BC-MaryBrown@SmithCompany.com</pdfexplode>

¢ You cannot include CC or BCC address without a TO address.

Example of Multiple Tags per Page
<pdfexplode>President@SmithCompany.com</pdfexplode>
<pdfexplode>Vice-President@SmithCompany.com</pdfexplode>
<pdfexplode>Director@SmithCompany.com</pdfexplode>

e This is an alternative if a tag with multiple e-mail addresses does not fit on a single line.

Example Tag to Specify a Folder and File Name Using Variables
<pdfexplode>November,Invoice_12345%JohnSmith@SmithCompany.com</pdfexplode>

¢ In the above example, an invoice will be e-mailed to John Smith and the PDF will be archived in \November\Invoice_12345.pdf,
where the PDF file folder name is in variable 1 and the PDF file name in variable 2.

¢ You can specify the pathname to \November\Invoice_12345.pdf, for example, G:\Invoices, using the File Path on a Default
Message ID Tag, Client Details or a Client-specific Message ID Tag screen. If you are not using either Message IDs or Client IDs
or these have been left blank, you will need to specify an exploded file path under Mail Settings for use. If those File Path settings
are blank, the most recently used folder will be used, which may or may not be the Default Document Path on the General Settings
screen.

e Remember that the tag must fit entirely on a single line in the document. You may reduce the font size to fit, if necessary.
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Text-based Documents
Text based documents like MS Word and how the PDF-eXPLODE tag rules apply
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Tagging a Microsoft Word Document

Microsoft Word® documents are text-based documents. A text-based document is a document in which you type literal tags to indicate
which pages go in which PDF files. For example, you might send different sections of a document to different people. All of the pages
associated with the same e-mail address will be combined into a single PDF file. The best way to insert a PDF-eXPLODE tag into a Word
document is to type it directly into the page header. Only pages that begin with a PDF-eXPLODE tag will be included in a PDF file.

I Insert a PDF-eXPLODE Tag

To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer. After typing the text,
click anywhere outside the header.

Type a PDF-eXPLODE tag with the name of the desired PDF file, which may be an e-mail address if you want PDF-eXPLODE to send the
PDF file as an e-mail attachment. The following example PDF-eXPLODE tag will not be sent by e-mail:

<pdfexplode>mydocument_</pdfexplode>The following example PDF-eXPLODE tag contains an e-mail address:
<pdfexplode>JohnSmith@SmithCompany.com</pdfexplode>
The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.
The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.
You may change the color of the tag to white to make it invisible in the resulting document.
You may include multiple PDF-eXPLODE tags per page if you want to include a page in multiple exploded documents.
All of the pages associated with the same filename will be combined into a single PDF file.
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Data-driven Documents
Data driven documents produced by Report Writers like Crystal Reports and MS Access and the tag rules that apply.
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Tagging a Crystal Report

Crystal Reports® stores documents in .rpt files, which are data-driven documents. A data-driven document is one in which you insert
placeholders where you want information from the fields in your database to appear within the report. If your database has a field
containing e-mail addresses, you can send different sections of a report to selected e-mail addresses. For example, if you are sending
invoices, you might insert the e-mail address of your clients' account payable contact into the invoice page header so that each invoice is
sent to the correct client contact person. All of the pages associated with the same e-mail address will be combined into a single PDF file.

Instead of using a database field to supply the e-mail address, you may optionally use a text object for the e-mail address if you always
send a report to the same e-mail address, for example you may have a report you always send to JohnSmith@SmithCompany.com. Another
alternative is to use a formula field to supply the e-mail address if you have special requirements for computing an e-mail address, for
example if-then logic to select from among several e-mail addresses for each client. In any case, you insert a PDF-eXPLODE tag into a
Crystal report using a text object.

P Insert a PDF-eXPLODE Tag

¢ On the Insert menu Click Text Object.
¢ Place the text object in a Page Header section beginning at the left margin. Make sure the selected section is not suppressed.
o Within the text object, type the following:

<pdfexplode> </pdfexplode>
If you are using a Message ID Tag, for example invoice, then your tag would look as follows:
<pdfexplode>invoice# </pdfexplode>

¢ In the Field Explorer, click on the desired e-mail field. You may use a database field, formula field or even a running total field.

* Drag the selected field and drop it immediately before the close </pdfexplode> tag.

¢ Make the text object as wide as necessary for the entire PDF-eXPLODE tag to appear in its entirety for the longest e-mail address. Click
and drag the right handle of the text object all the way to the right margin.

¢ A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line. Select the
text object and click Format Text on the Format menu. Click the Font tab, enter 6 for the Size and click OK.

¢ The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman. Select the text object and click
Format Text on the Format menu. Click the Font tab, set Font to Arial and click OK.

¢ You may change the color of the tag to white to make it invisible in the resulting document. Select the text object and click Format Text
on the Format menu. Click the Font tab, set Color to White and click OK.
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Tagging a Microsoft Access Report

Microsoft Access® reports are data-driven documents. A data-driven document is one in which you insert placeholders where you want

information from the fields in your database to appear within the report. If your database has a field containing e-mail addresses, you

can send different sections of a report to selected e-mail addresses. For example, if you are sending invoices, you might insert the e-mail

address of your clients' account payable contact into the invoice page header so that each invoice is sent to the correct client contact person.
All of the pages associated with the same e-mail address will be combined into a single PDF file. The easiest way to insert a PDF-eXPLODE

tag into an Access report is using a text box.

I Insert a PDF-eXPLODE Tag

Click the Text Box tool in the toolbox.

Click the upper left corner of the page header section to indicate where you want to place the text box.

Place the insertion point in the text box and type an expression that includes the e-mail address or the name of the field containing the
e-mail address, and an optional Message ID Tag. For example, if your database has a field named Email, you would enter the following
expression

="<pdfexplode>" + [Email] + "</pdfexplode>"
If you are using a Message 1D Tag, for example invoice, then your tag would look as follows:
="<pdfexplode>invoice#" + [Email] + "</pdfexplode>"

Make the text field as wide as necessary for the entire PDF-eXPLODE tag to appear in its entirety for the longest e-mail address. Click
and drag the right handle of the text field all the way to the right margin.

A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line. Right-click
the text box, click Properties and click the Format tab. Enter 6 for the Font Size.

The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman. Right-click the text box, click
Properties and click the Format tab. Set Font Name to Arial.

You may change the color of the tag to white to make it invisible in the resulting document. Right-click the text box, click Properties and
click the Format tab. Set Fore Color to White.
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Tagging a Microsoft Word Mail Merge Document

Microsoft Word® provides a Mail merge Wizard that enables the creation of data-driven documents. A data-driven document is one in which
you insert placeholders where you want information from the fields in your database to appear within the report. If your database has a
field containing e-mail addresses, you can send different sections of a report to selected e-mail addresses. For example, if you are sending
invoices, you might insert the e-mail address of your clients' account payable contact into the invoice page header so that each invoice is
sent to the correct client contact person. All of the pages associated with the same e-mail address will be combined into a single PDF file.
The best way to insert a PDF-eXPLODE tag into a Word document is to type it directly into the page header. Only pages that begin with a
PDF-eXPLODE tag will be included in a PDF file.

I Insert a PDF-eXPLODE Tag

On the Tools menu, point to Letters and Mailings and click Mail Merge Wizard.
Follow Steps 1-3 of the wizard.

When you reach Step 4 of the wizard, click Header and Footer on the View menu.
Type the PDF-eXPLODE open tag as follows:

<pdfexplode>
¢ In the wizard window, click More items... to display the Insert Merge Field dialog.
¢ Click the e-mail address field and then click Insert and Close.
¢ Type the PDF-eXPLODE close tag so that the completed tag looks as follows, where Email_Address would be the actual field name in
your database:

<pdfexplode>«Email_Address»</pdfexplode>
o Within the text object, type the following:

<pdfexplode> </pdfexplode>
If you are using a Message ID Tag, for example invoice, then your tag would look as follows:
<pdfexplode>invoice# </pdfexplode>

¢ A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line. Select the
tag and click Font on the Format menu. Click the Font tab, enter 6 for the Size and click OK.

¢ The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman. Select the tag and click Font on the
Format menu. Click the Font tab, set Font to Arial and click OK.

¢ You may change the color of the tag to white to make it invisible in the resulting document. Select the tag and click Font on the Format
menu. Click the Font tab, set Font color to White and click OK.
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Tagging an R&R Report

R&R Report Writer® stores documents in .rrw or .rsw files, which are data-driven documents. A data-driven document is one in which
you insert placeholders where you want information from the fields in your database to appear within the report. If your database has a
field containing e-mail addresses, you can send different sections of a report to selected e-mail addresses. For example, if you are sending
invoices, you might insert the e-mail address of your clients' account payable contact into the invoice page header so that each invoice is
sent to the correct client contact person. All of the pages associated with the same e-mail address will be combined into a single PDF file.
Instead of using a database field to supply the e-mail address, you may optionally use a text field for the e-mail address if you always send
a report to the same e-mail address, for example you may have a report you always send to JohnSmith@SmithCompany.com. Another
alternative is to use a calculated field to supply the e-mail address if you have special requirements for computing an e-mail address, for
example if-then logic to select from among several e-mail addresses for each client. In any case, the easiest way to insert a PDF-eXPLODE
tag into an R&R report is using a calculated field.

I Insert a PDF-eXPLODE Tag

 If your report does not already have a Page Header band, insert one. On the Insert menu Click Create Band Line. Click Select Band,
leave the default band as Page Header and click OK.

¢ Create a calculated field that includes the field with the e-mail address. On the Calculations menu click Calculated Fields and then click
New. Enter a field name such as PDFeXPLODE and then enter an expression such as the following example, where you will replace
e_mailAddr with the actual name of the field in your report that contains the e-mail address. When you are finished, click OK and Close.

"<pdfexplode>" + e_mailAddr + "</pdfexplode>"
If you are using a Message ID Tag, for example invoice, then your tag would look as follows:
"<pdfexplode>invoice#" + e_mailAddr + "</pdfexplode>"

¢ Place the cursor in the upper left corner of the report at the beginning of the first Page Header line and insert the field you just created.
On the Insert menu click Field. In the Insert Field dialog box, click Insert and Close.

¢ Make the text field as wide as necessary for the entire PDF-eXPLODE tag to appear in its entirety for the longest e-mail address. Click
and drag the right handle of the text field all the way to the right margin.

¢ A tag must fit entirely on a single line. Apply a small font size to minimize the risk of a tag not fitting entirely on a single line. Select the
text field and click Font on the Format menu. Enter 6 for the Size and click OK.

¢ The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman. Select the text field and click Font
on the Format menu. Set Font to Arial and click OK.

¢ You may change the color of the tag to white to make it invisible in the resulting document. Select the text field and click Font on the Format
menu. Set Color to White and click OK.

PDF-eXPLODE



Printing to PDF-eXPLODE

This section discusses the Printing and Logging options available
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Print Options

When you click Print on the File menu in most Windows Applications, you may select PDF-eXPLODE as your "printer." Doing so instructs
PDF-eXPLODE to intercept the output rather than sending it to a printer. After capturing your printer output, PDF-eXPLODE displays the
Print Options dialog.

Using the print Options dialog, you can save the document to a "master" PDF file instead of printing it. In addition to creating the master
PDF file, you can explode the master PDF file into separate "exploded" PDF files each of which may contain all or just selected pages from
the master PDF file according to the PDF-eXPLODE Tags you inserted. Finally, you may optionally e-mail the exploded PDF files.

All of the steps in the process described above (create, explode, e-mail) can be initiated by the user manually or can be set to run
unattended in an automated fashion, called "Silent Mode". You select whether PDF-eXPLODE operates in silent mode on the General
Settings screen.

In silent mode, the Print Options dialog is not displayed. If you print a document containing no PDF-eXPLODE tags, the Print Options dialog
will display regardless of the Silent Mode setting (except on PDF-eXPLODE Printer Server and PDF-eXPLODE Report Server, since dialogs
cannot be displayed on the workstation.) When silent mode is not selected, you may interact with the Print Options dialog to control the
process of document creation, exploding and e-mailing. The remainder of this help topic describes the options on the Print Options dialog
when silent mode is not selected and you are operating PDF-eXPLODE manually.

P Summary
You may optionally specify the following PDF document properties.

File Name is both the Windows filename and the PDF file title given to the master PDF file.

Author might be useful for identifying your nhame or your company's name.

Subject might be useful for identifying the type of document, such as "Invoice" or "Monthly Statement".
Keywords might be useful for searching documents.

Not to be confused with Windows file properties, PDF file properties may be viewed using either of the following methods:

Click Start, point to Programs, point to Accessories, and then click Windows Explorer.
Select the folder in which you saved your PDF file.

Double-click the PDF file you created to open it in your PDF viewer

Click Document Properties on the File menu.

When you are finished viewing the properties, click OK and then click Exit on the File menu.

-0r-

Right-click Start and click Explore.

Select the folder in which you saved your PDF file.
Right-click the PDF file you created and click Properties.
Click the PDF tab.

When you are finished viewing the properties, click OK.

I Quick Mail

Quick Mail enables you to convert a document into a PDF file and send it as an e-mail attachment without placing a PDF-eXPLODE tag in the
document. This is handy for ad-hoc and one-off documents. Any PDF-eXPLODE tags embedded in the document will be ignored and PDF
Security Settings will be ignored, i.e. the behavior will be the same as when Security Mode is set to Do Not Secure any PDF document
after

exploding.

The Print Options dialog will display if you print a document that contains no <pdfexplode> tags. To disable this feature, select Suppress
Quick Mail when the document has no <pdfexplode> Tags in General Settings.

¢ Select Send PDF created as attachment to Quick Mail to enable Quick Mail options.

¢ To: is the e-mail address to which the e-mail will be sent. Multiple e-mail addresses must be separated with a comma (,) or semicolon
(;)- Click To: to display a list of e-mail addresses from your Microsoft Outlook address book. Select one or more addresses and click
Continue to enter the addresses or click Close to cancel.

¢ Cc: works like To:, enabling you to send a copy of the e-mail to one or more e-mail recipients. Multiple CC e-mail addresses must be
separated with a comma (,) or semicolon (;). Unlike BCC, recipients will see each other's e-mail addresses.

¢ Bcc: works like To:, enabling you to send a blind copy of the e-mail to one or more e-mail recipients. Multiple BCC e-mail addresses
must be separated with a comma (,) or semicolon (;). Unlike CC, BCC recipients will not see each other's e-mail address.

¢ Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages using fonts
and images, etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts, etc.)
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¢ Subject is the subject that appears on the e-mail when received by your clients.
¢ Attachment is the pathname of an optional PDF file to attach (in addition to the PDF file created by PDF-eXPLODE). You may enter the
pathname or click Browse to select a file.
¢ Message is the message that will appear in the body of the e-mail received by your clients. If you selected Send e-mails as HTML,
click Create HTML Message to write a message using the HTML Editor, and when you are finished save your changes and close the
HTML Editor to return to this dialog. If you did not select Send e-mails as HTML, type your message in the area provided.
¢ Select e-mail flags for Importance and Sensitivity, if desired. Note that some e-mail clients, such as Outlook Express, do not display all of
the e-mail flags.
¢ Set Importance to Normal, Low or High. Press the Delete key to clear the selection.
¢ Set Sensitivity to Normal, Personal , Private or Confidential. Press the Delete key to clear the selection.
¢ Select Read Receipt to receive an e-mail notification when a recipient reads the e-mail sent by PDF-eXPLODE. Note that not all e-mail
servers support this option and also a recipient may optionally deny sending a read receipt.

I Options Button
Click Options to to display and/or modify options including General Settings, Security Settings and Mail Settings, as well as Default
Messages, Client Details and Client-specific Messages.

I Explode Later Button

Click Explode Later to save the master PDF file in the PDF-eXPLODE queue if you want to explode and e-mail it later. PDF-eXPLODE will
automatically select Suspend Printer on the Main Menu, placing a check mark next to the menu item. When you de-select Suspend
Printer, processing continues. If silent mode is selected on General Settings, the pending documents are exploded and e-mailed
immediately. If silent mode is not selected then the Print Options dialog is displayed to allow the user to control processing.

I Explode Now Button

Click Explode Now to explode the master PDF file into separate PDF files according to the embedded PDF-eXPLODE tags. If the Quick
Mail options are specified, the exploded PDF files will be e-mailed. If Quick mail is not selected, the exploded PDF files will be e-mailed
according to the Mail option on General Settings. The the current mail option is displayed for easy reference and may be changed by clicking
the Options button.

I Create PDF Button

Click Create PDF to save the master PDF file without exploding it or e-mailing the exploded PDF files. This button does not appear when
you have selected Send PDF created as attachment to Quick Mail.

I Create & E-Mail PDF Button

Click Create & E-Mail PDF to save the master PDF file and explode and e-mail the exploded PDF files. This button only appears when you
have selected Send PDF created as attachment to Quick Mail.

I Cancel Button

Click Cancel to remove the document from the PDF-eXPLODE queue without saving, exploding or e-mailing.
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Logging Operations

When you use PDF-eXPLODE to explode and send PDF attachments by e-mail, you may want to check the status of the PDF files and the e-
mails that were sent. Below are some suggested ways to monitor the status.

I View the Exploded PDF Files

You may view the PDF file you just created if you have a PDF viewer installed such as the free Adobe Reader, available at www.adobe.com.
If you do not have a PDF viewer installed, PDF-eXPLODE includes one named PeXPDFViewer, which can be accessed from the Logging and
Utilities screen.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.
_Or_

Right-click Start and click Explore.
2. Select the folder in which you save your exploded PDF files.lr Tips

¢ The Default Document Path is displayed on the General Settings screen.

« If the Default Document Path is blank, the location will be in the folder named PDFs located in the
directory where the PDF-eXPLODE program is installed (refer to What's Installed Where for the
location.)

3. Double-click the PDF file you want to view to open it. (The filenames will be your clients' e-mail address followed by the date and
time.) Close your PDF viewer when done.

I View the PDF-eXPLODE Log Files

It is a good idea to check the PDF-eXPLODE Log Files to be sure no errors occurred sending the e-mails. Log files are accessible from the
Logging and Utilities screen. If you are sending e-mail via SMTP, this is the best way to check on the success or failure of each e-mail. Use
the option labeled Log details of SMTP e-Mails to get details if e-mails are failing and you are sending via SMTP (not available for MAPI, or
Outlook).

I View Sent E-mails
If you are sending e-mail via Microsoft Outlook (MAPI), you can look for e-mails in your Sent folder. Make sure they are not stuck in the
Drafts folder. If so, you must open and send them.

I Monitor the Return Address Inbox
It is a good idea to specify an e-mail account in the Sender Name field of Mail Settings where you can easily check for return e-mails when
delivery problems occur. Delivery errors may result if someone typed an e-mail address incorrectly, or an employee is no longer be with a
company. Undeliverable e-mails may also return error notification e-mails to this address.
For example, you might create an e-mail account named "CustomerService@YourCompany.com". Then, in the Sender Name field you would
enter the following (be sure to leave a space before the left angle bracket (<):

Customer Service <CustomerService@yourcompany.com>
For e-mails that are delivered successfully, the recipient will see the sender name in their "From" field. However, if the receiving e-mail
server encounters an error, it may send a reply e-mail back to this e-mail account to help you resolve the error. You may need to work with
your intended recipient to resolve the error if their e-mail server has blocked your e-mail for some reason.

I Advanced Diagnostics

If documents accumulate in the queue with the status "Waiting", make sure you have not suspended PDF-eXPLODE by opening PDF-
eXPLODE and checking the Printer menu. To diagnose other processing issues, use the PDF-eXPLODE. log and PDF-eXPLODESPL.log (refer
to What's Installed Where for the location.) Information that can be found in these files includes:

PDF-eXPLODE.log - Logs operations of the main program.

If no log entries are created in the PDF-eXPLODE.log then check the PDF-eXPLODESPL.log as PDF-eXPLODE executable may have failed to
launch.

Creation of the Master PDFIf no master PDF is created, then no exploding, e-mailing or archiving will occur.
Exploding the master PDF
Sending exploded PDF files via e-mail or FTPIf no e-mails are sent, make sure the E-mail option on General Settings is not set to "Do not
send by e-mail to Clients after exploding”.
If e-mails fail to send, check the log for the phrase "Unable to relay" and if present, you must configure your outgoing e-mail server
(SMTP server) to allow relays from the computer on which PDF-eXPLODE is installed.
If e-mails do not include attachments, make sure you have not selected the option "Do NOT attach exploded PDFs to ANY e-mails" on

General Settings.
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Archiving exploded PDF filesIf no archive files are not created, make sure your Windows user account has Full control permissions for the
destination folder.

PDF-eXPLODESPL.log - Logs the process that moves files from the Windows printer spooler to the PDF-eXPLODE program.

¢ Communication/handover of the Windows document file output (in postscript format) to PDF-eXPLODE's print spooler
¢ Launching of the PDF-eXPLODE executablelf launching PDF-eXPLODE fails, make sure your Windows user account has the permissions
described in the Installation instructions.
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Command Line Usage
This describes the command line processes available to Users.
This command line is useful when scheduling the processing; or
where the PDF-eXPLODE which is your connection (from PDF-eXPLODE).
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Run PDF-eXPLODE from a Command Line

If you need to explode and e-mail an existing PDF file, besides the conventional end-to-end method of clicking PRINT from within your
Report Writer or document application, you can :

drag-and-drop the PDF file onto the PDF-eXPLODE program window,

use the PDF-eXPLODE Utilities, or

use a command line, or

send the PDF with an embedded tag to a folder monitored every 10 minutes by PDFeMONITOR.

PDFeMONITOR is our auto monitoring tool (further information from info@pdf-explode.com). This software will automatically launch
PDF-eXPLODE and explode , email and archive any 3rd party PDF with tags.

All of the four methods assumes you have separately created a PDF with embedded tag using PDF-eXPLODE or a third party
software. This 'master' PDF containing all pages to be distributed can be created by PDF-eXPLODE PDF engine or by some third party PDF

creation software. The PDF file format in all above cases, must be version 1.7 or earlier - check PDF file properties if unsure, by opening it in
Adobe Reader, select File/Properties menu. PDF Version shows under 'Advanced' on the Description tab.

Each method has its own advantages: drag-and-drop is fast and convenient, PDF-eXPLODE Utilities provides a user-friendly interface, using
the PDFeMONITOR tool allows you to automate the explode and emailing process from a third party PDF source, and running PDF-eXPLODE
from a command line can be used to accomplish such applications as:

¢ Using Window Task Scheduler to automate the execution of PDF-eXPLODE
¢ Exploding an existing PDF created by another application.

For example:

¢ Some applications (e.g. SQL Server Reporting Services) print an image rather than text which makes the PDF-eXPLODE tags
unreadable. So, instead of printing to PDF-eXPLODE you need to export to PDF and then explode the PDF.
¢ Some applications produce smaller PDF files so it may be advantageous to create the PDF using software other than PDF-eXPLODE.

I Drag-and-drop

¢ Open PDF-eXPLODE.

¢ Using Windows Explorer, navigate to the desired PDF file.

¢ Using the mouse, drag the PDF file to the PDF-eXPLODE window and when the cursor changes to plus sign release the mouse. If the
mouse cursor fails to turn to a plus from a circle, then you may like to read this article

I PDF-eXPLODE Utilities

Open PDF-eXPLODE.

Click the Printer menu and select PDF-eXPLODE Options.
Select Logging and Utilities.

Click Explode & E-mail PDFs.

Click Browse and select the file.

Click Explode & E-mail.

I Command Line Format
"Program Path" -PRINTFILE"master PDF path/file name"

For example:
"C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" -PRINTFILE"C:\Program Files\PDF-eXPLODE\PDFS\PDF-eXPLODE.pdf"
Note that there is no space between -PRINTFILE and the name of the PDF.

P Detailed Instructions
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First, you must verify the location of the PDF-eXPLODE.exe file on your computer. If you accepted the default folder location when
you installed PDF-eXPLODE, the PDF-eXPLODE.exe file is probably located at: C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe
e If you do not find the PDF-eXPLODE.exe file at that location, search for the file and make a note of the full path.

Do one of the following Windows Vista: Click the Start button e, point to All Programs, click Accessories, and then click Run.
¢ Windows XP, 2000,2003: Click the Start button, and then click Run.

1. In the Run dialog box, type a double quote (") followed by the full pathname for the PDF-eXPLODE.exe file (including the file
name) and another double quote, or click Browse to locate it.

2. At the end of the path, type a space, and then type the switch -PRINTFILE, a double quote, the full path of the master PDF file to
be exploded and another double quote. Note that there is no space between -PRINTFILE and the name of the PDF. For example,
you can type (or copy, paste and edit the following example):

32-bit systems:
“C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" -PRINTFILE"C:\Program Files\PDF-eXPLODE\PDFS\PDF-eXPLODE.pdf”

64-bit systems:

"C:\Program Files (x86)\PDF-eXPLODE\PDF-eXPLODE.exe" -PRINTFILE"C:\Program Files\PDF-eXPLODE\PDFS\PDF-
eXPLODE. pdf"

b Tips
e Switches and parameters are not case sensitive. For example, -PRINTFILE is the same as -printfile
e Remember to include one blank space before the -PRINTFILE switch and NO SPACE after it.
o If the PDF pathname has spaces in it, enclose the complete name in quotation marks; for example, “C:\Program Files\PDF-
eXPLODE\PDFS\PDF-eXPLODE.pdf".

1. Click OK.
2. The exploded files are created in the same folder as the master PDF, unless there is an Exploded File Path specified in Mail

Settings.

P Using PDFEMONITOR

PDFeMONITOR is an auto monitoring tool that is capable of launching PDF-eXPLODE and passing to it any PDF containing tags, for exploding
and delivery. It is especially useful where you the Client, are using a third party PDF engine to create tagged PDFs directly from your
accounting or reporting software. PDFeMONITOR' s process is automatic with no human intervention required. Just save your PDFs to

a pre-configured (in PDFeMONITOR) folder and set the time intervals (from 10 minutes to 2 hours) for PDFeMONITOR to scan the folder
path. PDFeMONITOR is not a scheduler but it certainly will benefit you in a similar way. Once PDFeMONITOR s started, it sits silently in the
Windows system tray (where the clock resides in the lower right corner of your screen) all the time monitoring your nominated folder.

PDFeMONITOR installs into a subfolder of PDF-eXPLODE. It create 3 subfolders relative to its location - INBOX, OUTBOX, PROCESSED at
installation time. By default all polling (aka 'monitoring") of the INBOX for any incoming PDFs, will be set to every 10 minutes.

Once a PDF is found in the INBOX, PDFeMONITOR first moves the PDF to OUTBOX and will then start PDF-eXPLODE, passing the PDF to it to
explode, deliver and archive according to the Tag found. PDFeMONITOR will then move the processed PDF to the PROCESSED folder and write
a log line in the PDFeMONITOR log. If no tag exists in the PDF, then the PDF will be closed and moved to the PROCESSED folder. You will need
to directly save all PDF created by your business software into the PDFeMONITOR INBOX subfolder.

In the Windows system tray, PDFeEMONITOR is accessible with a right mouse click. The monitoring process can be paused, reconfigured or
shut down. It is ideal for automating the exploding process from your business system which creates the PDFs.

If you need a free copy of PDFeMONITOR to automate your process, please request it here

I+ Restarting an Incomplete Job

If the PDF-eXPLODE process is interrupted after creating the temporary exploded PDF files (named *_expl.pdf), you can manually restart the
process and complete the naming, e-mailing and archiving steps using the command:

“Program Path” -CONTINUE"FolderPath of the_expl.pdf”

Note there is no space after the word CONTINUE. For example:
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“C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" -CONTINUE"C:\PROGRAM FILES\EXPLODED PDFS”
If you are unsure of where the _expl.pdf temporary files are located, you can use an alternate form of the command that will use the last
saved folder name (in pdfexplode.ini, the settings file):
“Program Path” -CONTINUETRUE
Note that CONTINUETRUE is one word. For example:
“C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" -CONTINUETRUE

I Setup User Accounts on Printer Server
The PDF-eXPLODE Printer Server default configuration provides for all users to share the same settings. Alternatively, the administrator may
create a separate user settings file for each user. This procedure must be done on the server. Execute the Turn_Admin_Ini_OFF registry
setting in the REG folder and then create individual user settings (the pdfexplode.ini file) with the following command. Replace username
with the Windows user account name:

“C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe"” -CONFIGURE"username”
This will open PDF-eXPLODE. You may then select Options from the Printer menu and you will see the username displayed in the window
title bar. A blank settings file will be created in the INI folder under the user account name and you may edit the options. To edit the
administrator's settings use the command:

"C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" -CONFIGURE"administrator"

I» Combine PDF Files
The PDF combine utility can be automated from the command line. Up to five PDF files can be combined using the command:
"Program Path" -CombineOutput"output file pathname" -CombineInputl"input file 1 pathname" ... -Combinelnput5"input file 5 pathname"
For example:
"C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" -CombineOutput"C:\Output.pdf" -CombineInput1"C:\Reportl.pdf" -
CombineInput2"C:\Report2.pdf" -CombineInput3"C:\Report3.pdf" -CombineInput4"C:\Report4.pdf" -CombineInput5"C:\Report5.pdf"

IF View PDF Files
The PDF viewer utility can be automated from the command line. :
"Program Path" "file pathname"
For example:
"C:\Program Files\PDF-eXPLODE\PeXPDFViewer.exe" "C:\MyFile.pdf"

I PDF Printer Utility

Use the PeXPrintPDF print utility (located in the Program folder) and print a PDF. PeXPrintPDF supports the following command line
parameters where the first two parameters are required and the last three are optional:

-PRINT, PDFpathname [,printername] [,#copies] [,password]

For example, "C:\Program Files\PDF-eXPLODE\PeXPrintPDF.exe" -PRINT, "C:\Program Files\PDF-eXPLODE\PDFS\PDFeXPLODE.pdf",HP
LaserJet 3300 Series PCL 6

¢ Omit the printername to use the default printer
e Omit the # of copies to default to 1 copy
¢ If you skip a parameter, include the comma, for example, to print 2 copies to the default printer use:

"C:\Program Files\PDF-eXPLODE\PeXPrintPDF.exe" -PRINT, "C:\Program Files\PDF-eXPLODE\PDFS\PDFeXPLODE.pdf",,2
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Technical Support

This section details the different aspect to configuring PDF file creation and the mail settings
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System Requirements

¢ Operating System: Microsoft Windows XP, Windows Server 2003, Windows Server 2008, Windows Vista or Windows 7

e Hard Drive: Minimum 52.5MB of free disk space, plus additional space for PDF files created

e RAM: At least 64MB of available memory, more during PDF creation. The size of the PDF that can be created is limited by the amount of
available memory.
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Advanced Configuration
This section descibes in some detail, the available configuration for PDF creation with PDF-eXPLODE.
It also sets out the programming functionality capability of PDF-eCPLODE.
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PDF File Creation Properties

PDF-eXPLODE includes a process that creates PDF files. While every effort has been made to optimize the resulting PDF files for the widest
audience, there may be times where you need to customize the default properties as noted below.

Properties that affect the creation of PDF files are stored in the file named pdfexplode.properties located in the PDF-eXPLODE program
folder (see What's Installed Where for the specific location). The properties file may be edited using the Windows Notepad text editor. It is
highly recommended that a backup copy of the original pdfexplode.properties file be saved before changes are made.

Note: Properties are case-sensitive. You must enter them in the case indicated.

To begin, close PDF-eXPLODE if it is currently open. Navigate to the PDF-eXPLODE program folder and make a copy of the file named
pdfexplode.properties to save as a backup. Open pdfexplode.properties in Notepad and make changes as necessary and then save the file.

I JPEG Compression

To further compress any gray or color raster images using the JPEG method use the -J <quality> property where <quality> may be a
value between 0 and 100 (best). Note that this option has no effect on text, vector images or black & white images, only gray-scale and
color raster images are affected. If using a BMP (for example, a signature), a high value for compression may distort rather than improve

quality.
¢ To reduce the PDF file size and still maintain good quality, set this property as follows:
-1 60
¢ To increase quality while increasing file size, set this property as follows:
-170
¢ To set very high quality while further increasing file size, set this property as follows:

-1 90

I Paper Size
To specify a default paper size format use the -F <format> property where <format> may be a2, a3, a4, a5, letter or legal.

¢ To set the default paper size format to letter, set this property as follows:
-F letter
¢ To set the default paper size format to A4, set this property as follows:

-F a4

I Rotate Page
The page may be rotated for proper onscreen viewing of landscape pages using the -R <degrees> property, where <degrees> may be 0,
90, 180 or 270.

¢ To prevent pages from being rotated, allowing landscape pages to be viewed normally, set this property as follows:

-RO

P Text Print Quality

The dots-per-inch resolution may be varied to affect the quality, size and speed using the -d <dpi>/<dpi>/<dpi> property, where <dpi>
may be a number between 72 and 600. The first <dpi> number is text resolution, the second <dpi> number is color graphics and the

third <dpi> number is monochrome graphics. In general, a higher value for <dpi> will produce higher quality output but will cause PDF-
eXPLODE to use more memory and take longer to create a PDF file and the resulting file will be larger.

 For draft quality office work at a resolution of 150 dpi, set this property as follows:
-d 150/150/150

» For higher quality output, for example if your PDF result shows slightly misplaced characters in text (usually horizontally by a tiny
amount), set this property to 300 dpi as follows:

-d 300/150/200
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For the highest quality output, for example if your PDF contains high-resolution graphics, set this property to 600 dpi as follows. Setting
text resolution greater than 300 is not recommended:

-d 300/600/600
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Programming Functions

Programming functions allow you to manipulate and format the contents of variables within an e-mail subject or message if mail-merge is
enabled. They work in both text and HTML messages if you have selected Use variables in e-mail on the Variable Settings screen. The
following functions are supported. The names are not case-sensitive, but you must not insert any spaces between the function name and the
open parenthesis.

P Keywords

o <<Date>>: Insert the current date. Format a date using the FormatDate() function described below.
e <<Time>>: Insert the current time.

I Functions

+ FormatDate(): Format a date by supplying a format code. For example, to format a date in variable 1 in mm/dd/yyyy format, insert
FormatDate(<varl>, "mm/dd/yyyy"). The variable must be a number containing 4, 6 or 8 characters, or the date parts can
optionally be separated by a punctuation character such as slash (/), dot (.), hyphen (-) or comma (,). For example, the value 12102013
would be interpreted as December 10, 2013

I Tips
The following format codes can be used. Note that the codes are case sensitive and must be enclosed within double quotes and
may contain slash (/) or hyphen (-) as a separator.For example: "ddmmyyyy", " yyyymmdd" "dd/mm.yyyy" or "dd-mm-yyyy".

d Displays the day as a number without a leading zero (for example, 1). Use %od if this is the only character in your
user-defined date format.

dd |Displays the day as a number with a leading zero (for example, 01).

ddd |Displays the day as an abbreviation (for example, Sun).

dddd |Displays the day as a full name (for example, Sunday).

M Displays the month as a number without a leading zero (for example, January is represented as 1). Use %M if this is
the only character in your user-defined date format.

MM [Displays the month as a number with a leading zero (for example, 01/12/01).

MMM [ Displays the month as an abbreviation (for example, Jan).

¢ NDays(): Calculate the number of days between two dates. For example, NDays(2012/01/01,<<Date>>) will calculate the number
of days since January 1, 2012. If you omit the second date it is assumed to be the current date. The order of the two dates does not
matter - the result is always a positive number. For example, NDays(2013/01/01,2013/12/31) and NDays(2013/12/31,2013/01/01) will
both return the number of days in the year, 365. Note that date constants should be entered in the format YYYY/MM/DD.

¢ VSplit(): Extract a portion of a variable, delimited by hyphen (-). For example, assuming variable 2 contains the text Apples-Oranges-
Bananas, VSplit(<var2>,3) returns the third term, in this case, Bananas.

« MSplit(): Extract a portion of a variable, specified by the starting position and number of characters. For example, assuming variable 2
contains the text Apples-Oranges-Bananas, MSplit(<var2>,16,7) returns the seven characters beginning at position 16, in this case,
Bananas. If you omit the length of the substring to extract it is assumed to be the length of the string starting at the specified position.
Using the previous example, MSplit(<var2>,16) also returns Bananas.

¢ Upper(): Convert a character string into all uppercase letters. For example, assuming variable 1 contains the text Apples,
Upper(<varl>) returns APPLES.
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¢ Lower(): Convert a character string into all lowercase letters. For example, assuming variable 1 contains the text Apples, Lower(<varl>) returns
apples.

* Proper(): Convert a character string into proper case format, i.e. initial caps. For example, assuming variable 1 contains the text john smith,
Proper(<varl>) returns John Smith.

* Replace(): Replace one character string with another character string. For example, assuming variable 1 contains the text Apples-Oranges-Bananas,
Replace(<varl>,"Oranges","Grapes") results in the text Apples-Grapes-Bananas. The double quotes are optional, so the same result could be
achieved using Replace(<varl>,0Oranges,Grapes).

* Trim(): Trim leading and trailing spaces from a character string. For example, assuming variable 1 contains the text " john smith ', Trim(<varl>)
returns "john smith'".

b Tips
You can nest functions. The order of evaluation is important. First variables are expanded and then keywords and functions are evaluated in
the following order:

<<Date>>
<<Time>>
FormatDate()
Replace()
Trim()
VSplit()
MSplit()
Upper()
Lower()
Proper()
NDays()
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Fast Start Guide

The purpose of this help topic is to assist users who want to use PDF-eXPLODE to send an e-mail as soon as possible after installing the
product before reviewing all the options and capabilities of PDF-eXPLODE.

Please note the default paper size supported by PDF-eXPLODE is Letter. If your paper size is different, for example A4, you must edit the
PDF File Creation Properties and set the appropriate Paper Size before proceeding.

Mail Settings

To send e-mails using PDF-eXPLODE, you must set up an e-mail account much like you would in an e-mail client program such as Microsoft
Outlook. The steps below are designed to get Microsoft Outlook users going quickly. Refer to the Mail Settings help topic for general
documentation.

To begin, start PDF-eXPLODE.

I Open Mail Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Mail Settings. You will see the two tabbed forms displayed in the right-hand pane of the PDF-eXPLODE
window: Default E-mail Setting and E-mail Connection Setting.

I Default E-Mail Setting

Enter the default e-mail Subject and Message Text you want to appear when your e-mail is viewed by recipients. You can change them
each time you send e-mail using PDF-eXPLODE, or you can create Subject/Message definitions that are associated with specific types of
mailings such as monthly statements or invoices (called Default Message ID Tags) or with specific recipients (called Client-specific Message
ID Tags).

I E-Mail Connection Settings
Click the tab labeled E-mail Connection Setting. To prepare Microsoft Outlook to lookup the proper settings, perform the following steps.
Leave the Outlook screen open to refer to as you fill in the PDF-eXPLODE Mail Settings.

Open Microsoft Outlook.

Click E-mail Accounts on the Tools menu.

Select View or change existing e-mail accounts and click Next.
Select the e-mail account you wish to use and click Change.

You will see a dialog box like the one below.

uhwn=
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E-mail Accounts

Internet E-mail Settings (POP3)
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Fill in the following fields in PDF-eXPLODE as described:

+ Sender Name: Refer to the Microsoft Outlook screen and enter the value from Your Name (e.g. John Smith) followed by a space,
followed by the value from E-mail Address within angle brackets (e.g. John Smith <jsmith@pdfexplode.com>.

¢ Reply To: By default this will be the email address part (within the <> brackets); however you can nominate any address to which a
"Reply" e-mail will be directed.

¢ Outgoing Mail SMTP Server: Refer to the Microsoft Outlook screen and enter the value from Outgoing mail server (SMTP).

« Sign-on Username: Refer to the Microsoft Outlook screen and enter the value from User Name.

« Password: Refer to the Microsoft Outlook screen and enter the same Password. Note that passwords are displayed as asterisks and
stored encrypted for security.

For the next field on the PDF-eXPLODE screen, click the More Settings... button in Microsoft Outlook to bring up the following dialog
window, and click on the tab labeled Advanced.
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Internet E-mail Settings

General] Outgoing Server] Connection  Advanced l

Server Port Mumbers

Incoming server (POP3Y: 110 Use Defaults |

[ This server requires an 55L-secured connection (551

Qkgoing server (SMTP: ] 25

[ This server requires an SSL-secured conneckion {551
Server Timeouks

Short = p————— Long 1 rinute

Delivery

[ Leave a copy of messages on the server

r

k. | Cancel

» Port: Refer to the Microsoft Outlook screen and enter the value from Outgoing server (SMTP).

For the next fields on the PDF-eXPLODE screen, in Microsoft Outlook click on the tab labeled Outgoing Server to display the following
dialog.
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Internet E-mail Settings

General Outgoing Server Ennnectiun] .ﬁ.dvanced]

[ My outgaing server (SMTP) requires authentication

=
o~

k. | Cancel

¢ Authentication Type: Refer to the Microsoft Outlook screen and:
¢ If the box labeled My outgoing server (SMTP) requires authentication is not checked, select None, otherwise if it is checked:
¢ If the Option labeled Use same settings as my incoming mail server is selected, select Login.
¢ If, when you try sending an e-mail using the Login setting, the e-mail does not get sent, select Plain instead of Login.
¢ If the option labeled Log on to incoming mail server before sending mail is selected, select POP.
¢ Incoming Mail (POP3) Server: Refer to the Microsoft Outlook screen and if the box labeled My outgoing server (SMTP) requires authentication
is checked and the option labeled Log on to incoming mail server before sending mail is selected, click Cancel in Microsoft Outlook return to the
previous screen and enter the value from Incoming mail server (POP3). Otherwise, leave this field blank.
¢ Delay each E-Mail: you can optionally set a delay (in seconds) between each e-mail sending so as to allow the e-mail server to recover between each
"send". This is especially recommended with slow and/or busy servers which take some time to send the e-mail thereby putting the e-mail send at risk of
timing out. A maximum of 2 seconds should not be exceeded as a delay time on large e-mail sending batches.
¢ Security Protocol: Where the SMTP server requires "an SSL secured connection" you would check SSL. This refers to an (implicit) secured connection
where a connection is established when the e-mail is about to send. You will need to use StartTLS where an explicit secured connection is created
BEFORE SMTP server handshaking protocol begins. This connection is used mostly with Cloud based SMTP servers.
* Your e-mail connection settings should now look like this:
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¢ Default E-Mal Setting Y.-‘i'q.tta:h'nent YE—HaI Connection Setting )

@ Use PDF-eXPLODE (SMTP) Use Microsoft Outlook (MAPIT)

SMTFP

Sender Mame <Sender E-mail Addr> John Smith <jsmith@pdfexplode. corms |

Reply To:  [email address only]  |iohn@expartviz.com

Dutgoing Mal SMTP Server mail pdfexplode. com |

Sign-on Username jsmith |

Sign-on Password

Authentication Type None - Port |29

Incoming Mail [POP3] Server mail pdfesxplode. com |

HEXRERR AR |

Security Protocol

[ | Delay each E-Mail By 12 Seconds | |SSL StatTLS | Test Connection

¢ Click Test Connection and check the sender name e-mail account (jsmith@pdfexplode.com in this example) to ensure the test e-mail
was delivered and received. If you do not receive the test e-mail, chances are the settings are incorrect. You may need assistance from
your e-mail administrator to ensure the settings are correct.

¢ Click Save to save your settings.

¢ On the Printer menu, click Exit to close PDF-eXPLODE.

E-mailing a Document

At the heart of PDF-eXPLODE is the ability to explode, or separate, a PDF file into individual PDF files to e-mail different people different
sections of a document.

To get your documents where they need to go, you need to inset PDF-eXPLODE tags in the documents to indicate which settings to use
when exploding and e-mailing documents.

IF Tagging a Document

¢ Open a short test document in a program such as Microsoft Word or Crystal Reports.
¢ In the page header, or at the top of the page, type a PDF-eXPLODE e-mail tag in the following format, replacing the example e-
mail address with your own e-mail address. <pdfexplode>jsmith@pdfexplode.com</pdfexplode>
o If you are using Crystal Reports, make sure the entire tag is visible. (Hint: Click and drag the right handle of the text object all the way
to the right margin.)
¢ A tag must fit entirely on a single line. Position the tag starting at the left margin. Apply a smaller font size if necessary.
¢ Apply the Times New Roman font to the entire tag.
You may change the color of the tag to white to make it invisible in the resulting document. However, we recommend leaving the color
black so the tag is visible until you have fully tested the document.
The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
Do not include spaces within a PDF-eXPLODE tag.
Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail.
All the pages associated with the same e-mail address will be combined into a single PDF file.

» Printing to PDF-eXPLODE
PDF-eXPLODE will create, explode and e-mail PDF files. The following instructions assume you will create the master PDF with PDF-

eXPLODE. However, if you have an existing PDF created by another process, you can still use PDF-eXPLODE to explode and e-mail it - refer
to the instructions for using PDF-eXPLODE from a command line.
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¢ Set the document to print to the PDF-eXPLODE printer.

¢ Print the document. For testing purposes, we recommend that you select just a few pages.

¢ If you have not configured PDF-eXPLODE to e-mail in “Silent Mode"” in General Settings and the following dialog appears, select Explode
Now and then click Save.
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I View the Resulting E-mail

You may view the PDF file you just e-mailed yourself if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com.
If you do not have a PDF viewer installed, PDF-eXPLODE includes its own viewer named PeXPDFViewer, which is fast and simple to

use. PeXPDFViewer can be accessed from the program folder, from the Logging and Utilities screen, or from a command line. To set

PeXPDFViewer as your default PDF viewer, right-click a PDF and select Open With, select Choose Program, navigate to the PDF-eXPLODE

program folder and select PeXPDFViewer.exe. Make sure the checkbox labeled "Always use the selected program to open this kind of

file" is checked.

1. In your e-mail inbox, locate the e-mail you just sent yourself.
2. Open the e-mail and then open the PDF attachment. If you want to use Foxit Reader, first save the PDF attachment to a disk file.
3. Close your PDF viewer when done.

I Troubleshooting

e Itis a good idea to check the PDF-eXPLODE Log Files to be sure no errors occurred sending the e-mails. Log files are accessible from
the General Settings screen.

¢ Check the Inbox for the e-mail account in the Sender Name field of the PDF-eXPLODE Mail Settings where you may find return e-mails
when delivery problems occur. Delivery errors may result if you typed the e-mail address incorrectly in the document you printed to
PDF-eXPLODE.

¢ The default paper size supported by PDF-eXPLODE is Letter. If your paper size is different, for example A4, you must edit the PDF File
Creation Properties and set the appropriate Paper Size.
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PDF-eXPLODE Developer's Website
Please click here to visit this site
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PDF-eXPLODE has been in the market for close to seven years. During that time the product has evolved such that it is now one of the best
feature rich product in the market.
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About 3000AD Systems
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3000AD SYSTEMS

Futuristic Business Solutions
v4.0.15.97 Nov 2014

3000AD Systems, an incorporated company, commenced business in March 1999 in Sydney Australia. At 3000AD Systems, we are committed
to excellence in product delivery and customer service. Our vision is the delivery of innovative, time and cost saving products to market. Our
business partners are our Clients who we work with to supply superior (and simple) solutions to complex problems. We believe our products
represent the best value for money and we back them up with excellent support services - just ask any of our Users. Here is what some of
our Users say:

".... It goes without saying that the savings in time, postage and labor paid for the system within a short space of time. And the
after sales support from 3000AD Systems, developers of the product, is courteous, fast and second to none.”

Robert Jurewicz
Business Development Coordinator
GARDENS HOME MANANGEMENT SERVICES, Florida USA

"PDF-eXPLODE support has been excellent. PDF-eXPLODE is a program that does what it says it’s going to do. The bottom line is it
works and saves me a tremendous amount of time on a weekly basis...."

Brad Barron, R.Ph.
Pharmacy Systems Coordinator
Bashas Grocers, Arizona USA

"... It is saving two of my customers HOURS AND HOURS of time every month - and the support is superior. Prompt responses to
emails and questions, and a tireless search for the best solution to any problem we may have encountered. Do not hesitate to buy
and use PDF-eXPLODE."

Angela Meharg

Crystal Reports Subject Matter Expert
www.crystalreportsgoddess.com,
Toronto, Canada
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Contact Us

3000AD SYSTEMS PTY LTD
10 PAUL AVE, ST.IVES NSW 2075
AUSTRALIA

Tel: +61 2 99830367
Support e-mail: support@3000ad.com.au
General enquiries e-mail: mail@3000ad.com.au

PDF-eXPLODE ® is a Registered Trademark of 3000AD SYSTEMS, Australia.

Support Desk

e
e

We have developed the following support options that take advantage of our highly acclaimed service at very affordable prices. If PDF-
eXPLODE is a business critical process then we strongly recommend you consider your options below.

You have a choice of service types as follows:

1. Priority Paid Support

Our premium priority annual support contract with turnaround times of up to 48 business hours or less. Priority Support is provided at no
charge during the startup period of the first 60 days following purchase. Once 60 days have elapsed, Priority Support is available for purchase
for a 12-month period provided that Priority Support has been purchased for all current licenses and includes:

Help installing, configuring and validating proper operation of PDF-eXPLODE software.
Help diagnosing and solving problems with PDF-eXPLODE software where the software does not perform as advertised or documented.
Product updates (e.g. V 4.0 to V 4.1) and temporary fixes but not major upgrades (e.g.V 4 to V 5).
Responses will be made by e-mail, phone or Skype at the support provider’s discretion and may require use of a remote connection to the
customer’s PC.
e Aresponse will be provided within 24 hours from the time of initial contact, excluding weekends and holidays.

2. Per-incident Support
Priority support will be provided on a per-incident basis for US $150 in the event the start-up period has passed and Priority Support has not
been purchased.

3. Free Support

Priority Support (see definition #1 above) will be provided at no charge during the Startup Period, defined as the first 60 days beginning on
the date of purchase of a product license. After the start up Period, free support will be limited to:

Self-service using resources provided on the product website.

License activation reset for the purpose of re-imaging the disk on which PDF-eXPLODE was installed or moving the license to a different PC
Providing a download link for the current or previously purchased versions of the PDF-eXPLODE setup program

Customer database lookup/update of contact information, license ID and password

Re-send a copy of an invoice
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Search the Knowledge Base

PDF-eXPLODE Knowledge Base

The Knowledge Base covers in excess of 30 articles spread over Installing, Licensing, Configuring, Processing, Emailing, Archiving and Tips. It
provides detailed solution instructions.
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